The information in this document is subject to change without notice and does not represent a commitment on the part of Native Instruments GmbH. The software described by this document is subject to a License Agreement and may not be copied to other media. No part of this publication may be copied, reproduced or otherwise transmitted or recorded, for any purpose, without prior written permission by Native Instruments GmbH, hereinafter referred to as Native Instruments.

“Native Instruments”, “NI” and associated logos are (registered) trademarks of Native Instruments GmbH.

Mac, Mac OS, GarageBand, Logic, iTunes and iPod are registered trademarks of Apple Inc., registered in the U.S. and other countries.
Windows, Windows Vista and DirectSound are registered trademarks of Microsoft Corporation in the United States and/or other countries.
All other trade marks are the property of their respective owners and use of them does not imply any affiliation with or endorsement by them.

Document authored by: Native Instruments GmbH

Software version: 2.5 (05/2012)

Special thanks to the Beta Test Team, who were invaluable not just in tracking down bugs, but in making this a better product.
Germany
Native Instruments GmbH
Schlesische Str. 29-30
D-10997 Berlin
Germany
www.native-instruments.de

USA
Native Instruments North America, Inc.
6725 Sunset Boulevard
5th Floor
Los Angeles, CA 90028
USA
www.native-instruments.com

© Native Instruments GmbH, 2012. All rights reserved.
## Table of Contents

1. **Welcome to the World of TRAKTOR KONTROL S4!** .......................................................... 11
   1.1 What Is TRAKTOR KONTROL S4? .................................................................................. 11
   1.2 The TRAKTOR KONTROL S4 Documentation ................................................................ 11
     1.2.1 Where To Start ....................................................................................................... 11
     1.2.2 In This Manual ..................................................................................................... 14
     1.2.3 Manual Conventions ............................................................................................ 15
   1.3 System Requirements .................................................................................................... 16

2. **TRAKTOR KONTROL S4 Overview** ................................................................................. 17

3. **Importing Your Music** ................................................................................................. 20
   3.1 What Is the Track Collection? ..................................................................................... 20
   3.2 Importing Music Folders ............................................................................................. 21
   3.3 Tracks Managed by iTunes .......................................................................................... 22
     3.3.1 Playing Tracks Managed by iTunes ....................................................................... 22
     3.3.2 Importing a Selection of Tracks from iTunes ......................................................... 24
     3.3.3 Importing iTunes Playlists .................................................................................... 24

4. **Tutorials** .................................................................................................................... 25
   4.1 Playing Your First Track .............................................................................................. 25
     4.1.1 Quick Loading a Track ......................................................................................... 26
     4.1.2 Playing the Track .................................................................................................. 28
     4.1.3 If You Don’t Hear the Track ................................................................................ 29
   4.2 Mixing In a Second Track ............................................................................................. 31
     4.2.1 Pre-listening a Second Track Directly from the Browser ..................................... 32
     4.2.2 Loading and Playing the Second Track ................................................................. 33
     4.2.3 Using Headphones to Prepare the Mix ................................................................. 33
     4.2.4 Synchronizing the Second Track .......................................................................... 34
     4.2.5 Setting a Cue Point as Starting Point ................................................................... 35
4.8.1 Introduction ............................................................................................................... 67
4.8.2 Who’s the Master? ..................................................................................................... 69
4.8.3 Other Useful Tools for Synching ................................................................................. 72
4.8.4 In Conclusion ............................................................................................................. 73

5  Hardware Reference ........................................................................................................... 74

5.1 Areas and Concepts .................................................................................................................... 74
5.1.1 Decks ......................................................................................................................... 74
5.1.2 Mixer .......................................................................................................................... 78
5.1.3 FX Units ..................................................................................................................... 79
5.1.4 Loop Recorder ............................................................................................................ 80
5.1.5 Front and Rear Panels ............................................................................................... 81

5.2 Types of Control Elements .......................................................................................................... 81
5.2.1 Buttons ...................................................................................................................... 81
5.2.2 Knobs ........................................................................................................................ 82
5.2.3 Encoders .................................................................................................................... 83
5.2.4 Jog Wheels ................................................................................................................. 83
5.2.5 Faders ....................................................................................................................... 84
5.2.6 Displays, Meters and Indicators ................................................................................ 84
5.2.7 Switches .................................................................................................................... 85
5.2.8 Sockets ...................................................................................................................... 86

5.3 The Decks ................................................................................................................................... 86
5.3.1 Deck Flavors and Structure ........................................................................................ 86
5.3.2 SHIFT Buttons: Accessing Secondary Functions ......................................................... 88
5.3.3 Deck Assign Buttons: Switching Deck Focus .............................................................. 88
5.3.4 Deck Display: Informed at a Glance ........................................................................... 89
5.3.5 LOAD Button .............................................................................................................. 91
5.3.6 Jog Wheel ................................................................................................................... 92
5.3.7 Tempo Fader and Tempo Offset Buttons .................................................................... 93
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.3.8</td>
<td>Loop Section</td>
<td>96</td>
</tr>
<tr>
<td>5.3.9</td>
<td>Sample Play Buttons</td>
<td>99</td>
</tr>
<tr>
<td>5.3.10</td>
<td>Hotcue Buttons</td>
<td>102</td>
</tr>
<tr>
<td>5.3.11</td>
<td>PLAY and CUE Buttons</td>
<td>106</td>
</tr>
<tr>
<td>5.3.12</td>
<td>SYNC Button</td>
<td>107</td>
</tr>
<tr>
<td>5.3.13</td>
<td>SHIFT Button</td>
<td>108</td>
</tr>
<tr>
<td>5.4</td>
<td>The Mixer</td>
<td>109</td>
</tr>
<tr>
<td>5.4.1</td>
<td>Mixer Overview</td>
<td>110</td>
</tr>
<tr>
<td>5.4.2</td>
<td>The Main Section</td>
<td>110</td>
</tr>
<tr>
<td>5.4.3</td>
<td>The Channels and the Crossfader</td>
<td>112</td>
</tr>
<tr>
<td>5.4.4</td>
<td>The Master Display</td>
<td>118</td>
</tr>
<tr>
<td>5.4.5</td>
<td>The BROWSE Encoder and BROWSE Button</td>
<td>121</td>
</tr>
<tr>
<td>5.5</td>
<td>The FX Units</td>
<td>122</td>
</tr>
<tr>
<td>5.5.1</td>
<td>Single Mode and Group Mode</td>
<td>123</td>
</tr>
<tr>
<td>5.5.2</td>
<td>FX Unit Reference</td>
<td>123</td>
</tr>
<tr>
<td>5.6</td>
<td>The Loop Recorder</td>
<td>124</td>
</tr>
<tr>
<td>5.6.1</td>
<td>DRY/WET Knob</td>
<td>125</td>
</tr>
<tr>
<td>5.6.2</td>
<td>SIZE Button</td>
<td>125</td>
</tr>
<tr>
<td>5.6.3</td>
<td>REC Button</td>
<td>126</td>
</tr>
<tr>
<td>5.6.4</td>
<td>UNDO Button</td>
<td>126</td>
</tr>
<tr>
<td>5.6.5</td>
<td>PLAY Button</td>
<td>127</td>
</tr>
<tr>
<td>5.6.6</td>
<td>Copying and Saving the Recorded Loop</td>
<td>127</td>
</tr>
<tr>
<td>5.7</td>
<td>Browsing, Loading and Copying</td>
<td>127</td>
</tr>
<tr>
<td>5.7.1</td>
<td>Browsing Tracks and Samples</td>
<td>128</td>
</tr>
<tr>
<td>5.7.2</td>
<td>Copying across the S4</td>
<td>131</td>
</tr>
<tr>
<td>5.8</td>
<td>The Rear Panel</td>
<td>133</td>
</tr>
<tr>
<td>5.8.1</td>
<td>MAIN OUT Section</td>
<td>134</td>
</tr>
<tr>
<td>5.8.2</td>
<td>INPUT CHANNEL D Section</td>
<td>134</td>
</tr>
</tbody>
</table>
## Table of Contents

5.8.3 INPUT CHANNEL C Section ................................................................. 135  
5.8.4 POWER Section ............................................................................... 136  
5.9 The Front Panel .................................................................................. 136  
5.10 TRAKTOR KONTROL S4 Modes ........................................................... 137  
5.10.1 Native Traktor Mode ................................................................. 137  
5.10.2 MIDI Mode .................................................................................. 137  

6 Customizing TRAKTOR KONTROL S4 ..................................................... 140  
6.1 The Preferences Window ..................................................................... 140  
6.2 Settings and Preferences for the S4 Control Elements ......................... 141  
6.3 S4 Control Options ............................................................................. 143  
6.3.1 Restore Default ........................................................................... 148  
6.3.2 Calibration ................................................................................... 149  
6.4 Other Settings of Interest ................................................................... 149  
6.4.1 Switching the Deck Flavors ......................................................... 150  
6.4.2 Adjusting the Input Routing ......................................................... 150  
6.4.3 Using Four FX Units .................................................................. 153  
6.5 The Setup Wizard ............................................................................... 154  

7 The S4 Audio Interface and Control Panel ............................................. 161  
7.1 Settings on Mac OS X ........................................................................ 161  
7.2 Settings on Windows: The Control Panel ........................................... 162  
7.2.1 Opening the Control Panel ......................................................... 162  
7.2.2 Audio Settings Page ................................................................. 163  
7.2.3 Diagnostics Page ....................................................................... 166  
7.3 Using the S4 Audio Interface with Other Music Applications .............. 167  
7.4 Using the S4 as your Default Audio Interface .................................... 168  
7.4.1 Windows XP ............................................................................. 168  
7.4.2 Windows Vista and 7 ................................................................. 168  
7.4.3 Mac OS X ................................................................................ 168
# Troubleshooting and Help

8.1 TRAKTOR Won’t Start ................................................................. 170

8.2 Hardware-related Problems .................................................... 170
  8.2.1 Basics .................................................................................. 170
  8.2.2 USB and Driver Issues ....................................................... 171
  8.2.3 Update the Driver ............................................................... 172
  8.2.4 USB-related Power Issues .................................................. 172
  8.2.5 Using the TRAKTOR KONTROL S4 with a Laptop .................. 173

8.3 Loose Jog Wheel Top Plate .................................................... 173

8.4 TRAKTOR Crashes ................................................................. 174

8.5 Getting Help ........................................................................... 174
  8.5.1 Knowledge Base / Readme / Online Support .................... 174
  8.5.2 Forum ............................................................................... 175

8.6 Updates .................................................................................. 175

# Appendix A – Common Setups

9.1 TRAKTOR KONTROL S4 Basic Setup ....................................... 176

9.2 Adding a Microphone .............................................................. 186

9.3 Using a Master Mixer .............................................................. 189

9.4 TRAKTOR KONTROL S4 with Turntables or CD Decks .......... 189

9.5 TRAKTOR KONTROL S4 with Slave Mixer .............................. 193

# Appendix B – Technical Information

10.1 Technical Specifications ...................................................... 195

10.2 Block Diagram ....................................................................... 199

# Appendix C – Quick References

11.1 Track Deck Quick Reference ............................................... 200

11.2 Remix Deck Quick Reference .............................................. 203

11.3 Mixer Quick Reference ........................................................ 207
  11.3.1 Main Section Quick Reference ....................................... 207
<table>
<thead>
<tr>
<th>11.3.2</th>
<th>Channel and Crossfader Quick Reference</th>
<th>208</th>
</tr>
</thead>
<tbody>
<tr>
<td>11.3.3</td>
<td>Master Display Quick Reference</td>
<td>209</td>
</tr>
<tr>
<td>11.4</td>
<td>FX Unit Quick Reference</td>
<td>209</td>
</tr>
<tr>
<td>11.5</td>
<td>Loop Recorder Quick Reference</td>
<td>210</td>
</tr>
<tr>
<td>11.6</td>
<td>Browsing, Loading and Copying Quick Reference</td>
<td>211</td>
</tr>
<tr>
<td><strong>Index</strong></td>
<td></td>
<td><strong>212</strong></td>
</tr>
</tbody>
</table>
Welcome to the World of TRAKTOR KONTROL S4!

We are delighted that you have chosen TRAKTOR KONTROL S4!

1.1 What Is TRAKTOR KONTROL S4?

TRAKTOR KONTROL S4 is the first fully integrated hardware and software DJ performance system created by the makers of TRAKTOR. TRAKTOR KONTROL S4 fuses the full-featured TRAKTOR KONTROL S4 hardware controller with the state-of-the-art TRAKTOR software.

The all-in-one TRAKTOR KONTROL S4 controller offers you an ergonomic DJ mixer, a built-in 24-bit/96 kHz audio interface, and a high-resolution control surface perfectly tailored for TRAKTOR. All controls needed for live performances now are at your fingertips!

— The TRAKTOR team at Native Instruments.

1.2 The TRAKTOR KONTROL S4 Documentation

1.2.1 Where To Start

TRAKTOR KONTROL S4 provides you with many information sources. The main sources are meant to be read in the following sequence:

- Setup Guide
- TRAKTOR KONTROL S4 Manual (this document) and video tutorials
- TRAKTOR 2 Getting Started Guide

Additionally, an overview poster and keyboard shortcut overview card will help you in your everyday work with TRAKTOR KONTROL S4. Finally, the Controller Editor Reference Manual deals specifically with the Controller Editor (see below).

Hereafter is a quick description of each of these documentation sources.
Some of these documents (Setup Guide, Overview Poster and Keyboard Shortcut Overview Card) are available in printed form in the product box. The whole documentation is also available in PDF format and located within the TRAKTOR KONTROL S4 installation folder on your hard drive. You can also access these documents from the application’s Help menu.

Your First Stop: the Setup Guide
A printed Setup Guide is included in the product box. It will guide you through the software and hardware installation of your TRAKTOR KONTROL S4 system, from the very beginning to the first sound coming through your speakers. This should be your first stop in learning TRAKTOR KONTROL S4.

First read the Setup Guide. Then proceed with this TRAKTOR KONTROL S4 Manual to get more familiar with TRAKTOR KONTROL S4!

TRAKTOR KONTROL S4 Manual
After having read the Setup Guide and followed its instructions, your TRAKTOR KONTROL S4 system should be up and running. The next step is to read this TRAKTOR KONTROL S4 Manual. The TRAKTOR KONTROL S4 Manual first gives you a practical approach to TRAKTOR KONTROL S4. Then, it provides you with a detailed reference of your TRAKTOR KONTROL S4 hardware controller along with extra information (solving common issues, specifications, etc.). The next section will give you an overview of the manual content.

Video Tutorials
The Native Instruments website provides you with a bunch of video tutorials that give you a hands-on approach to many sides of the TRAKTOR KONTROL S4 workflow. To see them, point your favorite browser to following URL:


TRAKTOR 2 Getting Started Guide
The Getting Started guide gives you a practical approach to the TRAKTOR software. Here you will learn about additional features of TRAKTOR that extend beyond the TRAKTOR KONTROL S4 controller.
TRAKTOR 2 Manual

For in-depth information on all features provided by the TRAKTOR software, please refer to the TRAKTOR 2 Manual. It is available as a PDF file in the Documentation subfolder of the TRAKTOR 2 installation folder.

Overview Poster

In the product box, you will also find a double-sided overview poster depicting the top panel of your TRAKTOR KONTROL S4 hardware controller: on one side, you will find an overview of the main areas and their functionality; on the other side, you will find a description of every control element to be found on the Decks, the FX Units, the Loop Recorder and the rear and front panels of your controller. This poster can be used as a quick reference when using your TRAKTOR KONTROL S4, saving you from opening the manual each time you feel uncertain about a particular control element.

Keyboard Shortcut Overview Card

A keyboard shortcut overview card is included in the product box. It gives you the dedicated keyboard mappings for the TRAKTOR software.

Controller Editor Reference Manual

Beside of using your TRAKTOR KONTROL S4 hardware controller together with the TRAKTOR software, you can also use it as a powerful and highly versatile MIDI controller to pilot any other MIDI-capable application or device. This is made possible by the Controller Editor software, a little application that allows you to precisely define all MIDI assignments for your TRAKTOR KONTROL S4 controller. The Controller Editor should have been installed during the TRAKTOR KONTROL S4 installation procedure. For more info on this, please refer to the Controller Editor Reference Manual available as a PDF file in the Documentation subfolder of the Controller Editor installation folder on your hard disk.

The Jog Wheel Calibration Guide

The jog wheels of the S4 where designed to recalibrate themselves dynamically during the use of the controller; however, there is one situation in which manual recalibration of the jog wheels can be necessary. If you accidentally turn the controller upside-down while it is connected to your computer, the jog wheel sensors might lose track of the position of the jog wheels' top plates. As a result, the jog wheels may not respond as expected when you turn it back to
the normal position. If this occurs, the easiest way to resolve this is to switch the unit off and on again. Alternatively you can recalibrate the jog wheels manually in TRAKTOR. Please refer to the separate Jog Wheel Calibration Guide in the Documentation subfolder of the TRAKTOR 2 program folder.

1.2.2 In This Manual

What you are reading now is the TRAKTOR KONTROL S4 Manual. This manual is structured as follows:

- The first part is this introduction.
- Chapter 2, TRAKTOR KONTROL S4 Overview quickly introduces you to the TRAKTOR KONTROL S4 user interface and its main areas, both on the hardware side and software side.
- Chapter 3, Importing Your Music shows you how to import your own music into the powerful Track Collection of TRAKTOR, so that you can use all TRAKTOR KONTROL S4 features with your own tracks.
- Chapter 4, Tutorials is a selection of tutorials focused on your controller. They will let you progressively discover how to use the various tools provided by TRAKTOR KONTROL S4. These practical examples will simplify the learning process and get you quickly started with computer-based DJing.
- Chapter 5, Hardware Reference is an extensive reference of all hardware control elements to be found on your TRAKTOR KONTROL S4 hardware controller. Whenever you are unsure about the functionality of a particular control element, you will find here all the necessary information.
- Chapter 6, Customizing TRAKTOR KONTROL S4 shows you how to customize TRAKTOR KONTROL S4 in order to make it fit your particular needs.
- Chapter 7, The S4 Audio Interface and Control Panel describes the on-board audio interface of the TRAKTOR KONTROL S4 hardware controller.
- Chapter 8, Troubleshooting and Help provides you with a list of most common problems and their solutions, along with info on how to get help.
- Finally, three appendixes provide you with useful additional information:
Appendix A shows you how to integrate TRAKTOR KONTROL S4 to your studio or live setup in various configurations.

Appendix B gives you the technical specifications of the TRAKTOR KONTROL S4 controller.

Appendix C provides you with Quick Reference tables for all control elements on your controller. Should you have any doubt about a particular control element, you will find here a useful reminder!

1.2.3 Manual Conventions

This section introduces you to the signage and text highlighting used in this manual. This manual uses particular formatting to point out special facts and to warn you of potential issues. The icons introducing these notes let you see what kind of information is to be expected:

Whenever this exclamation mark icon appears, you should read the corresponding note carefully and follow the instructions and hints given there if applicable.

This light bulb icon indicates that a note contains useful extra information. This information may often help you to solve a task more efficiently, but does not necessarily apply to the setup or operating system you are using; however, it's always worth a look.

Furthermore, the following formatting is used:

- Text appearing in (drop-down) menus (such as Open..., Save as... etc.) and paths to locations on your hard drive or other storage devices is printed in italics.

- Text appearing elsewhere (labels of buttons, controls, text next to checkboxes etc.) is printed in blue. Whenever you see this formatting applied, you will find the same text appearing somewhere on the screen.

- Important names and concepts are printed in bold.

► Single instructions are introduced by this play button type arrow.

→ Results of actions are introduced by this smaller arrow.
Pet Names for Software and Hardware

Throughout the documentation, we will refer to the TRAKTOR KONTROL S4 hardware controller either as “TRAKTOR KONTROL S4” or simply “S4.”

Likewise, the TRAKTOR software will often be referred as “TRAKTOR PRO” or simply “TRAKTOR.”

Hence, a sentence like “TRAKTOR KONTROL S4 is a highly integrated DJ system allowing you to control TRAKTOR from your S4” shouldn’t sound weird to you.

1.3 System Requirements

For the minimum system requirements your computer needs to meet, see the TRAKTOR specifications section of the Native Instruments website:


To check the compatibility with several operating systems, please have a look at: http://www.native-instruments.com/compatibility
2 TRAKTOR KONTROL S4 Overview

This mini-chapter will quickly introduce you to TRAKTOR KONTROL S4’s main areas and concepts, both on your TRAKTOR KONTROL S4 hardware controller and in the TRAKTOR software.

Take the time to read these few pages, as they will familiarize you with the way TRAKTOR KONTROL S4 works and let you catch sight of the power of its design. If you're familiar with importing music files in TRAKTOR, you can skip ↑3, Importing Your Music and start right away with the tutorials in chapter ↑4, Tutorials after having read this chapter.
Hardware controller and software side by side

- **(1) Decks:** TRAKTOR KONTROL S4 provides you with four virtual Decks. The Decks are the place where tracks, Samples and live input are played back. The Decks can be seen as the virtual equivalent to the good old vinyl or CD decks—just with a bunch of powerful additional features and the flexibility of a computer-based system. The two Decks on your S4 hardware controller allow you to control the four software Decks (labeled A, B, C and D) available in TRAKTOR: The **left Deck** on your S4 can control Decks A and C in the software. The **right Deck** on your S4 can control Decks B and D in the software.
• (2) **FX Units**: The signals coming from the Decks can be further processed by two FX Units located at the top of your hardware and software interface. You can even activate two additional FX Units in the software, allowing you to process each Deck individually. The FX Units give you access to the whole collection of high-quality FX included in TRAKTOR: The **left FX Unit** on your S4 can control the left FX Unit(s) in the software. The **right FX Unit** on your S4 can control the right FX Unit(s) in the software.

• (3) **Mixer**: Sitting in the middle of your TRAKTOR KONTROL S4 controller and of TRAKTOR’s window, the Mixer receives on its four **channels** the audio signals coming from the four Decks described above. There is one channel for each Deck. As any DJ mixer, the Mixer’s purpose basically is to adjust the relative level of each channel, to control the channels’ frequency content, possibly feeding them into the FX Units before sending the overall result to the **Main section** at its top — and in the end, to generate the mix that is sent to your audience.

You will find a more detailed presentation at the beginning of chapter 5, *Hardware Reference*, followed by a thorough description of each control element to be found on your TRAKTOR KONTROL S4 controller. For an in-depth explanation of each and every functionality provided by the TRAKTOR software, please refer to the separate TRAKTOR 2 Manual. It is available as a PDF file in the Documentation subfolder of the TRAKTOR 2 installation folder.
3  Importing Your Music

Most likely you already have a collection of music files on your computer. For those of you who can’t wait for mixing their own tracks, this chapter is for you! You will learn here how to quickly import your music into the powerful **Track Collection** of TRAKTOR.

If you prefer to start learning how to use TRAKTOR KONTROL S4 right away, skip this chapter and go on with the tutorials in chapter ↑4, **Tutorials**, which make use of the demo tracks provided with TRAKTOR KONTROL S4. You can always come back here at a later point.

3.1  What Is the Track Collection?

The Track Collection (or simply “Collection”) represents the whole music that you have used, that you are using or that you plan to use in TRAKTOR.

Based on the music files on your computer, the Track Collection is just another way to display them. The Collection makes it easy to organize, tag, and prepare your tracks for being integrated into your mix.

Worth to note is that the Track Collection doesn’t care about the actual file structure on your hard disk, nor will it alter this structure in any way (as long as you don’t delete your files from within TRAKTOR).

The Track Collection is:

- A database storing numerous information about your music files.
- A convenient way to represent and search your music files, according to many of their characteristics (tags) like title, artist name, BPM, genre, length, etc.
- The place where TRAKTOR-specific information about your tracks is stored.
- The basis on which you can create your Playlists.

The Track Collection is **not**:

- Moving, copying nor converting any audio file to some secret location.
- Modifying in any way the hierarchic structure of your files on your hard disk.
To make use of the Track Collection, you have to populate it by importing your music files.

3.2 Importing Music Folders

TRAKTOR offers an easy import function for tracks stored on your hard drive:

- Right-click (Windows) or [Ctrl]+click (Mac OS X) on the Track Collection entry in the Browser Tree and choose Import Music Folders from the menu.

By default this process imports all music files contained in the My Music folder of your operating system.

TRAKTOR analyzes music for certain characteristics (BPM, etc.) when importing tracks for the first time. This function takes some time to process. Be sure to prepare the tracks you want to use in a DJ set beforehand if you want to use features such as synching or Auto Looping with them.

If you have stored tracks in other folders or on external storage devices, you can add these folders to the list of TRAKTOR Music Folders as follows:

1. Open Preferences > File Management.
2. Click **Add…** at the bottom of the **Music Folders** section.
3. Navigate to a folder you want to add.
4. Confirm with **OK**.
Repeat to add all of your Music Folders.

Subfolders are automatically included in the scan. Hence, you don’t need to add them to this list.

### 3.3 Tracks Managed by iTunes

If you have organized your music collection with iTunes, TRAKTOR KONTROL S4 offers direct access to your iTunes Library and your iTunes playlists.

#### 3.3.1 Playing Tracks Managed by iTunes

You can browse your iTunes Library and playlists directly from your TRAKTOR KONTROL S4. By the way, this will be the opportunity to introduce you to browsing and loading from your hardware controller. For this, we will use following control elements:

- Any of the jog wheels:
Please do the following:

1. Push the BROWSE button to enter Browse mode. On your computer screen, the Browser fills up the whole TRAKTOR window.
2. Turn the LOOP MOVE encoders to scroll through the Browser Tree until the iTunes icon gets selected, then push the encoder to open that node.
3. Browse through the iTunes Library and playlists in the same manner: turn the LOOP MOVE encoder to scroll within the iTunes node and push the encoder to expand/collapse the selected node.
4. Once the desired playlist is selected in the Browser Tree, select a track from the list by spinning the jog wheel.
5. To load the selected track on to the left or right Deck, press the flashing CUE button on the corresponding channel of the Mixer (A or B).
6. Repeat steps 3-5 to load a track on the other Deck.
7. When you are done, press the BROWSE button again to leave the Browse mode.

The iTunes tree node represents a read-only view on your iTunes Library and playlists. Editing functions are not available in this view.

Software Equivalent

Of course, you can do all this from the TRAKTOR user interface too:
1. Click the iTunes icon in the Browser Tree to open that node.
2. Browse through the Library and playlists as you would do in iTunes.
3. Load a track into a Deck as you would do from a normal TRAKTOR Playlist—for example by dragging the track onto that Deck.

### 3.3.2 Importing a Selection of Tracks from iTunes

You can import a selection of tracks from your iTunes Library into the Track Collection via the TRAKTOR user interface:

1. Click the iTunes icon in the Browser Tree to open that node.
2. Select the tracks to import into the Track Collection.
3. Drag the selection onto the Track Collection icon in the Browser Tree.
4. Alternatively right-click (Windows) or [Ctrl]-click (Mac OS X) on the selection and choose Import to Collection in the contextual menu.

### 3.3.3 Importing iTunes Playlists

You can directly import iTunes playlists as TRAKTOR Playlists via the TRAKTOR user interface:

1. Click the iTunes icon in the Browser Tree to open that node.
2. Select the playlist to be imported.
3. Drag the playlist onto the Playlists icon.
4. Alternatively right-click (Windows) or [Ctrl]-click (Mac OS X) on the playlist and choose Import to Playlists in the contextual menu.
4 Tutorials

This chapter will guide you through the most common tasks that you will encounter during your work with TRAKTOR KONTROL S4.

The tutorials are workflow-oriented. They start with the simplest tasks and progressively lead you to more complex operation, helping you to get more and more familiar with your TRAKTOR KONTROL S4 system. After reading this, you should have the basic know-how allowing you to mix with TRAKTOR KONTROL S4.

The tutorials presented here and in the following chapter make use of the included demo tracks, which were copied to your hard disk during the TRAKTOR KONTROL S4 installation procedure. Thus, you can follow these tutorials even if you haven’t imported your own music yet into the Track Collection. For more info on how to import your music into the Collection, please refer to chapter ↑3, Importing Your Music above.

4.1 Playing Your First Track

This first tutorial will show you how to load and play a track, how to check the needed audio outputs and how to quickly troubleshoot your system if no music can be heard.

Prerequisites

We assume here that your TRAKTOR KONTROL S4 system is already up and running. If it’s not the case, please follow first the instructions in the separate Setup Guide and come back here when you’re done!

In case you already changed some settings in TRAKTOR KONTROL S4 before you start with these tutorials, we strongly recommend you to reset your TRAKTOR KONTROL S4 system to the factory settings by doing the following:

1. In the TRAKTOR software, click the Help menu in the menu bar at the top of your screen (on Mac OS X) or at the top of the window (on Windows), and select Help > Start Setup Wizard.
2. In the window that opens, just click Finish at the bottom right corner without touching anything else.
Your TRAKTOR KONTROL S4 is now reset to the factory settings.

The tutorials presented here assume that TRAKTOR KONTROL S4 is in its default factory state. If it's not the case, we cannot guarantee that you will experience what we describe here, and you might miss important things to know!

4.1.1 Quick Loading a Track

Let’s load the track “Techno 1” from the included demo tracks on to Deck A.

Since Deck A is sitting in the left part of the TRAKTOR window, we will use the left Deck on your S4. You can check this by looking at the left Deck’s display: you should see a lit blue indicator reading “DECK A”:

![The Deck Display with a lit DECK A indicator](image)

To select and load the track, we will use three control elements on your S4:

- Any of the two SHIFT buttons (one at the bottom of each Deck):
  ![SHIFT](image)

- The BROWSE encoder (in the top center of the Mixer):
  ![BROWSE](image)

- The left Deck’s LOAD button (above the jog wheel):
  ![LOAD](image)
While looking at the TRAKTOR window, do the following:

1. Hold SHIFT and turn the BROWSE encoder to select the Demo Tracks Favorite (Favorites are customizable shortcuts sitting at the top of the Browser in TRAKTOR’s window). The tracks of the “Demo Tracks” Playlist appear below:

   Release SHIFT and turn the BROWSE encoder to scroll through the Playlist and navigate to the track Techno 1.

2. Once the track is highlighted, press the LOAD button on the left Deck to load that track on to Deck A.
The track is loaded. In TRAKTOR, its waveform and info appear on Deck A:

The LOAD button on the right Deck of your S4 would have loaded the track on to Deck B in TRAKTOR.

In addition to using the S4 to load a track, you can also drag and drop tracks from the Browser or from a folder on your computer directly into one of TRAKTOR’s Decks.

### 4.1.2 Playing the Track

- Once the track is loaded, simply press the PLAY button at the bottom of the left Deck:

  ![PLAY button](image)

  The track starts playing. The PLAY button lights up and the waveform starts moving in TRAKTOR.
Again, pressing the PLAY button on the right Deck would have started the playback on Deck B.

To Each Deck Its Own Channel

The audio playing on each Deck can be further shaped by the controls on the corresponding channel of the Mixer. Since the track is loaded on Deck A, you can control its sound on channel A (showing a lit blue “A” letter):

![The Channel A](image)

At this point you will probably hear some audio coming through your speakers or PA. If not, please check the following section.

4.1.3 If You Don’t Hear the Track

If the track is playing on the Deck but the audio coming through your amplification system sounds too low, or if there is no sound at all, check the following:
- At the bottom of your S4, verify that the crossfader is moved all the way to the left:

- Above, the channel fader should be raised on channel A:

- The channel meter (the vertical bar of LEDs along the channel fader, see picture above) should show some activity. If not, check that the HI, MID, LOW and FILTER knobs higher up on that channel are set to center position; at the top of the channel, push the GAIN encoder once to reset the channel’s input gain to 0 dB.
At the top center of the Mixer, the MAIN LEVEL knob should be turned at least part of the way to the right. You should see the MAIN LEVEL meters going up and down:

If not, at the top center of the TRAKTOR window, check that the MAIN knob is raised:

If you see some activity on the MAIN LEVEL meters of your S4 but don’t hear any sound, then double-check the connection starting with the cable going from the S4’s Main Outputs to your PA.

4.2 Mixing In a Second Track

Now that you have learned how to quickly load and play tracks using the TRAKTOR KONTROL S4 (see the previous tutorial), let’s see how to mix in a second track. On the way, you will learn a few basic mixing tasks that every digital DJ needs to know: how to pre-listen tracks, synchronize tracks, start the playback at the right position, and mix the tracks together using the crossfader.

Prerequisites

We assume here that you already followed the instructions in the previous tutorial (see ↑4.1, Playing Your First Track). TRAKTOR KONTROL S4 now is in the following state:

- The track “Techno 1” is loaded on Deck A. The track is playing and audible.
The crossfader is all the way to the left.

4.2.1 Pre-listening a Second Track Directly from the Browser

Before we load another track, we will use TRAKTOR KONTROL S4’s Preview Player to pre-listen the track in the headphones directly from the Browser.

1. If it’s not already done, plug in a pair of headphones to the PHONES socket on the front panel of your S4.
2. On the right of the PHONES socket, turn the CUE VOL knob fully down and put on your headphones.
3. Next to the PHONES socket, Turn the CUE MIX knob fully counter-clockwise.
4. On the top panel of your S4, turn the BROWSE encoder to select any track in the Playlist.
5. Now press the BROWSE encoder.
   The selected track is loaded into the Preview Player, as indicated by the Preview Play (headphones) indicator in the top right corner of the Master Display in the middle of your S4:

6. On the front panel, turn up the CUE VOL knob to a suitable level.
   You should hear the track playing in the Preview Player.
7. By turning the BROWSE encoder, you can seek through the track and pre-listen other parts of the track.
8. To unload the track from the Preview Player, press the BROWSE encoder again.
→ You get back to the list browsing. You can select another track for pre-listening or load the desired track on a Deck.

### 4.2.2 Loading and Playing the Second Track

We will choose the track “Techno 2” and load it on Deck B, as we did on Deck A in the previous tutorial:

1. Turn the BROWSE encoder to select the track *Techno 2* in the Playlist.
2. Press the LOAD button on the right Deck to load the track on to Deck B. In the TRAKTOR window, the track info and waveform appear on Deck B.
3. Press the PLAY button on the right Deck to start the playback.

→ The track starts playing. The PLAY button lights up and the waveform starts moving on TRAKTOR’s Deck.

We don’t hear anything from Deck B through the speakers yet because we have set the cross-fader on the S4 all the way to the left—our plan is to slowly mix in the track on Deck B.

You can already give it a try: by slowly moving the crossfader to the right, you should hear the track on Deck B fade in, whereas the track on Deck A progressively fades out as you move the crossfader further to the right. Obviously, our mix is not satisfying at all yet: before mixing in the second track, we first have to beat-match it to the track playing on Deck A. So for now, pull the crossfader all the way back to the left.

If you don’t hear any sound coming from Deck B even with the crossfader all the way to the right, check the few troubleshooting guidelines in section ↑4.1.3, If You Don’t Hear the Track above.

### 4.2.3 Using Headphones to Prepare the Mix

From now on, let’s get used to preparing our mix with headphones until the next track (here on Deck B) is ready to be mixed in.
On your S4, press the CUE button on the channel B.

The button lights up, indicating that Deck B is now sent to the Cue channel, which you will hear in your headphones.

At any time, use the CUE MIX knob nearby to adjust the balance between the cued track (Deck B) and the main mix (Deck A) in your headphones: turn it counter-clockwise when you want to concentrate on the cued track; turn it clockwise when you want to hear more of the main mix.

You are now ready to work on the track playing on Deck B without interfering with the main mix sent to your audience. Regardless of the mix that you’re hearing in your headphones, the main mix is still controlled by the crossfader and channel faders.

### 4.2.4 Synchronizing the Second Track

Before mixing in the track playing on Deck B, we will use TRAKTOR’s automatic Sync feature to adjust its tempo to that of Deck A. This is done in just one step via the SYNC button:
Press the SYNC button on the right Deck to synchronize its tempo and phase with those of Deck A.

The SYNC button lights up. Now the two tracks are in perfect sync.

By slowly turning the CUE MIX knob on the front panel, you will hear the second track come into the mix in sync with Deck A.

Note that you should always adjust the tempo of the track that is not audible to the audience!

4.2.5 Setting a Cue Point as Starting Point

You will probably want to have more control over which particular part of the track you mix in. For example, most of the time, not only the tempos but also the downbeats of both tracks should match. Using a particular point in a track (for mixing in, triggering, etc.) is called “cueing.”

TRAKTOR KONTROL S4 lets you mark points for cueing—we call them Cue Points. This notably allows you to re-use these points at a later stage, or in a later session.

On the right Deck, whether or not the track is playing, simply press one of the unlit Hotcue buttons on a downbeat—let’s say the Hotcue button 1.

The Hotcue button lights up in blue: you’ve just stored a Cue Point that you can return to simply by pressing the same Hotcue button again.

The first Hotcue button is now lit in blue.
**Snapping to the Beats**

You don’t have to worry about dropping a Hotcue directly on a beat: by default, TRAKTOR will make sure this happens automatically. This is because the so-called Snap mode is on, as you can see by the lit SNAP indicator on the Master Display, located in the middle of the Mixer:

![The SNAP button and indicator on the Master Display](image)

With Snap mode on, any point you set in the track will snap to the closest beat, thus ensuring that you get directly to that beat next time that you jump to that point.

**Aligning the Tracks**

Aligning both tracks is straightforward:

1. Make sure that Deck B is playing (its PLAY button must be lit).
2. When you hear a downbeat in the other track, press the Hotcue button you just used to store the downbeat position.

→ The playback position on Deck B jumps to the stored Cue Point (as you can see in the TRAKTOR window), and the playback continues from there. Both tracks now are perfectly aligned, ready to be mixed.

**Sticking to the Beats**

Again, you don’t have to worry about pressing the lit Hotcue button *exactly* on the beat: by default, TRAKTOR will make sure that the beats of both tracks stick together and that the jump doesn’t ruin the beat matching. This is because the so-called Quantize mode is on, as you can see by the lit QUANT indicator on the Master Display (see picture above).

With Quantize mode on, whenever you jump through the track (e.g. by pressing a Hotcue button), the playback jumps to the nearest position that preserves the beat matching, thus ensuring that the current sync doesn’t get lost when you jump through the track.
4.2.6 Interlude: In Case the Left Track Is Over

The track “Techno 1” on Deck A has been playing since we started with the tutorials, and it might happen that the playback reaches the end of the track. In this case, just do the following:

► On the left Deck, press SHIFT + CUE to skip back to the beginning of the track.

You can then resume from where you left off.

4.2.7 Mixing In the Track by Using the Channel EQ and Filter

Now would be a great time to audition some of TRAKTOR KONTROL S4’s EQs and filters:

The EQ and FILTER knobs on channel B

► Turn any of the EQ or FILTER knob on channel B to hear the effect on the cued track.
The EQs and filters are excellent tools for making adjustments to tracks before mixing them in so that you get the smoothest transition possible. The most common technique is to filter the bassline out of the incoming track—having 2 basslines running rarely sounds good. Do the following:

- You just did your first mix with TRAKTOR KONTROL S4!

### 4.2.8 Doing Everything by Hand

You can also do your mix manually instead of using TRAKTOR’s sync and cueing facilities.

Most probably, you won’t do everything by hand in your everyday DJ work. Nevertheless, it is a good idea to get familiar with the “handcrafted” way:

- It can be necessary when synching to a playing vinyl record or to the previous DJ.
- You can combine it with TRAKTOR’s advanced features, thus further developing your own mixing style.

To show this, let’s mix a new track on Deck A with the one we just mixed in on Deck B.

- From now on, the track on Deck B is “on air,” i.e. it is heard by your audience. Hence, we will now exclusively work on the left Deck, which controls Deck A in the software.

### First Steps

1. First check that the crossfader is at full right.
2. With the track on Deck B still playing, load the track “House 1” onto Deck A (reminder: turn the BROWSE encoder to select the track in the list, then push LOAD on the left Deck).

   - At first, it may help to select a track with a similar BPM.

3. Press PLAY on the left Deck to start the playback of the new track.
4. On the same Deck, make sure the SYNC button is off.
5. On the Mixer, deactivate the CUE button above channel B’s fader and activate that of channel A to hear the new track in the headphone mix (you might need to adjust the CUE MIX knob accordingly).

**Adjusting the Tempo**

The tempo for each Deck can be manually controlled via the TEMPO fader:

![TEMPO fader](image)

Use the TEMPO fader to adjust the Deck’s tempo.

► Adjust the TEMPO fader on the left Deck until the track’s BPM either “sounds right,” or directly matches the value of the other track’s BPM, which is displayed at the top of Deck B in TRAKTOR.

**Manually Cueing with the Jog Wheel**

You can use the jog wheel to manually seek through the track and find a nice bring-in point:
Use the jog wheel to manually seek through the track.

1. On the left Deck, press and spin the jog wheel’s top plate to seek through the track. (You can also fast seek through the track by holding the SHIFT button at the bottom of the Deck while spinning the jog wheel.)

2. Once you have found an interesting point for cueing (let’s say a downbeat), keep pressing the top plate and release it when a downbeat arrives in the other track. Deck A starts playing from that point.

Note that you could also stop the playback (by pressing the PLAY button) before you seek an interesting point with the jog wheel. Once you have found the point, you can release the jog wheel—since the Deck is not playing, you won’t lose the point. When a downbeat arrives in the other track, press PLAY again on the left Deck.

**Aligning the Beats**

In case you still hear a slight offset between both tracks, you can use the outer rim of the jog wheel to adjust the track’s phase and cancel the offset:

► On the left Deck, move the jog wheel’s outer rim in the desired direction to temporarily bend the tempo and adjust the phase in order to cancel any minor offset.

→ Your tracks now perfectly match.
Note that this can also be useful when using TRAKTOR’s Sync feature. Indeed, in some situations, the automatic beat detection might need a slight correction: for example, in tracks with unusual low frequency content, the beat “feeling” might occur slightly after the beat as detected by TRAKTOR. If you couldn’t make it to manually correct the Beatgrid of your track before you go on stage, you can cancel the offset on the fly with the jog wheel’s outer rim.

Mixing In the New Track

► When you’re ready, you can bring the crossfader over from Deck B and slowly mix in the track in Deck A.

→ You just did your first handmade mix with TRAKTOR KONTROL S4!

Don’t expect to be capable of manually matching beats right away, though—this requires intensive training and can’t be fully explained here in detail. Practice makes perfect!

4.3 Adjusting Levels

Before going any further, we would like you to be aware of how important it is to have your mix at the right level. We provide you here with a few simple hints in order to get the best sound out of your mix.

Even if this section might look a bit technical, please take the time to read these few pages, as they can save you a lot of trouble, especially in a live situation!

4.3.1 The Theory

By mixing, you blend together signals coming from different sources (and possibly process them on the way).

The basic rule is: you need to ensure that no signal is clipping, while simultaneously trying to use the full dynamic range available. Just to keep it short, there are two reasons behind this:

• By using the full dynamic range available, you keep the noise level low relative to your mix. As a result, all the details of your music are better rendered.
• When a signal is clipping, it is not getting louder, just worse. The loud parts (typically the beats) are cut, which both reduces the dynamic range and introduces distortion in your mix. The speakers will suffer from this—and so will your audience! (Be also prepared for some angered sound technician or club owner coming down on you.)

Hence, you should always make sure that your signals stay at levels that satisfy these two requirements.

### 4.3.2 The Practice

To assist you in adjusting levels, the Mixer of your S4 is equipped with various level meters and controls. Each level meter consists of a bar of blue LEDs indicating the signal level, along with an orange LED at the top indicating the clipping.

The rule mentioned above can thus be translated as follows:

► Best practices when adjusting levels: Ensure that the displayed levels go high enough in the blue areas but don’t reach the orange LEDs, or only rarely.

Letting your levels go “in the red” (or orange in this case) and using signal clipping to let your mix sound dirtier is definitely not recommended: to do this, make use of the great FX selection of TRAKTOR KONTROL S4 instead!

### Checking the Level on Each Channel

Each channel on the Mixer provides you with a vertical channel meter next to the fader. This meter shows you the pre-fader level of the signal on that channel, i.e. the level of the signal before it is adjusted by the channel fader. To adjust this level, use the GAIN encoder at the very top of the channel:
A GAIN encoder sits at the top of each channel

► Adjust the channel’s GAIN encoder so that the level displayed on the channel meter stays in the upper part of the blue area without reaching the orange clipping LED.

Note that the channel’s EQ and filter settings also affect the signal level, as well as the possible FX Unit(s) it is assigned to. Hence, when modifying any of these, you might need to re-adjust the GAIN encoder accordingly.

Of course, the artistic side of your tracks should not be overlooked: for tracks with a variable average level over time (e.g. a track starting with a soft intro), you should consider the loudest parts of the track when adjusting the channel level.

Matching Levels Between Channels

Moreover, in order to avoid any level jump when crossfading between two channels, the average channel levels should match:

► Before mixing in a cued channel, adjust its GAIN encoder so that its channel meter activity roughly matches that of the channel currently on air.

TRAKTOR already does this for you by automatically setting the level for each newly loaded track to a satisfying value. This so-called “Autogain” feature relies on the gain values extracted from your tracks. Nevertheless, depending on the particular EQ, filter and FX applied to the cued track, you might have to double-check the level consistency before you mix in the track. Moreover, what is important here is the average level of the specific part of the track that you’re about to mix in.

Checking the Main Level

The signals coming from all channels are mixed together according to the relative levels set by the channel faders and by the crossfader. This mix is then sent from TRAKTOR’s main output to the Main section:
In this section, the MAIN LEVEL meters show you the (left and right) overall level of your mix before it is adjusted by the MAIN LEVEL knob. These meters actually mirror the MAIN meter in the Header of TRAKTOR. To adjust this level, use the MAIN knob right below in TRAKTOR’s Master panel:

Adjust the MAIN knob in TRAKTOR’s Master panel so that the values on your S4’s MAIN LEVEL meters stay in the upper part of the blue areas without reaching the orange clipping LEDs.

By default, a limiter is enabled on TRAKTOR’s main output. With this limiter enabled, the MAIN LEVEL meters’ clipping LEDs don’t indicate clipping anymore, but instead they indicate when the limiter kicks in. While the limiter virtually cancels any distortion that might occur, the resulting contraction of the dynamic range, though, cannot be undone. Therefore, even with the limiter enabled, ensure that the clipping LEDs don’t light up too often!

When the orange clipping LEDs light up, turning down the MAIN LEVEL knob on your S4 is of no use: indeed, changing the level of the already distorted or shrunked signal coming from TRAKTOR won’t repair it!

Should the level stay low on the MAIN LEVEL meters, check also the channel faders—they are probably set too low as well!
4.4 Looping and Cueing

Now that you have learned the basic mixing tasks, we will focus on one of TRAKTOR KONTROL S4’s great features: its looping facilities.

Prerequisites

As always, we assume here that you already followed the instructions in the previous tutorials. TRAKTOR KONTROL S4 now is in the following state:

- The track “House 1” is loaded on Deck A. The track is playing and audible.
- The crossfader is all the way to the left.

4.4.1 Playing with Loops

On your S4, each Deck is equipped with dedicated loop controls, located in the Loop section, right under the Deck Display:

The Loop section, from left to right: LOOP MOVE encoder, LOOP IN and LOOP OUT buttons, and LOOP SIZE encoder.

Setting a Loop with a Predefined Size

Let’s add a Loop to the track on Deck A.

To engage a loop on a playing track, just push down the LOOP SIZE encoder.
This will automatically add a loop at that position in the track.

The loop size will correspond to the number on the Deck Display just above the LOOP SIZE encoder:

![Loop Size Display](image)

To change the size of the Loop, just turn the same LOOP SIZE encoder until the display reads the number of beats you’d like the Loop to be.

Note that you can adjust the loop size either before or after you’ve set the Loop! When doing it beforehand, it will affect the next Loops you set.

### Setting a Loop Manually

You can also manually set loop start and loop end points. To do this, use the LOOP IN and LOOP OUT buttons in the Loop section:

![Loop IN and OUT buttons](image)

1. Press the LOOP IN button to set the Loop In Point.
2. Press the LOOP OUT button to set the Loop Out Point.
   
   As soon as you hit the LOOP OUT button, a Loop is set and the track will start looping.

We already introduced the Snap mode in the previous tutorial (see ↑4.2.5, Setting a Cue Point as Starting Point). This mode also affects the Loop In and Loop Out Points, so that they will automatically be positioned directly on the beat.

Of course, you can also change the size of manually set Loops via the LOOP SIZE encoder as described above.
Moving a Loop

You can also quickly move the active Loop across your track by using the LOOP MOVE encoder, at the left of the Loop section:

To move the Loop, turn the LOOP MOVE encoder.

The size of the move also corresponds to the loop size that is currently set, as displayed above the LOOP SIZE encoder.

Turning the LOOP MOVE encoder when there is no Loop currently active lets you jump backward/forward through the track by the same loop size. See section 5.3.8, Loop Section for more info.

Storing a Loop

In the previous tutorial, we looked at how to store Cue Points. This is as simple as pressing an unlit Hotcue button.

Storing Loops works similar:

To store the active Loop, press an unlit Hotcue button.
The Hotcue button lights up, this time in green: you’ve just stored a Loop that you can return to simply by pressing the same Hotcue button again.

Deactivating Looping
If you want to deactivate the current Loop, do the following:
► To deactivate looping, push either of the LOOP MOVE or LOOP SIZE encoder.
► The playback continues after the Loop.

By pushing the LOOP MOVE encoder when there is no Loop currently active, you activate looping: the next Loop in the track will be activated.

4.4.2 Using Hotcues
In this tutorial and in the previous one, we already used Hotcues to store Cue Points and Loops. We want to show you here a few more details on their use.

As already explained, when pressing an unlit Hotcue button, if there is no Loop active you store a Cue Point at the current playback position (the Hotcue button turns blue), and if there is a Loop active you store this Loop (the Hotcue button turns green).

On the waveform of the software Deck, you can see that a line with the same color appears in the track at the corresponding position. Moreover, a little number at the top reminds you which button you should use to jump to that Cue Point or Loop:
A waveform with a Cue Point stored as Hotcue 2 and a Loop stored as Hotcue 3.

If you make a mistake, or just decide you no longer want a particular Hotcue, you can quickly clear it:

► To clear a Hotcue, hold down the SHIFT button and press the corresponding Hotcue button.

→ You can see that the button is no longer lit.

**Creative Uses of Hotcues**

Hotcues aren’t just bookmarks to particular sections of a track—they can also be used for creative techniques such as remixing parts of a song, beat juggling effects, etc.

As an example, we will show you here how you can quickly make use of a Loop stored in a Hotcue slot to introduce the track you’re about to mix in. By the way, this will allow us to sum up what we’ve learned until now.

Provided that you carefully followed the instructions in the previous tutorials, the track “Techno 2” is still loaded on Deck B. Let’s say that the track on Deck A is on air (crossfader at full left) and you want to prepare the track on Deck B for mixing in:

1. Start the playback of the next track and send it to your headphones by activating the CUE button on the corresponding channel.
2. Find an interesting Loop near the beginning of the track by using the controls in the Loop section of the right Deck.
3. Once you have a nice Loop running, store it by pressing an unlit Hotcue button and leave it playing.
4. Now start to bring this Loop in your mix, for example by implementing the lowcut we explained in the previous tutorial (see ↑4.2.7, Mixing In the Track by Using the Channel EQ and Filter).
5. When you’re about to fade out the previous track completely, release the Loop on the new track, and you’re done.

4.5 Using Samples in Your Mix

The Remix Decks are a great way to add Samples to your set, or capture Samples from Track Decks for on-the-fly remixing.

The Remix Deck C with a Sample loaded in the upper Sample Cell of the first Sample Slot.

You can also use the Remix Decks to build new tracks on the fly, layering One-shot Samples and Loops on top of each other. Now let’s find out how to control the Remix Decks with your S4.

In case you were using Sample Decks in an earlier TRAKTOR version, don’t panic! All former Sample Slot functionality stays preserved.

Prerequisites

As always, we assume here that you already followed the instructions in the previous tutorials. TRAKTOR KONTROL S4 now is in the following state:
The track “Techno 2” is loaded on Deck B. The track is playing and audible. By the way, from now on we will use “Track Deck” to describe Decks that play tracks, so that we can easily distinguish Track Decks from Remix Decks. In TRAKTOR, you can see that the two upper Decks (A and B) are Track Decks, whereas the two lower Decks (C and D) are Remix Decks.

- The Deck A is stopped (if it’s not the case, press the PLAY button on the left Deck).
- The crossfader is all the way to the right.

4.5.1 Loading a Sample from the Collection

You can load Samples directly from your Track Collection. This will give us the opportunity to try the Browse mode on your S4 controller: this mode allows you to browse your whole computer for tracks and Samples.

The BROWSE button

1. Push the BROWSE button in the middle of the S4 to enter Browse mode. The BROWSE button lights up. You can see all available targets flashing on your S4 — among them, the four Sample Play buttons on each Deck.

2. Turn the LOOP MOVE encoder to select the Track Collection folder from the Browser Tree. Press the LOOP MOVE encoder button to expand the folder node.

3. Turn the LOOP MOVE encoder to select the All Remix Sets folder from the Browser Tree. Press the LOOP MOVE encoder button to expand the folder node.

4. Turn the LOOP MOVE encoder to select the Dirty Trap folder from the Browser Tree.
5. Turn the BROWSE encoder to highlight the Sample “C3 Bells #1” in the Playlist.

6. On the left Deck, press one of the flashing Sample Play buttons (let’s say the first one) to load the Sample into that particular Sample Slot.

7. Push the BROWSE button again to leave Browse mode.

You can do this in the software too: simply drag and drop the Sample from the list onto a Sample Cell of a Sample Slot.

The Sample is now loaded and ready to play:

- In TRAKTOR, the Remix Deck C now holds the Sample in the upper Sample Cell of the first Sample Slot.
- On your S4, the corresponding Sample Play button is now dimmed, indicating that the Sample Slot holds a Sample which is not audible (yet).

### 4.5.2 Triggering the Sample

Triggering the Sample is as simple as pressing the dimmed Sample Play button:

1. Press the dimmed Sample Play button to trigger the Sample.
2. Press the button again to mute the relevant Sample Slot. Press once more to unmute it.
3. Press SHIFT + the Sample Play button to stop the Sample and skip back to start the next time it is activated.

The Sample is looped. This is because the Sample is in **Loop mode**, which is indicated by the loop symbol on the left side of the Sample Cell:
The Sample "C3 Bells #1" in Loop mode.

To change the Play Type of the Sample to **One-shot mode**, the Advanced Panel of the Remix Deck needs to be opened. Double-click repeatedly on the upper border of the Deck to cycle through the Deck Layouts until the Advanced Panel becomes visible.

The Remix Deck C with the Advanced Panel on bottom. On the lower right you can see the cursor pointing on the Play Type button, which switches the Sample Cell from One-shot to Loop mode and vice versa.

► Click on the Play Type button in the lower right of the Advanced Panel (see screenshot above) to switch the Sample to **One-shot mode** if you wish.

In One-shot mode, pressing the relevant Sample Play button when a Sample is playing results in the Sample Slot being stopped.

Pressing SHIFT + Sample Play button once more after stopping Sample playback will clear the Sample Slot from the Sample.
In case you don’t hear the playing (unmuted) Sample, check that channel C’s fader is raised in the TRAKTOR software.

4.5.3 Capturing a Sample From a Track Deck

We have seen how you can load Samples directly into one of the Remix Decks using TRAKTOR’s Browser, but here’s an even cooler performance feature:

1. Check that the track “Techno 2” is still playing on the right Deck (Deck B in TRAKTOR). If not, start its playback by pressing PLAY. If the playback has reached the end of the track, press SHIFT + CUE to skip back to start.

2. Set a Loop on this track using the controls in the Loop section.

3. On the same Deck, press an unlit Sample Play button — let’s say the Sample Play button 1.

→ This automatically captures the current Loop playing on Track Deck B, and copies it into the upper Sample Cell of the first Sample Slot on Remix Deck D:
We just exported the active Loop from Deck B to the upper Sample Cell of Deck D's first Sample Slot.

The loop is now ready to play in Remix Deck D. Furthermore, provided that Snap mode and SYNC are active, the loop is in perfect sync with the Track Deck B above.

The Sample Play buttons offer you the same playback controls as described earlier (press to unmute/mute the Sample, SHIFT+ press to stop it and skip to start next time it's activated, SHIFT + press again to unload).

As previously described, you can switch the Sample Play Type between Loop and One-shot mode (see ↑4.5.2, Triggering the Sample).

Now you can load a different track onto Deck B, but you will still have the Sample loop from the original song stored on the Remix Deck D to be retrigged at any time. It's great for capturing loops on the fly and using them to build an alternate mix.
If the Deck that you captured from wasn’t playing a Loop when you pressed the Sample
Play button, it will still capture audio from the source Deck, but will instead take it from
the current playback position. The loop will automatically be cut to the length of the cur-
rent Loop size (as displayed in TRAKTOR).

► Capture a few Samples from various places in the track on Deck B and play around to get
used to the basic playback controls that we described above (triggering, muting etc.).

4.5.4 Unloading a Sample

If at any time you’d like to clear the contents in one of the Sample Cells, hold the SHIFT but-
ton and press the corresponding Sample Play button to stop the Sample, then repeat the same
action to clear the Sample Cell. The Sample Play button turns back off.

4.5.5 Getting More Controls Over the Samples

Once you have a Sample loaded in one of the Remix Decks, you have many more controls over
the Sample at your disposal. To access them, we need to switch the focus of the right Deck on
your S4 to the lower Remix Deck D in TRAKTOR:

► Press the DECK D button to switch the right Deck focus to Deck D.

→ The button lights up. All other elements on the right Deck now control the Sample Slots
on Deck D in TRAKTOR.

We won’t describe all of the functions here (refer to ↑5.3, The Decks and the TRAKTOR 2
Manual also), but at least show you some of the available functions:

▪ The jog wheel allows tempo bending (outer rim) and scratching (top plate) of the Remix
Deck including all Sample Slots.

▪ The Hotcue button under each Sample Play button will also function as a Play and Cap-
ture button. As a shortcut, if the Sample is already playing, the Hotcue button will retrigger the Sample.

▪ For any playing Sample, the Hotcue button’s brightness follows the Sample’s rhythm.
• It is also possible, to skip through a Sample Slot's Sample Cells by pressing SHIFT + a Hotcue button; however, this is dependent on whether the Hotcue buttons are set to Rem-ix or Legacy mode in TRAKTOR's preferences. See 6.3, S4 Control Options for further information.

For a more in-depth description of the Remix Deck and its capabilities, please refer to the TRAKTOR 2 Manual.

4.6 Adding FX

Now that we have seen the basics of playing tracks and Samples on the Decks and mixing them together, let’s see how to add effects—or “FX” in the TRAKTOR terminology.

TRAKTOR has an extremely powerful effect section. By default, there are two different FX Units in TRAKTOR, which can be assigned to any of the Decks. These FX Units are directly mirrored on your S4 above each Deck:

An FX Unit in TRAKTOR

An FX Unit on the S4
Prerequisites
As always, we assume here that you already followed the instructions in the previous tutorials. TRAKTOR KONTROL S4 now is in the following state:

- The track “Techno 2” is loaded on Deck B. The track is playing and audible.
- The Deck A is stopped (if it’s not the case, press the PLAY button on the left Deck).
- The crossfader is all the way to the right.

4.6.1 Group Mode
First we’ll look at Group mode. This mode allows up to three different FX to be used simultaneously in a single FX Unit.

We’ll focus here on the left FX Unit (labeled FX1) of your S4—but the same applies to the right FX Unit as well.

The MODE button

Press the MODE button to put the unit into Group mode (the button must be lit).
In TRAKTOR, you see three different FX slots stacked on top of each other in the corresponding FX Unit (see picture above).

4.6.2 Getting the FX Unit Ready
Let’s load the three default effects and activate the FX Unit:

1. Hold the SHIFT button and press the FX On button (at the far left of the FX Unit) to load the three default effects:

You now have the Delay, the Reverb, and the Filter loaded.
2. Choose which of the three loaded effects you want to activate by pressing the corresponding FX Buttons 1-3. Of course, you can use all three effects together—simply activate all three buttons:

![FX Buttons](image1)

The FX Buttons light up to indicate the activated effects.

3. As additional step, turn the DRY/WET knob fully counter-clockwise—we will use this knob later to progressively bring in the effects:

![DRY/WET Knob](image2)

→ Your FX Unit is now ready to process whatever you will send to it!

### 4.6.3 Assigning Decks to the FX Unit and Bringing In the FX

Now we need to assign this FX Unit to a Deck. To do this, we use the FX Assign buttons at the top of each channel on the Mixer, below the GAIN encoder:

![FX Assign Buttons](image3)

The FX Assign buttons on each channel

Let’s assign the FX Unit 1 to Deck B:

1. Press the left FX Assign button (labeled “1”) on channel B to assign Deck B to the FX Unit 1.
2. Slowly turn the DRY/WET knob clockwise to bring in the FX.

→ You now hear the track on Deck B being processed by the FX Unit 1.

You can assign other channels to the same FX Unit. For example, if you also want to apply these FX to the Samples loaded on Deck C or D, simply press the FX Assign button “1” on the corresponding channel(s).
4.6.4 Controlling the FX Unit

You can control each FX in this FX Unit by turning the respective FX Knob 1-3:

Play around with the FX Knobs 1-3 and listen to the result on the audio. You can also activate/deactivate each FX individually by pressing the corresponding FX Buttons 1-3 below.

Changing the FX in a Slot

You can load another FX in each slot. Let’s switch the first FX slot to the Gater:

1. Hold SHIFT and press the FX Button 1 repeatedly to scroll through all available FX until the Gater is selected in the first slot of the FX Unit 1 in TRAKTOR.
2. If the first FX slot is currently deactivated, press the FX Button 1 to activate it (the button must be lit).

You hear the Gater cutting the audio at regular intervals.

You might want to deactivate the FX Buttons 2 and 3 in order to better hear how the Gater affects the audio.

Tempo-synchronized FX

Now try the following:

Set the FX Knob 1 to various positions and listen to the resulting effect on the audio.

You’ll notice that the gating effect stays synchronized to the beat! Among other things, this can be very useful to temporarily emphasize the rhythm, e.g. by transitions between tracks.
You can check this by moving the TEMPO fader on the right Deck: by pulling the fader downwards, you hear the track playing faster... and the Gater following.

4.6.5 Single Mode

You can also switch each FX Unit to Single mode. Instead of multiple FX with one parameter each, Single mode will give you one FX but with much more control over its parameters.

This time, we will do it on the right FX Unit (labeled FX2) of your S4:

1. Check that the FX Mode button (MODE) is off. If it’s on, press it to switch that FX Unit to Single mode.
2. Press SHIFT + FX On button for the FX Unit to load an FX. You can hold SHIFT depressed and continue to press the FX On button to cycle through all the available FX until you see in the software one FX you’d like to try.
3. Press the same FX On button (this time without SHIFT) to turn on the FX Unit globally. The FX On button lights up.
4. On channel B, press the right FX Assign button (labeled “2”) to assign Deck B to this FX Unit as well. You can deactivate the left FX Assign button on that channel if you want to hear the new FX more distinctly.

The FX Knobs 1-3 and the FX Buttons 2 and 3 will give you access to each of the advanced parameters for that FX. At any time, you can press the FX Button 1 to reset the parameters to their default value.

As for Group mode, the DRY/WET knob allows you to adjust the balance between the unprocessed (dry) signal and the processed (wet) signal.

4.6.6 Storing a Snapshot

If you find yourself making the same settings to the FX each time and would like to set a default state for the FX parameters, simply do the following:

1. Adjust the FX Knobs and Buttons to your liking.
2. Press SHIFT + MODE to store these settings as snapshot.

→ The next time you press the FX Button 1 with this FX loaded, its parameters will assume the values you stored.
It’s now time to check another new feature introduced in TRAKTOR KONTROL S4: the Loop Recorder.

### 4.7 Using the Loop Recorder

Earlier we saw how you can use Remix Decks as a means for triggering one-shot and looped Samples. But this is how to work with existing material; the Loop Recorder, on the other hand, allows you to record new material on the fly.

![The Loop Recorder on your S4](image)

You could, for example, capture the signal from the microphone input on the S4, record your scratching in real time, or just record a few bars of a particular track while tweaking the FX settings.

**Prerequisites**

One more time, we assume here that you already followed the instructions in the previous tutorials. TRAKTOR KONTROL S4 now is in the following state:

- The track “Techno 2” is still loaded on Deck B. The track is playing and audible (remember: if the track is over, press SHIFT + CUE on the right Deck to skip back to the beginning).
- The Deck A is stopped (if it’s not the case, press the PLAY button on the left Deck).
- The crossfader is all the way to the right.
- FX Unit 2 is in Single mode and loaded with your favorite FX.
- None of the FX Units are assigned to channel B (both FX Assign button on channel B must be off).

### 4.7.1 Choosing a Source

The Loop Recorder can capture the input from several sources. In TRAKTOR, you can choose the desired source by clicking on the Source menu—the drop-down menu directly under the Loop Recorder’s DRY/WET knob:

![The Loop Recorder’s Source menu in TRAKTOR](image)

In this menu, you have following choices:

- **Main** will record TRAKTOR’s overall signal.
- **Cue** will record any channels whose Headphones Cue button is on.
- **Ext** will record from the Input FX Send.
- **Aux** will pick up the signal assigned to TRAKTOR’s Aux channel—typically the S4’s microphone input (for more info on how to use a microphone with your S4, please see ↑9.2, Adding a Microphone).

For our example, we’ll capture the main output:

► Select **Main** in the Source menu.

Selecting the source is the only action that must be done in the software. Everything else will be done from your S4 controller.
4.7.2 Recording a Loop

Let’s now record a loop.

Adjusting the Loop Size

Before we start recording, we need to specify the size of the loop we are going to record:

► Press the SIZE button on the S4 repeatedly to cycle through loop record sizes (in bars).

You can see the current loop size in the software at the top of the Loop Recorder. For our example, we’ll choose a loop of 4 bars:

![The selected loop size is displayed in the software.]

Starting the Recording

Now do the following:

1. Cut the low and mid frequencies on channel B by turning the LOW and MID knobs fully counter-clockwise.
2. Turn the DRY/WET knob of the Loop Recorder fully clockwise.
3. When you’re ready, press the REC button.

→ The Loop Recorder will punch in (REC button lit), automatically punch out according to the selected loop size (REC button back off), and then begin playing (PLAY button lit). That’s all there is to it!

You can hear that our adjustments to the EQ are now part of the recording.

You’ll notice that the loop automatically started playing when it finished recording. If you don’t want this to happen, just push the PLAY button during recording. Now the loop will only trigger when you explicitly tell it to.

Playing with the Recorded Loop

You can control the balance between the looped recording and the main output using the Loop Recorder’s DRY/WET knob:
The Loop Recorder’s DRY/WET knob

You can stop and start again the recorded loop by using the PLAY button. By doing this, you’ll notice the following:

- The Loop Recorder always stays in sync with the Deck B, which is our current tempo reference—we say “tempo master” (for more info on tempo references, check the tutorial in section 4.8, Synchronization).

- You don’t have to bother with the DRY/WET knob position when stopping the Loop Recorder: when you stop the Loop Recorder, the DRY/WET knob is automatically bypassed, whatever its current position is. This ensures a seamless transition with the main signal at its original level.

Deleting the Loop and Trying Again

If you don’t like what you hear and want to try again:

► Press the UNDO button when the Loop Recorder is stopped.

→ Now the recording has been cleared and you can try again.

For example, you could try again to record a loop from the track on Deck B, this time while tweaking the FX loaded on the FX Unit 2:

1. Turn channel B’s EQ knobs back to neutral position.
2. Activate the FX Assign button “2” on channel B.
3. Press the REC button on the Loop Recorder and tweak the FX Knobs and buttons of the FX Unit 2 as you see fit.

Since the Loop Recorder records the audio (including any processing by the FX), you can create this way brand new loops from your existing tracks!
4.7.3 Overdubbing

You can also dub over the current recorded loop, building additional recorder layers on the fly. To do this:

1. Press the REC button while the Loop Recorder is already playing an existing loop, and press REC again to exit overdubbing.
   The new audio will then be added to the existing loop.
2. If you don't like the overdub, just hit UNDO and it will clear your last overdub and you can try it again.
3. If you hit UNDO once more, it will act as a “redo” and bring back the overdub.
4. If you want to completely clear all the contents of the Loop Recorder, just press UNDO while the Loop Recorder is stopped.

4.7.4 Further Uses of the Recorded Loop

One of the great things about the Loop Recorder is that you can use it to record loops that you can then transfer to the Remix Decks. To do this, we will use the Copy mode on the S4:

1. Hold down the BROWSE button to enter Copy mode.
   You will see the PLAY button on the Loop Recorder start flashing, letting you know that it contains a loop ready to be copied.
2. While holding the BROWSE button, press the PLAY or REC button on the Loop Recorder to select it as source.
3. Still holding the BROWSE button, press any flashing Sample Play button in the Remix Decks to select it as target.

→ Now the loop has been stored in a Sample Slot, and you can record a new loop into the Loop Recorder if you like. Moreover, your loop now has access to all Sample-related features provided by the Remix Deck. Last but not least, as already mentioned, the loop is automatically added to your Collection!
4.8 Synchronization

It is now time to give a closer look at the advanced synchronization features offered by TRAKTOR. Once you will get more familiar with them, you will be able to use these powerful tools to build rich and complex mixes.

4.8.1 Introduction

In the previous tutorials, we have already seen TRAKTOR’s synchronization facilities many times in action:

- We synchronized a track to the previous one before we mixed it in (see ↑4.2, Mixing In a Second Track).
- We played with Loops and jumped to Cue Points without losing the beat (see ↑4.4, Looping and Cueing).
- We captured a Sample from a track and it played in sync with the track (see ↑4.5, Using Samples in Your Mix).
- We noticed that the Gater FX was synchronized to the track it was processing (see ↑4.6, Adding FX).
- We recorded a loop in the Loop Recorder and it played in sync with the track (see ↑4.7, Using the Loop Recorder).

The Tempo Master

For all this to work, TRAKTOR needs both a tempo and beat reference it can synchronize things with. We call this the tempo master. The tempo master doesn’t have to be the same throughout your mix, but there is always one tempo master—and only one.

For example, by activating SYNC on a Track Deck, you say to TRAKTOR: “Synchronize the track on this Deck with the current tempo master.” Samples playing in Looped mode on a Remix Deck, as well as loops recorded in the Loop Recorder, always play in sync with the current tempo master.

In TRAKTOR, the Clock or any Track Deck can be the tempo master:

- TRAKTOR’s Clock can provide a tempo and a tick.
A Track Deck can provide the tempo and the beats from the track that is currently playing.

The Beatgrid

So that a Track Deck can provide reliable tempo and beats, these must be precisely determined in the loaded track—if not, the “reference” wouldn’t make any sense. Therefore, tracks must first be analyzed beforehand by TRAKTOR in order to determine the BPM as well as the position of the beats. The result of this analysis is the so-called Beatgrid. There is a specific Beatgrid for each of your tracks:

![A track's waveform with Grid Marker (1) and the Beatgrid (indicated by the white vertical segments, 2).](image)

The track’s Beatgrid is not only important when a Track Deck is set as tempo master, but also when you want this Track Deck to be synchronized with the current tempo master, whichever it may be.

The included demo tracks used in the tutorials were previously analyzed, therefore they already have a reliable Beatgrid. Before you can effectively use the synchronization facilities on your own tracks, you will have to analyze them. By default, this is done automatically when you import your music into the Track Collection. For more info on how to do this, see chapter 3, Importing Your Music. For all the details on the Beatgrid, the Analysis and the Track Collection, please refer to the separate TRAKTOR 2 Manual.

What Is Synched and What Is Not?

Basically, time-evolving FX are always automatically synched to the current tempo master.

On the other hand, for each Track Deck you can decide whether to use the automatic Sync or not — for example if you want to beat match the track manually (see tutorial in 4.2, Mixing In a Second Track), or if you don’t want any beat matching at all for that track.
4.8.2 Who’s the Master?

You can build your mix using various Deck setups: you can mix with two Track Decks only, or make use of the lower Remix Decks (default setup), or even replace the Remix Decks with another two Track Decks.

Depending on your preferred way of DJing and Deck setup, you will have different needs and perspectives for choosing your tempo master. We will describe here the various use cases.

Letting TRAKTOR Decide for You: the Auto Mode

Let’s first give a look at TRAKTOR’s Clock:

► In TRAKTOR, click on the metronome icon at the top left of the window to show the Clock panel:

![The Clock panel in TRAKTOR](image)

In this Clock panel, you see the activated **AUTO** button, meaning that we are in Auto mode.

The Auto mode is activated by default, and this the mode we used in all the previous tutorials.

With **AUTO** activated, TRAKTOR automatically switches the tempo master between Track Decks when needed—that is to say, when the Track Deck set as tempo master is stopped or when you load a new track onto it. This way, you don’t have to worry about setting the tempo master yourself.

Should there be no other Track Deck playing, the Clock would become the tempo master, thus keeping in sync any FX still on air!

You can check this by doing the following:
1. Stop any playing Deck.
   On the Master Display of your S4, the MASTER button and indicator light up, indicating that the Clock currently is the tempo master:

![Master Display](image)

2. Load two tracks on Deck A and B.

3. Start the playback on Deck A.
   Deck A now is the tempo master: the MASTER indicator in the Master Display turns back off, whereas the MASTER indicator on the left Deck Display lights up:

![Deck Display](image)

4. Start the playback on Deck B and beat match the track on Deck B with that on Deck A (whether manually or via automatic Sync).

5. Stop Deck A.
   → Deck B now is the tempo master: the MASTER indicator on the left Deck Display turns off, whereas that of the right Deck lights up:

![Deck Display](image)

If you play sets with two Decks only, or if you prefer to do your beat matching manually, the Auto mode might be for you: it guarantees that each new track in the mix sets the tempo reference, and all FX will synchronize to it correctly — without being constrained to a single tempo.

If you’d like to do a combination of manual and synched beat matching, again leave the AUTO button engaged, and enable the SYNC button for individual Decks on your S4 as needed:

- If SYNC is enabled, the new Deck inherits the tempo from the previous tempo master.
- If SYNC is disabled, the new track sets the current tempo master.

Note that you can also manually set a particular Deck as tempo master:
To manually set a Track Deck as tempo master, press SHIFT + SYNC on that Deck.

**Using the Clock as Tempo Master**

If you run beat-mixed sets with more than 2 Decks, you should use the Clock as tempo master. The clock will always give you a solid tempo reference that will not change. Also, if you intend to only do beat-synced transitions, and would like to stay within the same general BPM range throughout your set, this is the ideal mode to use. To set it up, do as follows:

1. In TRAKTOR’s Clock panel, deactivate the AUTO button.
2. Set the Clock as tempo master, whether by activating the MASTER button in the Clock panel, or by pressing the MASTER button on the Master Display of your S4 (in the middle of the Mixer).

The Clock panel should now looks like this:

![Clock Panel](image)

The Master Display on your S4 should now look like this:

![Master Display](image)

3. On your S4, activate SYNC on all Decks by pressing the respective SYNC buttons. This way, all Decks will instantly follow the Clock’s tempo. You can then set the Clock’s tempo to the tempo you intend to play your set via the numeric field to the right of the MASTER button (see picture above):

   ✷ Change the Clock’s tempo by clicking the displayed BPM value and dragging your mouse vertically while holding the mouse button depressed.

   → You can see the tempos on every Deck changing accordingly.

As in Auto mode, you can change the tempo master at any time from your S4 by pressing SHIFT + SYNC on the desired Deck or by pressing MASTER again in the Master Display.
4.8.3 Other Useful Tools for Synching

Lastly, we would like to quickly mention here three other interesting features related to synchronization: the Snap and Quantize modes, and the Keylock function.

Snap and Quantize Modes

As you probably remember, we already mentioned the Snap and Quantize modes in the tutorial in section 4.2, Mixing In a Second Track. They are other important tools that can help with synchronizing your tracks:

▪ The Snap mode ensures that any Loop or Cue Point you set in a track will snap to the closest beat.

▪ The Quantize mode ensures that any jump you make within the track will retain the phase sync—may you jump to a Loop, a Cue Point or a beat.

Both Snap and Quantize modes can be enabled/disabled directly from your S4 by pressing the corresponding buttons in the Master Display, on either side of the MASTER button:

![SNAP MASTER QUANT](image)

The SNAP and QUANT buttons allow you to activate/deactivate Snap and Quantize mode, respectively.

Depending on what you are about to do, you can decide to enable or disable them at any time. Here are a few examples:

▪ If you want to set a Loop starting directly on a beat, activate SNAP and press the LOOP SIZE encoder around the desired beat.

▪ On the contrary, should you wish to set a Cue Point at the beginning of some backing vocals that don’t necessarily start on the beat, deactivate SNAP before pressing an unlit Hotcue button.

▪ If you’re about to mix in a synched track and want the downbeats of both tracks to perfectly match, activate the QUANT button before you press PLAY (or some Hotcue button).
▪ On the other hand, if you want to jam around with a Sample loaded on a Remix Deck and make some stutter-like effects by pressing the corresponding Hotcue button repeatedly, you might prefer to deactivate QUANT to create repetitions shorter than a beat.

▪ Etc.

**Locking the Key of Your Tracks**

When synchronizing tracks, you alter their tempo, and consequently their pitch (or key). For small tempo adjustments, this is not really serious; but when the tempo is changed more frankly, the resulting pitch might get problematic: kick sounds would lose their power, vocals would sound silly, etc.

To avoid this, TRAKTOR KONTROL S4 provides you with a Keylock feature that uncouples the tone and the tempo of a track:

1. Load two tracks with quite different tempos on Deck A and B.
2. Start the playback on both Decks and synchronize Deck B to Deck A.
   You can clearly hear how the tone of the track on Deck B changed.
3. Now press SHIFT + PLAY on the right Deck of your S4. This activates the Keylock on that Deck.

→ The tone of the track gets back to its original value, thus preserving most of its acoustic feeling. In the Deck Display, the KEYLOCK indicator lights up to remind you that the Keylock is active on that Deck:

![Keypad Image]

---

**4.8.4 In Conclusion**

There is no “correct” sync setting: it all depends on your DJ style and the kind of music your sets will consist of. Regardless of which setting you choose, you can see all necessary info on your S4 and pilot your DJ set accordingly.
5  Hardware Reference

This chapter details all you can do with your TRAKTOR KONTROL S4 controller.

After a quick introduction to the main areas on your S4 and to their underlying concepts, we will give a thorough description of each and every control element on your S4.

In this chapter, we describe actions on the TRAKTOR KONTROL S4. Of course, every action on your S4 is instantly mirrored in TRAKTOR! For an in-depth explanation of all features provided by the TRAKTOR software, please refer to the TRAKTOR 2 Manual.

Quick References

You will find in ↑6.5, The Setup Wizard a series of Quick Reference tables summing up the basic functionality of each control element on your S4.

5.1  Areas and Concepts

This first section will give you an overview of TRAKTOR KONTROL S4’s main areas, both on your TRAKTOR KONTROL S4 hardware controller and in the TRAKTOR software. On the way, we will describe some important concepts that together build the TRAKTOR KONTROL S4 system.

You will continuously encounter these concepts in your work with TRAKTOR KONTROL S4. Previous chapter ↑4, Tutorials proposes a practical approach of how these concepts are implemented.

5.1.1  Decks

TRAKTOR KONTROL S4 provides you with four virtual Decks. The Decks are the place where tracks, Samples and live input are played back. The Decks can be seen as the virtual equivalent to the good old vinyl or CD decks—just with a bunch of powerful additional features and the flexibility of a computer-based system.
A Deck on your TRAKTOR KONTROL S4 hardware controller
The equivalent control elements on a Track Deck in TRAKTOR

The two Decks on your TRAKTOR KONTROL S4 allow you to control the four software Decks (labeled A, B, C and D) available in TRAKTOR:

- The left Deck on your S4 can control the upper Deck A and lower Deck C in the software.
- The right Deck on your S4 can control the upper Deck B and lower Deck D in the software.

On your TRAKTOR KONTROL S4 controller, each Deck provides you with a multi-function jog wheel with advanced transport functionality via its top plate (1) and outer rim (2), a TEMPO fader (3) to adjust the playback’s speed, a Deck Display (4) giving you various information about the Deck’s state, a Loop section (5), Sample Play buttons (6) and Hotcue buttons (7) with different functionality according to the Deck type (Track Deck or Remix Deck, see below), the traditional PLAY and CUE buttons (8), along with a few other useful control elements. Of course, you will find equivalent features in the TRAKTOR software.
Both left and right Decks also provide a **SHIFT button** (9): when held depressed, this button modifies the function of many other control elements (see section ↑5.3.2, SHIFT Buttons: Accessing Secondary Functions for more info).

Many control elements on the Decks can have their function customized in order to fit your specific needs and habits! For more info on this, please refer to chapter ↑6, Customizing TRAKTOR KONTROL S4.

### Three Types of Audio Material – Three Deck Flavors

Your Decks can handle three different types of audio material, each of them leading to a specific Deck Flavor:

- **Tracks**: A track is a song stored in digital format stored on your hard disk. For instance, the traditional way-of-DJing consists in playing back a particular sequence of tracks—a so-called **Playlist**. Decks handling tracks are called **Track Decks**.

- **Samples**: A Sample is a small piece of audio material. If its physical content does not really differ from a track’s content (it’s all about audio stored in digital format on your hard disk), the difference between them is both in their size and purpose: in general, a Sample is much shorter than a track, and it is aimed to be added to (or blended into) your main mix. Notably, Samples are perfect material for live remixing! Decks handling Samples are called **Remix Decks**. Each Remix Deck provides you with four **Sample Slots** containing 16 Sample Cells each.

- **Audio input**: Whereas the two aforementioned audio material types are played back from your hard disk, Decks C and D can also be switched to **Live Inputs**, in which case they transfer audio signals coming from the outside world to TRAKTOR’s audio processing and mixing facilities. Whether it’s a microphone, a turntable, a keyboard or anything else, it gets directly inserted in TRAKTOR’s signal flow.

### Deck Configurations

In TRAKTOR KONTROL S4, the upper Decks A and B are always Track Decks. The lower Decks C and D are Remix Decks by default, but you can switch them to Track Decks or Live Inputs—or even deactivate them.

You will find a detailed description of every control element in the Decks in ↑5.3, The Decks.
5.1.2 Mixer

The Mixer is sitting in the middle of your TRAKTOR KONTROL S4 controller and of TRAKTOR’s window.

The Mixer receives on its four channels (1) the audio signals coming from the four Decks described above. There is one channel for each Deck. Hence, channels are labeled from A to D according to their corresponding Deck.
As any DJ mixer, the Mixer’s purpose basically is to adjust the relative level of each channel, to control the channels’ frequency content, possibly feeding them into the FX Units (see section ↑5.1.3, FX Units below) before sending the overall result to the Main section (2)—and in the end, to generate the mix that is sent to your audience. Of course, the Mixer also provides you with a crossfader (3), which allows you to make seamless transitions between various channels.

The Mixer of your TRAKTOR KONTROL S4 hardware controller has a few additional features not to be found on usual DJ mixers, though. For example, it includes a BROWSE encoder (4) for quickly browsing your Playlist content, along with a set of indicators and switches in the Master Display (5) that give you quick access to vital information and options, and last but not least, the Loop Recorder (6), presented in more details below.

You will find a detailed description of every control element on the Mixer in section ↑5.4, The Mixer.

Mixer-related controls dealing with the physical inputs and outputs of your TRAKTOR KONTROL S4 are also to be found on the front and rear panels of your S4 (see section ↑5.1.5, Front and Rear Panels below).

### 5.1.3 FX Units

Adding effects to playing audio can tremendously expand the sonic possibilities of your mix. For that purpose, TRAKTOR provides you with a great selection of high-quality FX. These FX can be loaded into the so-called FX Units.
By default, two FX Units are active. Both FX Unit 1 and FX Unit 2 can be freely assigned to any of the channels A-D.

On the hardware side, the TRAKTOR KONTROL S4 also provides you with two FX Units (labeled FX1 and FX2 on your controller), which allow you to control the corresponding FX Units in the software.

You will find a detailed description of every control element in the FX Units in section 5.5, The FX Units.

You can activate two additional FX Units in the Preferences of TRAKTOR. Using four FX Units instead of two implies a few changes in the FX routing scheme. Please refer to section 6.4.3, Using Four FX Units for more info.

5.1.4 Loop Recorder

The Loop Recorder is another powerful tool for live remixing your tracks.

The Loop Recorder on your S4

The Loop Recorder in TRAKTOR
The Loop Recorder allows you to instantly create loops whether coming from the Mixer’s master signal, from a particular Deck or from a physical audio input. As soon as the loop is recorded, it is automatically triggered. You can then blend between the loop playing in the Loop Recorder and your main mix. Moreover, you can save the recorded loop to your hard disk or better, transfer it directly to any relevant location in TRAKTOR KONTROL S4 — typically a Sample Slot on a Remix Deck!

You will find a detailed description of every control element in the Loop Recorder in section ↑5.6, The Loop Recorder.

5.1.5 Front and Rear Panels

The front and rear panel of your TRAKTOR KONTROL S4 contain controls and connectors related to the physical inputs and outputs of your controller. They are extensively described in section ↑5.8, The Rear Panel and ↑5.9, The Front Panel.

5.2 Types of Control Elements

Your TRAKTOR KONTROL S4 holds various types of control elements, which we will quickly describe here.

5.2.1 Buttons

A button on your S4

Buttons are spread everywhere over your TRAKTOR KONTROL S4. They can have three Flavors:

- Some buttons trigger a function when they’re pressed ("trigger" action), e.g. the Hotcue buttons: hit one of the Hotcue buttons, this triggers the playback to continue from there.
Some buttons switch to another state until they are pressed again ("toggle" action), e.g. the PLAY button: hit it once and it starts the playback, press it a second time and the playback stops.

A few buttons activate a certain state for the time they are held depressed ("gate" or "hold" action). Notably, this is the case of the SHIFT buttons (see below).

All buttons of your TRAKTOR KONTROL S4 are equipped with LEDs that give you various info. Basically, the LED indicates the button’s current state, but its exact meaning varies for each button—for more info, please refer to the description of each button later in this reference chapter.

**The SHIFT Buttons**

Instead of triggering any function themselves, the **SHIFT buttons** (one on each Deck) modify the behavior of other control elements on your TRAKTOR KONTROL S4, giving you access to some secondary functions.

For more info on the SHIFT buttons, please refer to section ↑5.3.2, SHIFT Buttons: Accessing Secondary Functions.

### 5.2.2 Knobs

Knobs are rotary potentiometers with limited range—this is indicated by the limited white ring around them. By turning them, you can dial an absolute value for the parameter. The small white line on their top indicates the current value of the parameter within the defined range. Depending on their purpose, most of them have a center detent at the middle (default) position, which is shown by the little notch on their ring.
5.2.3 Encoders

An encoder on your S4

Encoders are endless rotary potentiometers—this is indicated by the full white ring around them. By turning them, you can dial a value for the parameter relatively to its current value in the software. All encoders have a step-by-step movement.

Additionally, encoders have a “push” action available: pushing the encoder can trigger some other function.

5.2.4 Jog Wheels

A jog wheel on your S4

Functionally speaking, the two jog wheels are quite similar to the encoders described above: they have an endless rotary movement (here continuous) and an additional push action available on their top plate. The main difference (beside their size) is that, on the jog wheel, the
push movement is very tiny and is rather used for detecting whether you put your hand on the top plate or on the outer rim when spinning the jog wheel. Hence, this leads to two different rotation controls:

- You can spin the jog wheel’s outer rim.
- You can spin the jog wheel by (pressing and) turning its top plate.

This makes the jog wheel a versatile element that gives you a very precise control, e.g. for scratching, seeking in a track, or browsing in lists.

5.2.5 Faders

**Faders** are linear control elements with limited range. All of them set absolute values, with the possible exception of the TEMPO faders (see ↑5.3.7, Tempo Fader and Tempo Offset Buttons).

5.2.6 Displays, Meters and Indicators
Displays, indicators and meters are single- or multi-LED elements that provide you with real-time feedback about various states and levels in the TRAKTOR KONTROL S4 system.

5.2.7 Switches

Switches are only available on the rear panel. They control a few basic options needed when setting your TRAKTOR KONTROL S4 up.
5.2.8 Sockets

Sockets are to be found on the rear and front panels only. They allow you to plug various types of cables (USB, audio, MIDI, etc.) into your TRAKTOR KONTROL S4.

5.3 The Decks

This section describes the handling of the Decks on your TRAKTOR KONTROL S4. After an overview of the general structure and the Deck Flavors in TRAKTOR, we will describe the individual areas and elements of the Decks on your S4.

5.3.1 Deck Flavors and Structure

As described in section 5.1.1, Decks, TRAKTOR's software Decks can have three different Flavors, depending on the type of audio material you want them to handle: Track Deck, Remix Deck or Live Input.

- By default, Decks A and B are Track Decks when TRAKTOR is configured for use with TRAKTOR KONTROL S4.
- Decks C and D are Remix Decks then.

2 Track Decks + 2 Remix Decks is the intended layout when TRAKTOR is configured for use with the S4. See also 6.5, The Setup Wizard for further information on configuring TRAKTOR using the Setup Wizard; however, you are not restricted to use this configuration, both Decks on the S4 can control Track Decks and Remix Decks in TRAKTOR.
Selecting Deck Flavors

For TRAKTOR KONTROL S4, it is recommended to use the Track Deck Flavor for Decks A and B, and the Remix Deck Flavor for Decks C and D; however, you can control any Deck Flavor with the S4's Decks. To change the Flavor of a Deck:

► Select the Flavor in the TRAKTOR Preferences via the settings in Preferences > Decks > Deck Flavor.

► Or click on the Deck letter in a Deck's upper right corner and select a Flavor from the drop-down menu:

The Decks on your TRAKTOR KONTROL S4

The two Decks on your TRAKTOR KONTROL S4 allow you to control all four Decks in TRAKTOR:

- The left Deck on your S4 can control both Decks on the left of the TRAKTOR window: the upper Deck A and the lower Deck C.

- The right Deck on your S4 can control both Decks on the right of the TRAKTOR window: the upper Deck B and the lower Deck D.

At any time, each S4 Deck controls a particular Deck in the software: we say that the focus of the S4 Deck is on that particular software Deck. You can switch the focus of an S4 Deck between two software Decks (e.g., between A and C). This is done via the Deck Assign buttons, see section 5.3.3, Deck Assign Buttons: Switching Deck Focus below.

Depending on the Flavor of your Decks in TRAKTOR (Track Decks, Remix Decks or Live Input), the Deck's control elements have slightly differing functions on your S4. These differences will be pointed out at the relevant places in the subsequent chapters.
Using a Deck as Live Input

When a Deck is switched to Live Input, the Deck simply forwards audio signals coming from your S4’s physical audio inputs to its corresponding channel on the Mixer. As a consequence, all control elements for this Deck are deactivated. On your S4, you cannot put the focus on a software Deck working as Live Input. For an in-depth description of the Live Input, please refer to the separate TRAKTOR 2 Manual.

5.3.2 SHIFT Buttons: Accessing Secondary Functions

The SHIFT buttons have an overall purpose, regardless of the Deck Flavor (Remix Deck or Track Deck).

The SHIFT buttons (one on each S4 Deck) act as “modifiers” for other control elements on your TRAKTOR KONTROL S4, they allow you to access a secondary function when using other control elements simultaneously—much like the [Shift] key on your computer keyboard.

► To access the secondary function of any control element, hold SHIFT depressed when using that control element.

▪ For the Deck and FX Unit control elements, SHIFT operates locally, which means that you cannot use the SHIFT button on the opposite side of your S4 to access the secondary functions of a Deck or FX Unit.

▪ For the Mixer, the SHIFT button on either side can be used to access the secondary functions.

On Track Decks, the SHIFT button additionally allows you to define the Deck tempo. See section 5.3.13, SHIFT Button for further information.

5.3.3 Deck Assign Buttons: Switching Deck Focus

The Deck Assign buttons have an overall purpose, regardless of the Deck Flavor (Remix Deck, Track Deck or Live Input).
Both Deck Assign buttons (one on each Deck)

The Deck Assign button (labeled DECK C on the left Deck and DECK D on the right Deck) allows you to switch the focus of your S4 Deck between the two Decks it can control in the TRAKTOR software.

► On the left Deck, press DECK C to switch the focus between Deck A and Deck C.
► On the right Deck, press DECK D to switch the focus between Deck B and Deck D.

→ When the focus is on the lower Deck (Deck C or D), the Deck Assign button lights up. Simultaneously, the DECK C (or DECK D) indicator lights up instead of the DECK A (or DECK B) indicator in the Deck Display (see ↑5.3.4, Deck Display: Informed at a Glance below), along with the Deck Assignment indicator in the corresponding channel of the Mixer (see ↑5.4.3, The Channels and the Crossfader).

Secondary Function: Switching Between Layouts

The Deck Assign buttons also allow you to switch between Layouts in TRAKTOR.

► On the left Deck, press SHIFT + DECK C to switch to another Layout in TRAKTOR.
► On the right Deck, press SHIFT + DECK D to switch to another Layout in TRAKTOR.

You can customize the Layouts that will be activated when pressing each Deck Assign button by going to Preferences > Traktor Kontrol S4 > S4 Control Options. Please refer to section ↑6.3, S4 Control Options for more info on this.

For more info on what a Layout is, please refer to the separate TRAKTOR 2 Manual.

5.3.4 Deck Display: Informed at a Glance

The Deck Display holds six indicators along with the Loop Size Display:
Indicators in the Deck Display

The six indicators in the Deck Display provide various Deck-related information:

- **ON AIR indicator**: lights up when the Deck is audible on the TRAKTOR KONTROL S4 main outputs. This indicator takes the crossfader position as well as the corresponding channel fader position into account in order to decide whether the Deck is “on air” or not. In a nutshell: When the ON AIR indicator is lit, think twice before starting or pausing the Deck!

- **SAMPLES indicator**: lights up if the lower Deck is a Remix Deck. This notably allows you to know that the Sample Play buttons of the upper Track Deck are controlling the Sample Slots of the Deck below (provided that you didn’t change their assignments—see the description of the Sample Play buttons in section ↑5.3.9, Sample Play Buttons).

- **DECK A (or DECK B) indicator**: lights up in blue when the Deck on your S4 is focused on the upper Deck (Deck A on the left, Deck B on the right) in TRAKTOR.

- **DECK C (or DECK D) indicator**: lights up in white when the Deck on your S4 is focused on the lower Deck (Deck C on the left, Deck D on the right) in TRAKTOR.

- **KEYLOCK indicator**: lights up when the Keylock is active on that Deck. Note that Keylock can be activated on Track Decks only. For more info on the Keylock feature of TRAKTOR, please refer to the tutorial in section ↑4.8, Synchronization and to the TRAKTOR 2 Manual.

- **MASTER indicator**: Lights up when the Deck is the tempo master. This information is crucial when synchronizing tracks. Note that only Track Decks can be set as tempo master. To set a Track Deck as tempo master, use SHIFT + SYNC (see section ↑5.3.12, SYNC Button). For more info on synchronization, please refer to the tutorial in section ↑4.8, Synchronization and to the TRAKTOR 2 Manual.
Loop Size Display

At the far right of the Deck Display, the **Loop Size Display** shows the currently selected loop size (measured in beats). You can change the selected Loop size and create Loops with this size via the LOOP SIZE encoder (see section ↑5.3.8, Loop Section).

5.3.5 LOAD Button

The LOAD button allows you to load/unload a track / Remix Set to / from the Deck when using Quick Loading. It is used in conjunction with the BROWSE encoder, which allows you to quickly browse the Playlist you’re currently in:

1. Turn the BROWSE encoder to select the desired track in the currently opened Playlist in the Browser. Hold SHIFT and turn the BROWSE encoder to scroll through your Favorites.
2. Press LOAD to load that track / Remix Set to the Deck.

   By pressing SHIFT + LOAD, you unload the track from the Deck.

You will find more info on browsing and loading in section ↑5.7.1, Browsing Tracks and Samples.

Moreover, the LOAD button lights up when you push the jog wheel’s top plate (e.g. for scratching, see ↑5.3.6, Jog Wheel).

The LOAD button can be switched to an alternate assignment in which it activates a special Jog mode for the jog wheel. Please refer to section ↑6.3, S4 Control Options for more info.
5.3.6 Jog Wheel

The jog wheel (right Deck pictured)

The jog wheel has several functions dealing with the playback of your Deck:

- **Tempo bending**: By spinning the jog wheel’s outer rim, you temporarily raise or lower the Deck tempo. When you stop spinning the rim, the Deck tempo returns to its original value.

- **Scratch**: By pressing and spinning the jog wheel’s top plate, you fully take over manual control for cueing up a beat, back spinning or for scratching. Also this can be very useful to precisely locate any particular point in your track / Remix Set. When you release the top plate, the Deck returns to its previous playback state (playing or paused).

- **Seek**: By additionally pressing SHIFT when spinning the jog wheel’s top plate, you can fast seek through your track / Remix Set.

> When you press the jog wheel’s top plate, the LOAD button above lights up to indicate that you are manually controlling the playback position.

The jog wheel also provides additional features:

- Inside an active Loop, while holding the LOOP IN or LOOP OUT button depressed, use the jog wheel to adjust the Loop In Point or Loop Out Point, respectively. See section ↑5.3.8, Loop Section for more info on this.
- In Browse mode, you can use the jog wheel to scroll through the selected Playlist. See section 5.7, Browsing, Loading and Copying for more info on this.

- Your jog wheel can also be switched to a special Jog mode providing you with advanced features like FX control or filter control. Please refer to section 6.3, S4 Control Options for more info.

### 5.3.7 Tempo Fader and Tempo Offset Buttons

The TEMPO fader and the OFFSET buttons provide you with extended controls over the Deck tempo.

The TEMPO fader controls the tempo of the focused Deck: Pulling the TEMPO fader downwards/upwards increases/decreases the tempo, respectively. By default, the range of the TEMPO fader is ±6 %.

You can change this range in Preferences > Transport > Tempo. Both the tempo fader in the software Deck and the TEMPO fader on your S4 are affected by this setting.
Absolute Mode

By default, the TEMPO fader is in Absolute mode. In this mode, whenever you move the TEMPO fader on your S4, its position is transmitted 1:1 to the tempo fader on the software Deck—which in the end controls the tempo of the software Deck.

Therefore, the software Deck’s tempo matches the TEMPO fader position on your S4, unless you have somehow changed the software Deck’s tempo by other means such as:

▪ Activating SYNC on that Deck to sync it to another tempo, thus modifying the tempo on the software Deck. As long as SYNC is on and the relevant Deck is not the tempo master, the Deck tempo cannot be manually controlled via the faders (they are deactivated both on the software and hardware Deck).

▪ Switching the Deck focus on your S4 to the alternate software Deck, in which the tempo fader may have another position.

▪ Moving the tempo fader in the software.

For all these situations, the Tempo Offset buttons come into play and help you to keep track (!) of the Deck tempo.

Tempo Offset Buttons

The Tempo Offset buttons (labeled OFFSET and showing little up and down arrows) are equipped with LEDs that indicate you the offset between the TEMPO fader on your S4 and the tempo fader of the focused Deck in TRAKTOR:

▪ Down-arrow lit: The tempo fader position on the software Deck is below the TEMPO fader position on your S4 (the software plays faster than indicated by the fader on the S4).

▪ Up-arrow lit: The tempo fader position on the software Deck is above the TEMPO fader position on your S4 (the software plays slower than suggested by the fader on the S4).

You can cancel the offset shown by the OFFSET buttons in various ways:
Hold SHIFT while moving the TEMPO fader: This disconnects the hardware fader from the software fader and allows a soft takeover. While holding SHIFT depressed, find the fader position at which the lit OFFSET button turns off and the other one lights up: This position roughly corresponds to the software fader position. Release SHIFT and move the TEMPO fader: the tempo jump will be negligible.

Press either OFFSET button to reset the software’s tempo fader to the position of the TEMPO fader on your S4. This can lead to a substantial tempo jump.

In Absolute mode, slightly moving the TEMPO fader on your S4 also resets the software fader to the position of the hardware fader.

Additionally, both OFFSET buttons light up dimmed to indicate that the TEMPO fader is near 0 %.

**Locking the Tempo**

In case you don’t use the TEMPO fader at all and play the Deck at its exact original speed, you can lock the tempo and disable the fader on your S4 to avoid moving it by accident. To lock the tempo to its original value:

► Press both OFFSET buttons simultaneously (provided that none of them is lit).

→ The tempo of the focused Deck is reset to 0 % and the TEMPO fader is deactivated. Both OFFSET buttons light up simultaneously to indicate the tempo locking.

Tempo locking is only possible if SYNC is deactivated on the relevant Deck.

To enable the TEMPO fader again, press either (or both) OFFSET button(s).

**Relative Mode**

You can also switch the TEMPO faders to Relative mode. In this mode, each TEMPO fader on your S4 affects the tempo fader of the software Deck relatively to its current position, even if this position does not match the position of the TEMPO fader on your S4. This notably resolves possible conflicts between the TEMPO fader and the Deck synchronization or Deck switching. To activate the Relative mode, open Preferences > Traktor Kontrol S4 > Tempo Faders. Please refer to section ↑6.3, S4 Control Options for more info in this.
5.3.8 Loop Section

The Loop section holds all necessary controls for setting and modifying Loops in your tracks / Remix Sets. The Loop section consists of two buttons in the middle and two push encoders on the sides. From left to right, you find the following controls: LOOP MOVE encoder, LOOP IN button, LOOP OUT button, and LOOP SIZE encoder.

**LOOP IN and LOOP OUT Buttons**

The LOOP IN and LOOP OUT buttons allow you to manually define a Floating Loop in the playing Track Deck / Remix Deck.

Pressing the **LOOP IN button** sets a Floating Cue Point at the current playback position. This Floating Cue Point will serve as Loop In Point as soon as you press the LOOP OUT button.

**Hint:** The LOOP IN button is the perfect tool for setting a Floating Cue Point without stopping the playback, whether you set a Loop Out Point later or not!

Pressing the **LOOP OUT button** sets a Loop Out Point at the current playback position and activates a Floating Loop between the previously set Floating Cue Point and this Loop Out Point.

**You can reuse the same Loop In Point for several Loops: simply set a new Loop Out Point, and the previous Loop In Point will be used for the new Floating Loop!**
The LOOP IN and LOOP OUT buttons also act as indicator: they light up simultaneously to indicate that a Loop is running. If looping is active but the playback position is outside any Loop, only the LOOP OUT lights up.

When a Loop is running, you can fine-tune its Loop In and Loop Out Points by holding the corresponding button depressed and using the jog wheel:

► Hold the LOOP IN or LOOP OUT button depressed and spin the jog wheel to adjust the Loop In or Loop Out Point of the running Loop.

Bear in mind that all your actions affect a Floating Loop (and not the original Stored Loop, if any). Hence, if you plan to use the modified Loop later, don’t forget to store it! For example, you can do this by assigning the Loop to a Hotcue slot (see section ↑5.3.10, Hotcue Buttons). Storing Loops to a Hotcue slot is only available for Track Decks.

The LOOP IN and LOOP OUT buttons can also have alternate functions when switched to Auto Loop mode. You can do this in Preferences > Traktor Kontrol S4 > S4 Control Options. See section ↑6.3, S4 Control Options for more info.

**LOOP MOVE Encoder**

The LOOP MOVE encoder allows you to activate/deactivate looping, move the Loop and jump in the track:

<table>
<thead>
<tr>
<th>LOOP MOVE encoder</th>
<th>No Loop active</th>
<th>Loop active</th>
</tr>
</thead>
<tbody>
<tr>
<td>Turn</td>
<td>Beatjumps by the current loop size (as displayed in the Loop Size Display).</td>
<td>Moves the Loop by the current loop size (as displayed in the Loop Size Display).</td>
</tr>
<tr>
<td>SHIFT + Turn</td>
<td>Beatjumps by 1-beat steps.</td>
<td>Moves the Loop by 1-beat steps.</td>
</tr>
<tr>
<td>Push</td>
<td>Activates looping (current or next Loop in track will be looped).</td>
<td>Deactivates looping.</td>
</tr>
</tbody>
</table>
Bear in mind that all your actions affect a Floating Loop (and not the original Stored Loop, if any). Hence, if you plan to use the modified Loop later, don’t forget to store it! For example, you can do this by pressing an unlit Hotcue button (see section ↑5.3.10, Hotcue Buttons). Storing Loops to a Hotcue slot is only available for Track Decks.

**LOOP SIZE Encoder**

The LOOP SIZE encoder allows you to select/adjust the loop size and to set a Floating Loop with the selected size:

<table>
<thead>
<tr>
<th>LOOP SIZE encoder</th>
<th>No Loop active</th>
<th>Loop active</th>
</tr>
</thead>
<tbody>
<tr>
<td>Turn</td>
<td>Selects a loop size (in beats) for the next Floating Loop that you will set. The selected loop size is displayed in the Loop Size Display above the encoder.</td>
<td>Halves/doubles the Loop's size.</td>
</tr>
<tr>
<td>Push</td>
<td>Sets and activates a new Floating Loop at the current playback position with the selected loop size.</td>
<td>Deactivates looping.</td>
</tr>
</tbody>
</table>

You may have noticed that pushing either of the LOOP MOVE and LOOP SIZE encoders activates/deactivates looping. The only difference when activating looping via the LOOP SIZE encoder is that you additionally set a new Floating Loop at the current position.

Bear in mind that all your actions affect a Floating Loop (and not the original Stored Loop, if any). Hence, if you plan to use the modified Loop later, don’t forget to store it! For example, you can quickly do this by assigning the Loop to a Hotcue slot (see section ↑5.3.10, Hotcue Buttons). Storing Loops to a Hotcue slot is only available for Track Decks.
5.3.9 Sample Play Buttons

By default, the Sample Play buttons control the Sample Cells of a Remix Deck:

- In case the upper Deck is a Track Deck, and the lower Deck is a Remix Deck, the Sample Play buttons will control the Remix Deck's Sample Cells.
- In case the upper Deck is a Remix Deck, the Sample Play buttons will control the upper Remix Deck's Sample Cells.

The Sample Play buttons allow you to load and play Samples. Each Sample Play button represents a Sample Cell in one of the four Sample Slots of a Remix Deck.

If you don't want to use Samples at all, or if you don't want to mix Track Deck controls and Remix Deck controls, you can activate alternate functions for these Sample Play buttons in Preferences > Traktor Kontrol S4 > S4 Control Options. For example, they can be used as Beatjump buttons or as additional Hotcue buttons. Please refer to section 6.3, S4 Control Options for more info.

Sample Slot States

The LED of each Sample Play button indicates the current state of the Sample Slot:

<table>
<thead>
<tr>
<th>Sample Play button</th>
<th>Sample Slot's state</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unlit</td>
<td>Empty Sample Slot.</td>
</tr>
<tr>
<td>Dimmed</td>
<td>Sample loaded but stopped or muted.</td>
</tr>
<tr>
<td>Lit</td>
<td>Sample loaded and playing.</td>
</tr>
</tbody>
</table>
Capturing a Sample from another Deck

If a track is currently loaded into a Track Deck, you can directly export a Sample from that track by pressing an unlit Sample Play button. Select the Deck to be captured from with the Capture Source selection drop-down menu in the Remix Deck's Header.

Once you press an unlit Sample Play button, a Sample is copied from the current playback position to the Sample Slot:

- If the current playback position is within an active Loop, the Sample is a copy of the Loop.
- If the current playback position is outside any active Loop, the Sample starts at the current playback position and its size is defined by the selected loop size (as displayed by the Loop Size Display).

The Sample Play button now lights up dimmed to indicate that the Sample is loaded but not audible, because it is either muted or stopped.

To tell whether the Sample is stopped or muted, have a look at the TRAKTOR software: If the Sample is muted, its waveform in the Sample Slot is dimmed, while the lit/unlit Sample Play button indicates whether or not the Sample is playing.

When importing a Sample from the loaded track, as soon as the Sample is played live three times in the main mix, the Sample is automatically saved to the Collection for later use!

Quick Loading a Sample from a Playlist

By holding SHIFT and pressing an unlit Sample Play button, you load the currently selected Sample from the currently active Playlist into the relevant Sample Slot.
Other Methods for Loading a Sample

You can also copy a Sample from other Sample Slots or from the Loop Recorder by using the Copy mode, or load a Sample from the Browser by using the Browse mode. Both modes are explained in detail in section §5.7, Browsing, Loading and Copying.

Playback Controls in Loop and One-shot Mode

Once a Sample is loaded into a Sample Slot, the Sample Play button controls its playback. Its functionality depends on the Sample’s Play Type (Loop or One-shot), which is indicated by the Play Type indicator to the left of a Sample Cell; it either depicts a loop or an arrow symbol.

To change the Play Type of the Sample, the Advanced Panel of the Remix Deck needs to be opened. Double-click repeatedly on the upper border of the Deck to cycle through the Deck Layouts until the Advanced Panel becomes visible below the Deck (as shown in the screenshot below).

The Remix Deck C with the Advanced Panel on bottom. On the lower right you can see the cursor pointing on the Play Type button, which switches the Sample Cell from One-shot to Loop mode and vice versa.

- Click on the Play Type button in the lower right of the Advanced Panel (see screenshot above) to switch the Sample to One-shot mode if you wish.

In Loop mode, the Sample will be played back looped. The Sample Play button acts as follows:
In **One-shot mode**, the whole Sample will be played once. The Sample Play button acts as follows:

<table>
<thead>
<tr>
<th>Playback state</th>
<th>Sample Play button</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample stopped</td>
<td>Press to start playback.</td>
</tr>
<tr>
<td>Sample playing</td>
<td>Press to mute/unmute the Sample.</td>
</tr>
<tr>
<td></td>
<td>SHIFT + press to stop the Sample. The next time you trigger the Sample, it will start playing from its start position.</td>
</tr>
</tbody>
</table>

**Unloading a Sample**

You can clear a Sample Cell by pressing SHIFT + Sample Play button. The button’s LED turns off.

**More Controls over the Samples**

By default, the Samples are loaded and played on the lower Remix Deck — Deck C on the left and Deck D on the right. The Sample Play buttons represent the Sample Cells inside the Sample Slot of the Remix Deck, while the LOOP section, Hotcue buttons and transport section control the upper Track Deck; however, by pressing the Deck Assign button, you gain full Deck control over the lower Deck.

### 5.3.10 Hotcue Buttons

The Hotcue buttons
The Hotcue buttons (labeled “1” to “4”) have different functions, depending on whether the controlled Deck is a Track Deck or a Remix Deck. For a Track Deck, they represent the first four Hotcue slots of the Deck. Hotcues allow you to quickly jump to the stored Cue Points and Loops they are assigned to. Using Hotcues is only available for Track Decks.

If the Deck in focus is a Remix Deck, the Hotcue buttons control the Sample Slots of the Remix Deck. See also section "Hotcue Buttons in a Remix Deck Context" at the end of this chapter.

Hotcue Slot States

The LED on each Hotcue button indicates the current state of the slot:

<table>
<thead>
<tr>
<th>Hotcue button</th>
<th>Hotcue slot’s state</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unlit</td>
<td>Empty Hotcue slot.</td>
</tr>
<tr>
<td>Blue</td>
<td>Hotcue slot contains a Cue Point.</td>
</tr>
<tr>
<td>Green</td>
<td>Hotcue slot contains a Loop.</td>
</tr>
</tbody>
</table>

Storing a Cue Point or a Loop into a Hotcue Slot

You can directly store the current playback position into a Hotcue slot by pressing an unlit Hotcue button (empty slot) during playback. A Cue Point or a Loop will be stored, depending on the current playback position:

- If the playback position is outside any active Loop, a Cue Point will be stored. The Hotcue button lights up in blue.
- If playback is within an active Loop, this Loop will be stored. The Hotcue button lights up in green.

If you want to store a Cue Point while the playback position is within an active Loop, deactivate looping first—for example by pushing the LOOP MOVE encoder.

Jumping to Predefined Hotcues

Pressing a lit Hotcue button jumps to that Cue Point / Loop. On a playing Deck, playback continues after the jump; on a paused Deck, the track is played from that Cue Point / Loop as long as the Hotcue button is held depressed. Upon release, playback stops and skips back to that point.
Deleting a Hotcue Slot

To delete the content of a Hotcue slot, press SHIFT + desired Hotcue button. The button’s LED turns off.

⚠️ By deleting a Hotcue slot, you also delete the Cue Point or Loop it contained.

Hotcue Buttons in a Remix Deck Context

When the Deck in focus is a Remix Deck, the Hotcue buttons provide advanced functions for the Sample Slots instead of triggering Hotcues. The functions then depend on the Hotcue Buttons setting in the Traktor Kontrol S4 section of the TRAKTOR Preferences.

The Hotcue Buttons drop-down menu from the Preferences
The following settings are available:

- **Legacy Mode:** In Legacy mode, the Hotcue buttons will behave as they did for the former Sample Decks:
  
  - Pressing an unlit Hotcue button will capture a Sample from the capture source Deck / start playback.
  
  - Pressing SHIFT + a Hotcue button will enter Edit mode for the Sample Slot, in which the LOOP MOVE and the LOOP SIZE encoders control the volume and filter settings, respectively. The Hotcue buttons flashes when Edit mode is activated for a Sample Slot.

- **Remix Mode:** in Remix mode, the Hotcue buttons have the following functions:
  
  - Pressing an unlit Hotcue button will capture a Sample from the capture source Deck / start playback.
  
  - Pressing SHIFT + a Hotcue button will activate the next Sample Cell in the Sample Slot.

The Hotcue buttons' LEDs also provide feedback on the state of the Sample Slot.

<table>
<thead>
<tr>
<th>Hotcue button – LED state</th>
<th>Sample Slot’s state</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unlit</td>
<td>Empty Sample Slot.</td>
</tr>
<tr>
<td>Dimmed</td>
<td>Sample loaded but stopped.</td>
</tr>
<tr>
<td>Blue</td>
<td>Sample Cell is set to One-shot mode</td>
</tr>
<tr>
<td>Green</td>
<td>Sample Cell is set to Loop mode</td>
</tr>
<tr>
<td>Flashing</td>
<td>Edit mode is activated for the Sample Slot (only in Legacy mode)</td>
</tr>
</tbody>
</table>
5.3.11 PLAY and CUE Buttons

At the bottom of the Deck, the PLAY and CUE buttons are the usual transport controls for the Deck.

**PLAY Button**

The PLAY button starts/stops the playback of the Deck. The button is lit when the Deck is playing.

Pressing SHIFT + PLAY activates/deactivates the Keylock on the Deck. When the Keylock is activated, the KEYLOCK indicator lights up in the Deck Display (see ↑5.3.4, Deck Display: Informed at a Glance for more info).

**CUE Button**

The CUE button functions as follows:

- When the Deck is playing, pressing CUE skips to the Floating Cue Point and stops the playback.

- When the Deck is paused, pressing CUE sets a new Floating Cue Point (which replaces the previous Floating Cue Point). The track is played back from that Floating Cue Point as long as the CUE button is held depressed. Upon release, playback stops and skips back to the Floating Cue Point.

Pressing SHIFT + CUE skips back to the beginning of the track. The playback state (playing or paused) is left untouched.
5.3.12  SYNC Button

The SYNC button activates/deactivates the synchronization of the Deck to the current tempo master (another Deck or the Clock). The button is lit when synchronization is activated.

Activating the synchronization disables the TEMPO fader if it is in the default Absolute mode. See section ↑5.3.7, Tempo Fader and Tempo Offset Buttons for more info.

Pressing SHIFT + SYNC sets the Deck to **tempo master**—the Deck tempo then serves as tempo reference for all other synched Decks and FX. When the Deck is set as tempo master, the MASTER indicator lights up in the Deck Display (see ↑5.3.4, Deck Display: Informed at a Glance for more info).

For more details on the synchronization concepts in TRAKTOR KONTROL S4, see the tutorial in section ↑4.8, Synchronization.

**Adjusting the Beatgrid with the S4**

The SYNC button can also be used to adjust the Beatgrid of a track.

The Beatgrid, which serves to synchronize playback of tracks, may not have been correctly set by the automatic beat detection. In this case you must adjust it manually to the beats of the track.

Most commonly, Beatgrids do have the correct tempo but are shifted relatively to the beats of the track. To correct such an offset proceed as follows:

1. Play a reference track with a correct Beatgrid in Deck B and set Deck B to tempo master (via SHIFT + SYNC on Deck B).
2. Play the track with the incorrect Beatgrid in Deck A and activate SYNC on Deck A.
3. Use the outer rim of the jog wheel to tempo bend Deck A until the beats match the beats of Deck B.
4. Once the beats are aligned, press and hold SHIFT + SYNC for more than one second to adjust the Beatgrid according to the current settings.

If you can’t match the beats with this method, most likely also the tempo of the Beatgrid has been wrongly detected. In this case proceed as follows to set a correct tempo:

1. Play the track in Deck A (turn off SYNC).
2. Tap the SHIFT button repeatedly (at least 5 times) to the beat of the music. In this procedure you must try to be very precise. The longer you tap, the better the result you will get. If you pause tapping for two seconds you can resume tapping from scratch.

→ If you managed to visually align the Beatgrid with the beats of the track you can proceed as described above to also correct the offset.

For more info on Beatgrids, see the tutorial in section 4.8, Synchronization.

5.3.13 SHIFT Button

The SHIFT button is a modifier: holding SHIFT depressed while using other control elements grants you access to their secondary function.

This element always has the same functionality, regardless of the Deck Flavor (Track Deck or Remix Deck). It is described in detail in section 5.3.2, SHIFT Buttons: Accessing Secondary Functions above.

**Tapping to the Beat**

On a Track Deck, the SHIFT button can also help you to define the track’s Beatgrid manually.

This allows you to redefine the Grid of a track from your S4 on the fly, would the Beatgrid ever appear to be wrong or missing. Tapping is used in conjunction with the SYNC button. See section 5.3.12, SYNC Button above for more details.
5.4 The Mixer

The Mixer, in the middle of your S4

This section describes the general handling of the Mixer on your TRAKTOR KONTROL S4.

You will find in \[11.2, \text{Remix Deck Quick Reference}\] a Quick Reference table summing up the basic functionality of each control element on the Mixer.
5.4.1 Mixer Overview

The Mixer is equipped with four channels, each of them controlling the signal coming from one particular Deck: channel A, B, C, and D control the signals coming from Deck A, B, C, and D, respectively.

Thanks to the logical layout of the channels on the Mixer, you can quickly see what goes where:

▪ Channels on the left (A and C) control the signals from left Decks in the software.
▪ Channels on the right (B and D) control the signals from right Decks in the software.
▪ Channels in the middle (A and B) control the signals from the upper Decks in the software.
▪ Channels on the sides (C and D) control the signals from the lower Decks in the software.

5.4.2 The Main Section

![The Mixer's Main section]

The Main section allows you to both monitor and adjust the overall output level of your mix, i.e. the level of the signal sent to the Main Outputs on your S4. This is the last step for controlling the level on your S4, before your mix is sent to the outside world.

The Main section holds two elements: the MAIN LEVEL knob and the MAIN LEVEL meters:
Control element | Function
--- | ---
 MAIN LEVEL knob | Adjusts the level of the signal sent to the Main Outputs of the S4.
 MAIN LEVEL meters | Give a visual feedback on the pre-knob level of your mix.
Orange LEDs light up when the signal is clipping or when the limiter kicks in on the software side.

Worth to note is that the MAIN LEVEL meters show you the level of your mix at the output of the TRAKTOR software—thus after it has been adjusted by the MAIN knob in TRAKTOR's Master panel, but before the signal reaches the MAIN LEVEL knob on your S4. Hence, if the orange LEDs tend to light up too often, you should turn down the MAIN knob in the Master panel of TRAKTOR.

For more info on how to set your levels correctly, see the tutorial in section 4.3, Adjusting Levels.
5.4.3 The Channels and the Crossfader

A channel on the Mixer (channel C pictured)

The channels and the crossfader make up the core of the mixing scheme.

**Signal Flow**

As a rule of thumb: the signal coming from a Deck arrives at the top of the channel (GAIN encoder) and goes down to the bottom (channel fader). The only exception to that rule is the pair of FX Assign buttons: although they are sitting right under the GAIN encoders, they actually tap the signal after the EQ and FILTER knobs and before the channel fader.
**GAIN Encoder**

The GAIN encoder controls the input level of the signal coming from the corresponding Deck.

- Turn the GAIN encoder to adjust the channel input gain.

  ![GAIN encoder](image)

  This notably affects the resulting level as shown by the channel meter at the bottom: If the channel meter indicates that the signal is clipping, turn down the GAIN encoder. For more info on how to set your levels correctly, see the tutorial in section 4.3, Adjusting Levels.

- Push the GAIN encoder to reset the channel input gain to 0 dB.

**FX Assign Buttons**

The FX Assign buttons (labeled “1” and “2”) allow you to assign the channel and its corresponding Deck both to the desired FX Units (normal layer) and to a particular side of the cross-fader (Shift layer).

For the **FX Unit assignment**, press the left or right button to assign this channel to the FX Unit 1 or 2, respectively. The button lights up when the channel is routed to the corresponding FX Unit. When activating both buttons on the same channel, FX Unit 1 and FX Unit 2 will process the channel’s signal in series.

![FX Assign buttons](image)

For a description of the FX Units on your S4, please refer to section 5.5, The FX Units.
You can activate two additional FX Units in the Preferences of TRAKTOR. Using four FX Units instead of two implies a few changes in the FX routing scheme. Please refer to section 6.4.3, Using Four FX Units for more info.

For the **crossfader assignment**, press SHIFT when using the buttons. This allows you to choose the crossfader’s side to which the current channel is assigned (and thus, its corresponding Deck too):

- Press SHIFT + FX Assign 1 or 2 to assign the channel to the left or right side of the crossfader, respectively.

The resulting assignment is shown by the Crossfader Assignment indicator (the little arrows), at the bottom of each channel (see description at the end of this section).

You can also unlink a channel from the crossfader by pressing SHIFT and the FX Assign button corresponding to the side it is currently assigned to. This way, that channel won’t be affected by the crossfader position.

**EQ and FILTER Knobs**

Each channel boards an **EQ section** with the three usual knobs HI, MID and LOW for controlling high, medium and low frequency content of the signal, respectively.
Turn each EQ knob clockwise to emphasize the corresponding frequency band, and counter-clockwise to attenuate this band. At center detent position, the knob does not alter the signal.

TRAKTOR provides you with various types of EQ, each of them having its own “personality.” You can choose the EQ type in Preferences > Mixer > EQ Selection. For more info, please refer to the TRAKTOR 2 Manual.

Below the EQ, the FILTER knob allows you to adjust the channel’s on-board bipolar filter. From the center detent position, turning the knob clockwise activates a high-pass filter, whereas turning it counter-clockwise activates a low-pass filter. On left and right end, the filter almost acts as a high frequency and low frequency killer, respectively.

From its center detent position, turn the FILTER knob clockwise to cut low and mid frequencies and counter-clockwise to cut high and mid frequencies.

TRAKTOR provides you with two different types of bipolar filters. You can choose the filter type in the Preferences > Mixer > Filter Selection. For more info, please refer to the TRAKTOR 2 Manual.

Headphones Cue Button

The Headphones Cue button (CUE) allows you to send the channel’s signal to the cue channel—in other words, to your headphones. This is a basic feature for DJing, since it allows you to pre-listen the audio playing on that channel before using it in your mix.

Press the CUE button to send the channel’s signal to your headphones.

The Headphones Cue button lights up when activated, i.e. when the corresponding channel is sent to the cue channel.

In Browse mode, the Headphones Cue button is used to load the selected track on to the corresponding Deck (Track Decks only). See section 5.7, Browsing, Loading and Copying for more info on the Browse mode.
**Deck Assignment Indicator**

The Deck Assignment indicator (labeled A, B, C, or D) shows which software Deck is currently controlled by the S4 Deck nearby—simultaneously, it shows on which channel the Deck nearby is playing. For example, if the Deck Assignment indicator of channel C lights up (showing a “C”), it means that the left Deck on your S4 controls Deck C in TRAKTOR.

Furthermore, the color of the lit Deck Assignment indicator reminds you whether the controlled Deck is an upper Deck (blue) or a lower Deck (white).

**Channel Fader and Channel Meter**

The channel fader and meter

The channel fader controls the channel’s level, before the signal is sent to the crossfader and Main section.

The channel meter gives you a visual feedback on the pre-fader level of the signal on this channel:

- Blue: The signal is below clipping.
- Orange: The signal is clipping.

This meter allows you both to check that the signal is neither too low nor clipping, and to visually match the level on this channel with the level on other channels in order to avoid level inconsistencies during transitions.
To correct the channel level, adjust the GAIN encoder at the very top of the channel. For more info on how to set your levels correctly, see the tutorial in section 4.3, Adjusting Levels.

**Crossfader Assignment Indicator**

The Crossfader Assignment indicator shows you the side of the crossfader the channel is assigned to.

To change the crossfader assignment, hold SHIFT and press the desired FX Assign buttons (see above, at the beginning of this section).

**Crossfader**

The crossfader controls the mix between the signal(s) assigned to its left and right side. At the center position, the crossfader has no effect: channel levels are then only defined by the respective channel faders (see above). At each crossfader’s end, the opposite signals are totally cut.

You can customize the fading curve of the crossfader in TRAKTOR’s Preferences. Please refer to the TRAKTOR 2 Manual for more info.
You can quickly see which channels are assigned to each side of the crossfader by looking at the Crossfader Assignment indicators right above (the pairs of little arrows). You can change the crossfader assignments via SHIFT + FX Assign buttons. For more info on these control elements, see above in this section.

If you rather use the channel faders instead of the crossfader for mixing, you can deactivate the crossfader in order to avoid unwanted level inconsistencies between channels. To do this, deactivate all crossfader assignments by SHIFT-pressing the corresponding FX Assign buttons.

You can customize the fading curve of the Crossfader in Preferences > Mixer > Crossfader. Please refer to the TRAKTOR 2 Manual for more info.

### 5.4.4 The Master Display

The Master Display provides you with some vital information and controls for your TRAKTOR KONTROL S4 system.

**Alert Indicator**

![Alert Indicator](image)
The Alert indicator basically informs you that something might go wrong with your TRAKTOR KONTROL S4 system: the indicator flashes if the Main Volume knob or the Headphones Volume knob is too low in TRAKTOR, if the CPU meter is too high, or if the power supply of your laptop is disconnected.

**USB Indicator**

![USB Indicator](image)

The USB indicator gives you information about the status of the USB connection between your S4 and your computer. The indicator should be continuously lit. If it flashes, there is no connection to the computer or a problem with the driver.

► Check that the USB indicator is continuously lit before going any further with your S4.

**Preview Play Indicator**

![Preview Play Indicator](image)

The Preview Play indicator lights up if a track is loaded into the Preview Player.

For more info on the Preview Player, see section ↑5.7.1, Browsing Tracks and Samples.
SNAP Button and Indicator

The SNAP button and indicator allows you to activate/deactivate the Snap mode. With Snap active, every Cue Point that you set will snap to the closest beat (see the tutorials in section ↑4.2, Mixing In a Second Track and ↑4.8, Synchronization for more info on this).

⚠️ The Snap option affects both Cue Points and Loops.

When the Snap option is active, both the button and the indicator light up.

Clock Master Button and Indicator (MASTER)

The Clock Master button and indicator allows you to set TRAKTOR’s Clock as tempo master.

When the Clock is set as tempo master, both the button and the indicator light up.

💡 For more info on the whole synchronization concept in TRAKTOR KONTROL S4, please refer to the tutorial in section ↑4.8, Synchronization.
Quantize Button and Indicator (QUANT)

The Quantize button and indicator

The Quantize button allows you to activate/deactivate the Quantize mode. With Quantize active, all skips within audio (Hotcues, Beatjumps, etc.) are beat-accurate: for example, if you trigger a jump before a beat, the playback jumps at the equivalent position before the target beat. This way, your track always stays in sync, allowing a perfect real-time remixing.

When the Quantize option is active, both the button and the indicator light up.

See the tutorials in section ↑4.2, Mixing In a Second Track and ↑4.8, Synchronization (for more info on this)

5.4.5 The BROWSE Encoder and BROWSE Button

The BROWSE encoder

The BROWSE button
The BROWSE encoder and BROWSE button are used to browse and copy tracks or Samples in TRAKTOR KONTROL S4. You will find a description of these control elements in section 5.7, Browsing, Loading and Copying.

**BROWSE Button: Switching between Native Traktor Mode and MIDI Mode**

Pressing SHIFT + BROWSE switches your TRAKTOR KONTROL S4 between native Traktor mode and MIDI mode. For more info on both modes, see section 5.10.2, MIDI Mode.

### 5.5 The FX Units

The FX Units 1 and 2 on your S4 allow you to control the FX Units in TRAKTOR. All controls of the FX Units in the software are mirrored on your S4.

The left FX Unit on your S4

- (1) FX On button
- (2) FX DRY/WET knob
- (3) FX Knob 1
- (4) FX Knob 2
- (5) FX Knob 3
- (6) FX Button 1
- (7) FX Button 2
5.5.1 Single Mode and Group Mode

In TRAKTOR, each FX Unit can work in two different modes:

- **Group mode**: Each FX Unit boards three different FX chained in series. Each FX can be controlled by one knob and one button.

- **Single mode**: Each FX Unit boards a single FX, which can be fine-tuned via the three knobs and three buttons of the FX Unit.

As a consequence, the control elements on an FX Unit will have different functions, depending on the current mode of this FX Unit.

You can switch between both modes from your S4 via the FX Mode button (see below).

5.5.2 FX Unit Reference

The following table sums up the functionality of each control element in the FX Unit.

<table>
<thead>
<tr>
<th>Control element</th>
<th>Single mode</th>
<th>Group mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>FX On button</td>
<td>Normal: activates/deactivates FX Unit globally (lit when activated).&lt;br&gt;SHIFT: selects next FX from FX list (as set in Preferences &gt; Effects &gt; FX Pre-Selection).</td>
<td>Normal: not used.&lt;br&gt;SHIFT: loads a set of three predefined FX (as set in Preferences &gt; Traktor Kontrol S4 &gt; S4 Control Options &gt; Direct FX 1-3).</td>
</tr>
<tr>
<td>FX DRY/WET knob</td>
<td>Adjusts the ratio between unprocessed (dry) signal and processed (wet) signal.</td>
<td></td>
</tr>
<tr>
<td>FX Knob 1-3</td>
<td>FX parameter 1-3 (FX-dependent).</td>
<td>Parameter for 1st, 2nd, and 3rd FX.</td>
</tr>
</tbody>
</table>
### Assigning FX Units to Channels

The FX Units can be assigned to any number of channels in order to process the signals coming from the corresponding Decks. To do this, use the FX Assign buttons on the desired channels. See section ↑5.4.3, The Channels and the Crossfader for more info.

You can activate two additional FX Units in the Preferences of TRAKTOR. Using four FX Units instead of two implies a few changes in the FX routing scheme. Please refer to section ↑6.4.3, Using Four FX Units for more info.

### 5.6 The Loop Recorder

The Loop Recorder allows you to seamlessly record a piece of audio material coming from various sources and directly blend it into your mix. Furthermore, it allows you to record many layers on the same loop (overdubbing).
The Loop Recorder on your S4

The recording source for the Loop Recorder can be selected via the Loop Recorder’s Source menu in TRAKTOR. Please refer to the TRAKTOR 2 Manual for more info.

You will find in ↑11.4, FX Unit Quick Reference a Quick Reference table summing up the basic functionality of each control element on the Loop Recorder.

5.6.1 DRY/WET Knob

The DRY/WET knob controls the mix between the main output of TRAKTOR KONTROL S4 and the output of the Loop Recorder. As soon as some audio material recorded into the Loop Recorder is played back, you can blend it into your main mix.

As long as the Loop Recorder is stopped (or empty), the DRY/WET knob is disabled. Hence, you don’t have to bother with the position of this knob as long as you’re not playing a loop on the Loop Recorder.

5.6.2 SIZE Button

The SIZE button allows you to define the size of the loop you plan to record.

► Press SIZE repeatedly to select the desired loop size.
The selected loop size cannot be seen on your S4; for this, you have to look at the Loop Recorder in the TRAKTOR window on your computer screen.

5.6.3 REC Button

The REC button starts/stops recording a loop or additional overdub layers.

If no loop has been recorded yet, pressing the REC button starts recording a loop with a predefined size (previously selected via the SIZE button). The recording always starts on the next beat. As soon as the loop is recorded, it starts playing (at the level defined by the DRY/WET knob).

If a loop has already been recorded, pressing the REC button activates/deactivates overdubbing. Overdubbing adds incremental layers on top of the recorded loop. Unlike the first recording, overdubbing starts right away instead of waiting for the next beat. Moreover, overdubbing stays engaged until you explicitly stop it by pressing REC again (possibly going on more than one loop cycle). This allows you to add as many layers as you want to your original loop by repeatedly activating/deactivating overdubbing.

Whatever the number and duration of the overdub layers, the size of the loop itself stays at the predefined size of the first recording.

5.6.4 UNDO Button

The UNDO button allows you to delete the recorded loop or to undo/redo the last overdub layer:

- When the Loop Recorder is stopped, pressing UNDO deletes the recorded loop and all its overdub layers, if any.

- When the Loop Recorder is playing, pressing UNDO undoes the last overdub layer only. Pressing UNDO again redoes this last layer. This is useful if you don’t like the last layer that you recorded. It can also be used for “punching” the last layer in and out during your live performance.
5.6.5  PLAY Button

The PLAY button starts/stops the playback of the Loop Recorder—provided of course that something has been recorded into it. When playback is stopped, the playback position skips back to the loop beginning.

Playback is also automatically triggered while overdubbing: the currently recorded material is played while a new layer is being recorded.

5.6.6  Copying and Saving the Recorded Loop

Once you have recorded a loop, you sure can leave it in the Loop Recorder and mix it with your main mix using the DRY/WET knob as described above. But you can also copy it to any free slot on a Remix Deck and use all Sample-related features on your recorded loop.

To do this, use the Copy mode described in section ↑5.7.2, Copying across the S4.

5.7  Browsing, Loading and Copying

Your S4 offers various ways for finding tracks and Samples and loading them on to the desired Decks or Sample Slots:

▪ You can quickly load tracks and Samples from the currently selected Playlist or from your Favorites.

▪ You can browse the entire content of your Track Collection for tracks and Samples via the Browse mode.

▪ You can copy a Sample directly from the track loaded on the upper Deck.

▪ You can copy a track or Sample from one location to another on your S4 via the Copy mode.

You will find in ↑11.5, Loop Recorder Quick Reference a Quick Reference table summing up the basic functionality of each control element needed for browsing, loading and copying.
5.7.1 Browsing Tracks and Samples

Quick Loading Tracks and Samples

You can quickly select tracks and Samples for loading via the BROWSE encoder, located at the top of the Mixer:

1. Hold SHIFT and turn the BROWSE encoder to scroll through your Favorites.
2. Turn the BROWSE encoder to scroll through the selected Playlist.

You can see the items being scrolled in the TRAKTOR Browser:
By turning the BROWSE encoder, you scroll the Playlist that is currently selected.

⚠️ For more info on the Browser, the Playlists and the Favorites, please refer to the TRAKTOR 2 Manual.

💡 At any time, you can load and pre-listen the selected item into the Preview Player by pushing the BROWSE encoder (see below).

► To load the selected track or Sample, press LOAD on the desired Deck:

If the focus is on a Remix Deck, the Sample will be loaded into the first empty Sample Slot. Only audio with a maximum length of 48 seconds can be loaded into Sample Slots.

💡 For Samples, you can also press SHIFT + the Sample Play button of an empty Sample Slot to load the selected Sample into that Sample Slot. Please refer to section 5.3.9, Sample Play Buttons for more info on this.
Pre-listening in the Preview Player

TRAKTOR KONTROL S4 allows you to pre-listen your tracks and Samples in the Preview Player before you load them:

► Push the BROWSE encoder to load the selected track/Sample into the Preview Player. You can see that something is loaded in the Preview Player via the lit Preview Play indicator in the Master Display (see section 5.4.4, The Master Display):

While a track or Sample is loaded into the Preview Player, the BROWSE encoder serves as seek control. You can load this track or Sample as usual, depending on whether you are using Quick Loading (see above) or Browse mode (see below).

Pushing the BROWSE encoder while an item is loaded into the Preview Player unloads it from the Preview Player and re-assigns the BROWSE encoder to list browsing.

Using the Browse Mode

The Browse mode allows you to browse your entire Collection directly from your S4 controller:

► To activate the Browse mode, press the BROWSE button in the middle of the Mixer:

When Browse mode is active, all available targets start flashing and act as load buttons: the Headphones Cue buttons (CUE) on the Mixer for tracks, and the Sample Play buttons on the Decks for Samples.
Browse through your tracks and Samples by using the jog wheels and encoders as follows:

<table>
<thead>
<tr>
<th>Action</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>BROWSE encoder</td>
<td>As usual:</td>
</tr>
<tr>
<td></td>
<td>Turn: scrolls through the Playlist.</td>
</tr>
<tr>
<td></td>
<td>SHIFT + turn: scrolls through the Favorites.</td>
</tr>
<tr>
<td></td>
<td>Push: loads/unloads selected item in the Preview Player. When an item</td>
</tr>
<tr>
<td></td>
<td>is loaded into the Preview Player, turning BROWSE seeks through the</td>
</tr>
<tr>
<td></td>
<td>loaded item.</td>
</tr>
<tr>
<td>Jog wheels</td>
<td>Scrolls through the Playlist.</td>
</tr>
<tr>
<td>LOOP MOVE encoders</td>
<td>Turn: scrolls through the Browser Tree.</td>
</tr>
<tr>
<td></td>
<td>Push: expands/collapses node in the Browser Tree.</td>
</tr>
<tr>
<td>LOOP SIZE encoders</td>
<td>Turn: scrolls through the Favorites.</td>
</tr>
</tbody>
</table>

Press a flashing target to load the selected track or Sample.

After a target has been selected, the Browse mode stays active, allowing you to load items to other locations (Track Decks or Sample Slots).

When you are finished, press the BROWSE button again to deactivate the Browse mode.

While in Browse mode, you cannot control the Decks.

5.7.2 Copying across the S4

Direct Copy for Samples

You can directly export a Sample from the current track by pressing an unlit Sample Play button (empty slot). Please refer to section 5.3.9, Sample Play Buttons for further information on this.
Using the Copy Mode

The Copy mode allows you to copy a track or a Sample from one location to another on your S4.

► To activate Copy mode, press and hold the BROWSE button in the middle of the Mixer:

While the BROWSE button is held depressed, all available copy sources are flashing: the Headphones Cue buttons (CUE) on the Mixer for tracks, the Sample Play buttons on the Decks for Samples, and the PLAY button in the Loop Recorder for the recorded loop (if any).

► Press a source to select it.

→ The selected source stops flashing and remains continuously lit.

After a source has been selected, all potential targets start flashing: the Sample Play buttons on the Decks; the Headphones Cue buttons (CUE) on the Mixer.

If the Loop Recorder’s PLAY button is not selected as source, it stops flashing because it cannot be selected as target.

► Press a target to select it.

→ The source is copied to the target.

Copying a track triggers a track duplicate so that the track is loaded on to the target Deck playing from the same position as the source Deck.

After a target has been selected, sources start flashing again, in case you want to copy other sources to other targets.

► When you are finished, release the BROWSE button to deactivate Copy mode.
5.8   The Rear Panel

This section describes all sockets and controls available on the rear panel of your TRAKTOR KONTROL S4. Together with the front panel, it provides you with the necessary elements for using other equipment with the TRAKTOR KONTROL S4 (headphones, microphone, turntable, etc.) and setting your system up.

The rear panel of the TRAKTOR KONTROL S4

- (1) **Kensington lock slot**: Attach your Kensington lock here to protect your device against theft.

- (2) **Ground terminal**: When using a turntable, attach its earth lead here.

- (3) **MAIN OUT section**: Sockets for connecting the TRAKTOR KONTROL S4 to your main mixer or amplification system. See section ↑5.8.1, MAIN OUT Section below.

- (4) **INPUT CHANNEL D section**: See section ↑5.8.2, INPUT CHANNEL D Section below.

- (5) **INPUT CHANNEL C section**: See section ↑5.8.3, INPUT CHANNEL C Section below.

- (6) **FOOTSWITCH socket**: This port can be used to attach any type of foot switch. This foot switch can be used to trigger the record/overdub control of the Loop Recorder (see ↑5.6, The Loop Recorder for more info).

- (7) **MIDI IN/OUT sockets**: Your TRAKTOR KONTROL S4 is also a MIDI interface. Connect your external MIDI devices here.

- (8) **POWER section**: See section ↑5.8.4, POWER Section below.
5.8.1 MAIN OUT Section

The MAIN OUT section holds sockets for the main outputs of your TRAKTOR KONTROL S4 controller.

The MAIN OUT section on the rear panel

- **(1) Main Outputs 1/2 RCA sockets (1/2):** main outputs of TRAKTOR KONTROL S4 (line level, unbalanced). Use these sockets to connect your TRAKTOR KONTROL S4 to an amplification system (or master mixer) with unbalanced inputs.

- **(2) Main Outputs 1/2 1/4" sockets (1/2):** main outputs of TRAKTOR KONTROL S4 (line level, balanced). Use these sockets to connect your TRAKTOR KONTROL S4 to an amplification system (or master mixer) with balanced inputs.

5.8.2 INPUT CHANNEL D Section

The INPUT CHANNEL D section allows you to route external signals to the TRAKTOR software.

The INPUT CHANNEL D section on the rear panel

- **(1) Thru Gain knob (GAIN):** Adjust here the input gain for the Thru mode (see below).
- **(2) THRU/USB switch**: Select here between Thru mode and USB mode. In Thru mode, Inputs 3/4 are additionally routed to the Main Outputs without going through TRAKTOR. In USB mode, Inputs 3/4 are only routed to TRAKTOR.

- **(3) LINE/PHONO switch**: Choose here the appropriate level (line or phono) for the source connected at Inputs 3/4.

- **(4) Line/Phono Inputs 3/4 RCA sockets (IN 3/4)**: Connect here an external audio source (turntable, CD deck, etc.).

- **(5) Microphone Gain knob (GAIN)**: Adjust here the input gain for the connected microphone (see below).

- **(6) Microphone socket (MIC)**: Connect your microphone here. The Microphone input and the Line/Phono 3/4 inputs are mutually exclusive: When you connect a microphone to the MIC socket, the IN 3/4 sockets are deactivated.

### 5.8.3 INPUT CHANNEL C Section

The INPUT CHANNEL C section allows you to route external signals to the TRAKTOR software.

![INPUT CHANNEL C](image)

The INPUT CHANNEL C section on the rear panel

- **(1) LINE/PHONO switch**: Choose here the appropriate level (line or phono) for the source connected at Inputs 1/2.

- **(2) Line/Phono Inputs 1/2 RCA sockets (IN 1/2)**: Connect here an external audio source (turntable, CD deck, etc.).
5.8.4 POWER Section

The POWER section holds the sockets for the connection of your S4 to your computer and to the power, along with the ON/OFF switch.

![POWER Section Diagram]

1. **USB socket**: Connect here your S4 to your computer with the included USB cable.
2. **Power Supply connector**: Connect here the power cord.
3. **ON/OFF switch**: Engage the switch to turn on your device.

5.9 The Front Panel

This section describes all sockets and controls available on the front panel of your TRAKTOR KONTROL S4. The front panel of your S4 holds the elements you might need during your mix.

![Front Panel Diagram]

1. **PHONES**: Controls sound volume for your headphones.
2. **CUE MIX**: Adjusts the mix for cueing.
3. **CUE VOL**: Controls the volume of the cue mix.
4. **MIC VOL**: Adjusts the mix for microphone input.
▪ **(1) Headphones socket (PHONES):** Cue channel stereo output (jack 1/4”). Connect your headphones here.

▪ **(2) Headphones Volume knob (CUE VOL):** Adjusts the volume in your headphones.

▪ **(3) Headphones Mix knob (CUE MIX):** Adjusts the mix between master output and cue channel in your headphones.

▪ **(4) Microphone Volume knob (MIC VOL):** Adjusts the AUX knob in TRAKTOR, typically used for the microphone plugged in the Microphone socket of the INPUT CHANNEL D on the rear panel (see ↑5.8.2, INPUT CHANNEL D Section above).

All knobs on the front panel are retractable: by pushing them softly, you can hide them within the body of your controller to protect them against shocks during transport!

## 5.10 TRAKTOR KONTROL S4 Modes

Your TRAKTOR KONTROL S4 controller can be used in two modes: TRAKTOR mode and MIDI mode.

### 5.10.1 Native Traktor Mode

This is the mode that you will be normally using with TRAKTOR, which gives you access to all the features explained in this manual.

In Native Traktor mode, your TRAKTOR KONTROL S4 will communicate directly with TRAKTOR over USB using the Native Instruments proprietary NHL protocol, which features high resolution translation of the TRAKTOR KONTROL S4 knobs superior to MIDI.

### 5.10.2 MIDI Mode

The MIDI mode allows you to use your TRAKTOR KONTROL S4 as a normal MIDI controller.

In MIDI mode, the TRAKTOR KONTROL S4 will transmit only MIDI data via the virtual MIDI port that the TRAKTOR KONTROL S4 driver will provide to the host computer’s operating system.
To switch your TRAKTOR KONTROL S4 between TRAKTOR mode and MIDI mode, hold SHIFT and press the BROWSE button.

Press SHIFT + BROWSE to switch between TRAKTOR mode and MIDI mode.

When your S4 is in MIDI Mode, the BROWSE button is lit.

To customize the S4’s MIDI properties, such as MIDI channel or CC numbers of its individual controls, Native Instruments has included the Controller Editor. The Controller Editor should have been installed during the TRAKTOR KONTROL S4 installation procedure. If you cannot find the Controller Editor on your computer, you can install it from the TRAKTOR KONTROL S4 installation disc.

TRAKTOR mode and MIDI mode may be used simultaneously, for example you can control TRAKTOR in TRAKTOR mode, then hold SHIFT and press BROWSE to switch to MIDI mode to control other software or hardware over MIDI.
For more information on how to use your TRAKTOR KONTROL S4 as a MIDI controller, please refer to the Controller Editor Reference Manual, provided on the installation disc.
6 Customizing TRAKTOR KONTROL S4

TRAKTOR KONTROL S4 is a highly customizable DJ system. Many of its features can be modified so that it best suits your preferred way of DJing: customizable features include audio configuration, Decks, Mixer, transport controls, overall software layout, FX, Browser, file management, to mention a few.

Since the customization of TRAKTOR KONTROL S4 is not supposed to take place in a live situation, these settings are found in the software only. This also ensures you against accidental modification of the settings while playing.

6.1 The Preferences Window

Most customization options in TRAKTOR KONTROL S4 occur in the Preferences window.

► Click the Preferences button, located in the right part of the Header (at the very top of TRAKTOR’s window) to open the Preferences of TRAKTOR.

Alternatively, you can select Preferences… in the File menu of the Application Menu Bar.

In the Preferences window, the settings are organized into various pages, each of them dealing with a specific part of your system:
1. To display a particular page of settings, click on the page name in the left column.
2. Adjust the settings according to your needs.
3. Once you have modified the desired settings, click Close at the bottom of the Preferences window to confirm your modifications or on Cancel to discard them.

6.2 Settings and Preferences for the S4 Control Elements

In this section, we will describe the available settings for the control elements sitting on the top panel of your TRAKTOR KONTROL S4 controller. The next section will present a few other settings of importance for your work with TRAKTOR KONTROL S4.
For a detailed description of all settings available in the Preferences window, please refer to the TRAKTOR 2 Manual.

In the Preferences window, the settings for the S4 have their dedicated page, judiciously called Traktor Kontrol S4.

► In the Preferences window, click Traktor Kontrol S4 at the bottom of the left column to display the page of settings for your TRAKTOR KONTROL S4 controller.

The settings for your TRAKTOR KONTROL S4 controller in the TRAKTOR Preferences.
In this page, settings are grouped into four sections: S4 Control Options, Restore Default, Calibration and LEDs.

### 6.3 S4 Control Options

On the Traktor Kontrol S4 page of the Preferences, the S4 Control Options section allows you to adjust the way your TRAKTOR KONTROL S4 controller reacts to your actions. The following paragraphs thoroughly describe each of the available settings.

**Layout Switch Left and Layout Switch Right**

The Layout Switch Left and Layout Switch Right menus allow you to change the behavior of the Layout switching function on both Decks.

In each menu, following options are available:

- **Next Layout** (default): Repeated pressures step through available Layouts.
- **Layout 0**: Selects fixed Layout #0 in the list.
- **Layout 1**: Selects fixed Layout #1 in the list.

The list of available Layouts can be customized in Preferences > Layout Manager. For more info on how to create and manage Layouts, please refer to the TRAKTOR 2 Manual.

**Direct FX 1-3**

The three menus Direct FX 1, Direct FX 2, and Direct FX 3 allow you to choose the FX to be directly loaded when holding SHIFT.
**Sample Play Buttons**

The Sample Play Buttons menu lets you choose alternate functions for the four Sample Play buttons on Track Decks.

The Sample Play Buttons setting

The Sample Play buttons’ default behavior on Track Decks is thoroughly described in section.

The following options are available:

- **--AUTO--** (default): This is the default behavior. The buttons can have two sets of functions, depending on the type of the Deck underneath:
  - If the lower Deck is a Remix Deck (which is the default situation), the Sample Play buttons control the Sample Slots of this underlying Deck.
  - If you switched the lower Deck to Track Deck, the Sample Play buttons trigger Beatjumps on the current Deck, from left to right: 4 beats backward, 1 beat backward, 1 beat forward, and 4 beats forward. This is also true for the lower Deck, when focused.

- **Beatjump**: The Sample Play buttons trigger Beatjumps, from left to right: 4 beats backward, 1 beat backward, 1 beat forward, and 4 beats forward, respectively.

- **Direct Loop**: The Sample Play buttons set predefined Loops, from left to right: Loop on the previous 8 beats, on the previous 4 beats, on the next 4 beats, and on the next 8 beats, respectively.

- **Hotcue 5-8**: With this setting, the Sample Play buttons give you access to Hotcues 5 to 8. All features are the same as with the underlying Hotcue buttons 1-4.
Hotcue Buttons

The Hotcue Buttons menu lets you choose between a Legacy mode, where the Hotcue buttons behave as with TRAKTOR’s former Sample Decks, and a Remix mode, where there was new functionality added to control TRAKTOR’s Remix Decks.

This setting is only relevant in a Remix Deck context, i.e., when the Deck is set to control a Remix Deck.

The following options are available:

- **Legacy Mode** (default): In Legacy mode, when pressing SHIFT + a Hotcue button, the controller will activate Edit mode for a Sample Slot, where the LOOP MOVE encoder and the LOOP SIZE encoder control the filter and volume controls of one or multiple Sample Slots. Pressing SHIFT + Hotcue button again will deactivate Edit mode for the relevant Sample Slot.

- **Remix Mode**: In Remix mode, pressing SHIFT + a Hotcue button will select the next Sample Cell in a Sample Slot.

Loop Buttons

The Loop Buttons setting lets you choose alternate functions for the LOOP IN and LOOP OUT buttons on Track Decks.

The Loop section allows you to manipulate Loops in your track.

Following options are available:

- **Manual Looping** (default): When this option is selected, the buttons have manual looping functions:
  - When no Loop is active, the LOOP IN button sets a Floating Cue Point, whereas the LOOP OUT button sets a Loop Out Point and activates a Floating Loop between the Floating Cue Point (acting as Loop In Point) and this Loop Out Point.
When a Loop is active, holding one of these buttons while spinning the jog wheel allows you to move the corresponding Loop In Point or Loop Out Point.

- **Auto Loop**: When this option is selected, the buttons have auto looping functions:
  - When no Loop is active, the LOOP IN and LOOP OUT buttons set and activate a 4-beat and an 8-beat Floating Loop, respectively.
  - When a Loop is active, the LOOP IN button halves the Loop’s size while the LOOP OUT button doubles it.

**Tempo Faders**

The Tempo Faders setting allows you to switch the TEMPO faders between Absolute mode and Relative mode.

- **Absolute** (default): The tempo fader in the software Deck directly mirrors the TEMPO fader position on your S4.
- **Relative**: The TEMPO fader on your S4 affects the tempo fader on the software Deck relatively to its current position, even if this position does not match the position of the TEMPO fader on your hardware. This has the benefit of solving all possible offset-related issues occurring when you change the software Deck’s tempo by any other means (e.g. synchronizing the Deck to another tempo, switching the Deck focus, or moving the tempo fader in the software):
  - There is no more risk of any tempo jump when you touch the TEMPO fader.
  - The Tempo Offset buttons have the same functionality as in Absolute mode (indicating any offset between software and hardware faders, among other things). Additionally, they allow you to shift the range of the TEMPO fader: pressing a Tempo Offset button when both are unlit moves the range down/up by half range (e.g. by 6 % for the default range ±6 %). The tempo fader in the software Deck jumps accordingly.
  - Like in Absolute mode, you can move the handle of the TEMPO fader to another position without altering the software Deck’s tempo by holding SHIFT depressed while moving the fader. This is not only useful to cover the whole range of the tempo fader in the software (should there be any offset between hardware and software faders), but
it also allows you to go beyond this range and change the Deck tempo within ±100% while preserving the current fader accuracy (as defined by the range set in Preferences > Transport > Tempo). Obviously, beyond the range of the software tempo fader, this fader does not represent the Deck tempo anymore. By moving the software fader with your mouse, though, the Deck tempo jumps back to the software fader position.

Load Buttons

The Load Buttons setting allows you to choose an alternate function for the LOAD buttons on your Decks.

Following options are available:

- **Load Track** (default): Pressing LOAD loads the selected track on the Deck when using Quick Loading; pressing SHIFT + LOAD unloads the track from the Deck.

- **Jog Mode**: Pressing LOAD activates/deactivates a special Jog mode for the jog wheel. You can choose from two different Jog modes in the underlying Jog Mode Select menu:
  - **FX**: The jog wheel controls the FX parameter 3 in Hold mode in the FX Unit right above: when releasing the jog wheel, the parameter snaps back to its previous value.
  - **Filter**: The jog wheel controls the channel’s FILTER knob in Hold mode: when releasing the jog wheel, the filter snaps back to its previous value.

If a Jog mode is activated, you can still load a track on the Deck by pressing SHIFT + LOAD (of course, you can also load tracks via the Browse mode).
Jog Wheel

The Disable Jog Wheel Push option will defeat the touch-sensitivity of the KONTROL S4 jog wheels when checked. If this option is checked, you will not be able to perform normal scratching techniques because TRAKTOR will no longer check if you're pressing the jog wheel or not. The wheel will then behave as a pitch bend at all times (like when rotating the wheel from its outside edge).

![Jog Wheel]  
By default, this option is unchecked.

6.3.1 Restore Default

The Restore Default section holds only one element: the Restore button.

![Restore Default]  
The Restore button

This button recalls all default factory settings for TRAKTOR KONTROL S4 and lets you choose its basic Deck configuration via the Setup Wizard.

To carry out the restoration procedure, do the following:

1. Click the Restore button. The following message appears:

![Confirmation Message]  
2. Upon confirmation, the default control settings and audio routing is set accordingly. You are now ready to start again with a fresh TRAKTOR KONTROL S4.
6.3.2 Calibration

The Calibration section allows you to perform the calibration for various knobs, faders, and jog wheels on your S4 in order to correct potential inaccuracies of both center position (for the knobs) and range of the control elements.

The Calibration section

The calibration can be done separately for four groups of control elements, each of them proposing its own Recalibrate button:

- **FX Knobs**: for recalibrating the FX DRY/WET knob and FX Knobs 1-3 on both FX Units.
- **EQ and Filter Knobs**: for recalibrating EQ’s and FILTER knobs on all channels of the Mixer.
- **Faders**: for recalibrating the TEMPO and channel faders.
- **Crossfader**: for recalibrating the crossfader on the Mixer.
- **Jogwheel**: for calibrating the touch-sensitivity of the jog wheels. The left and right wheels are calibrated independently. For more information on the manual calibration routine, please refer to the separate Jog Wheel Calibration guide from the Traktor 2 documentation folder.

6.4 Other Settings of Interest

This section describes a few other settings of the TRAKTOR Preferences that affect the way your TRAKTOR KONTROL S4 reacts.
6.4.1 Switching the Deck Flavors

As explained in section 5.1.1, Decks, all Decks can be individually switched between different Flavors: Track Deck, Remix Deck or Live Input.

This is done in the Decks page of the Preferences via the two lower menus in the Deck Flavor section:

The Deck Flavor section allows you to select another Flavor for each of the lower Decks C and D.

In this section, each menu represents a Deck and is labeled accordingly.

To change the Flavor of a Deck, click on the corresponding menu and select the desired Flavor. Click Close at the bottom of the Preferences window to confirm your modifications.

If you activate one or two Live Inputs for using external audio sources on the corresponding channel(s) of the Mixer, make sure to set the audio input routing accordingly, as explained in the next section.

You can also reset your Decks to some basic configurations by starting the Setup Wizard. Bear in mind, though, that the Setup Wizard additionally resets all TRAKTOR settings to their default values. For more info on the Setup Wizard, please refer to section 6.5, The Setup Wizard.

6.4.2 Adjusting the Input Routing

The audio interface of your TRAKTOR KONTROL S4 is perfectly tailored for use with the TRAKTOR software. Its audio inputs can be routed to the desired locations in TRAKTOR, according to your current setup and needs. You can do this in two ways: via the Setup Wizard or via the Preferences of TRAKTOR.
Using the Setup Wizard

When setting up TRAKTOR KONTROL S4, the easiest way is to start the Setup Wizard. This allows you to choose from a set of basic Deck configurations and to forget about any audio routing settings—these will be automatically configured according to the selected Deck configuration!

Bear in mind, though, that the Setup Wizard additionally resets all TRAKTOR settings to their default values. For more info on the Setup Wizard, please refer to section 6.5, The Setup Wizard.

Using the Preferences

In some circumstances, you might prefer to manually set the correct routing for incoming audio signals in TRAKTOR depending on your specific needs. This is notably the case in the following situations:

▪ You already customized TRAKTOR and don’t want to lose all your particular settings.
▪ Your desired configuration is not proposed by the Setup Wizard.

You can directly configure the audio routing options via the Input Routing page of the Preferences:
In this page, you can choose the physical inputs to be used for each virtual input channel in TRAKTOR.

For example, let’s say that you are currently using the default Deck configuration (two Track Decks and two Remix Decks) and want to use an external audio source plugged on channel D. Here is the way to go:

1. In Preferences > Decks > Deck Flavor, select Live Input in the D menu (as described in section ↑6.4.1, Switching the Deck Flavors above).
2. In Preferences > Input Routing > Input Channel D, select 3: In: Ch D left and 4: In: Ch D right in the L (Mono) and R menu, respectively:
3. Click **Close** at the bottom of the window to confirm your modifications.

→ Your external audio source is now sent to Deck D, which acts as Live Input and forwards the signal to channel D on the Mixer.

### 6.4.3 Using Four FX Units

TRAKTOR KONTROL S4 provides you with a total of four FX Units. By default, the first two FX Units are activated. You can activate the other two FX Units in the **Effects** page of the Preferences via the FX Unit Selector in the **FX Unit Routing** section:

![FX Unit Routing](image)

The FX Unit Selector in the FX Unit Routing section

► To activate all four FX Units, click **4 FX Units** in the FX Unit Selector.

#### 4-FX Routing Scheme

With the four FX Units 1-4 activated, channels are differently routed to the FX Units. Each channel and its dedicated Deck have their own FX Unit: FX Unit 1, 2, 3, and 4 are assigned to channel (and Deck) A, B, C, and D, respectively. This routing cannot be changed, only activated/deactivated.

**Controlling Four FX Units from your S4**

When the four FX Units 1-4 are activated in TRAKTOR, the **FX Units on your S4** follow the Deck focus of the Decks underneath:

- Depending on whether the left Deck focus is on Deck A or C, FX Unit 1 on your S4 is assigned to FX Unit 1 or 3 in TRAKTOR, respectively.

- Depending on whether the right Deck focus is on Deck B or D, FX Unit 2 on your S4 is assigned to the FX Unit 2 or 4 in TRAKTOR, respectively.

This way, each FX Unit on your S4 always controls the software FX Unit needed for the Deck in focus below.
Due to the different FX routing scheme, the **FX Assign buttons** work differently:

<table>
<thead>
<tr>
<th>FX Assign button</th>
<th>Function with four FX Units</th>
</tr>
</thead>
</table>
| FX Assign 1      | Channel A: Assigns the channel to FX Unit 1.  
                                    Channel B: unused.  
                                    Channel C: Assigns the channel to FX Unit 3.  
                                    Channel D: unused. |
| FX Assign 2      | Channel A: unused.  
                                    Channel B: Assigns the channel to FX Unit 2.  
                                    Channel C: unused.  
                                    Channel D: Assigns the channel to FX Unit 4. |

For more info on the FX Assign buttons, please refer to section ↑5.4.3, The Channels and the Crossfader.

Note that if you switched a Deck to Live Input, it cannot be focused from your S4 (see ↑5.3.1, Deck Flavors and Structure). Hence, with four FX Units activated, you cannot access the Live Input's dedicated FX Unit from your S4. Of course, you can still control this FX Unit in the software.

### 6.5 The Setup Wizard

The Setup Wizard lets you configure TRAKTOR in a few simple steps. It also is a convenient way to restart with a fresh out-of-the-box setup. The Setup Wizard does two things:

- It lets you choose from a few basic audio, MIDI, and general setup configurations and automatically sets the available options accordingly.
- It resets all other TRAKTOR settings to their default values.

You can start the Setup Wizard in two ways:
Select *Start Setup Wizard* in the *Help* menu of the Application Menu Bar (to see this bar, Fullscreen mode must be deactivated).

Or click the *Setup Wizard* button at the bottom left corner of the Preferences window.

**Setup Wizard Walk-through**

Let's walk you through the S4 configuration using the Setup Wizard:
1. On the welcome screen, click Next to confirm you have connected TRAKTOR KONTROL S4 to your computer via USB.
2. The Wizard asks whether you want to use TRAKTOR with a MIDI controller. Select No here as TRAKTOR is already pre-configured for use with the S4.
3. The Wizard asks whether you want to use an external DJ mixer in your setup. Select Yes and confirm with Next. In case of TRAKTOR SCRATCH PRO, this screen is skipped and external mixing is auto-selected.
4. Select a basic setup for your Decks (how many Decks and what Deck Flavors to use). Select **2 Track Decks + 2 Remix Decks** from the drop-down menu and confirm with **Next**.

![DECK LAYOUT SELECTION](image)

5. The last screen of the Setup Wizard sums up your selection of options: four Decks (two Track Decks and two Remix Decks); an external DJ mixer; your TRAKTOR KONTROL S4 controller; the keyboard layout (derived from the system settings). You can click **Back** to change the settings made, **Cancel** to cancel the Setup Wizard completely, or **Finish**, which confirms your selections.
→ TRAKTOR starts with the selected settings and a matching interface layout, e.g., if you selected to use an external DJ mixer, TRAKTOR's software mixer will be hidden. You can always change the Layout of the user interface with the Layout selection menu in TRAKTOR's header.

To change the Deck Flavors, click on the Deck letter in a Deck's upper right corner and select a Flavor from the drop-down menu:
7 The S4 Audio Interface and Control Panel

Your TRAKTOR KONTROL S4 is equipped with a high-end 24-bit/96 kHz audio interface. You can adjust the audio interface settings to your needs and computer performance.

Depending on whether you work on Windows or Mac OS X, you can adjust these settings in different ways.

7.1 Settings on Mac OS X

On Mac OS X, you can adjust the settings for the S4 audio interface from within each music application. In TRAKTOR:

► Open Preferences > Audio Setup to access the settings for the S4 audio interface.

There, you can adjust the audio interface settings of the TRAKTOR KONTROL S4. You have two settings:

- **Sample Rate**: Choose a sample rate that is compatible with your music application and suited to your computing power. A higher sample rate improves the audio quality, but also causes higher CPU load. Per default, the sample rate is set to 44100 Hz (CD quality).

  The sample rate defines how many samples are played/recorded per one second of sound. A higher sample rate results in higher audio quality; however, 44100 Hz (as used for recording audio CDs) is a common setting and absolutely sufficient for most tasks. If your final destination is CD you should use this setting or a multiple of it (88200 Hz). For a better understanding: 48000 Hz is used by DAT recorders, and for DVD (films) recording, 96000 Hz is typical for DVD, HD DVD, and Blue-ray Disc audio recording. You should be aware that a higher sample rate also causes higher CPU load.

- **Latency**: Lower the latency value for a quicker response of your computer to TRAKTOR controller and software actions.
When converting audio information to digital and vice versa, the audio driver needs to store the data in buffer packages (audio buffers) which are then sent to and processed by the CPU. The higher the buffer size, the longer it takes for a signal to finally arrive at the output as audio. You might experience this as late response in between hitting a key on a controller which controls music software on your computer, and hearing sound at the output. This delay is called latency. You should start off with a higher latency value, and gradually decrease it until you find the perfect balance between playability and audio quality for your system. If you experience crackling at the audio output, the latency value is very likely to be too low for your computer’s CPU to cope with, as lower latency values cause a higher load on the CPU.

7.2 Settings on Windows: The Control Panel

On Windows, the settings for the TRAKTOR KONTROL S4 audio interface are accessed via a little tool called Traktor Kontrol S4 Control Panel. The Control Panel was installed together with the drivers for your S4 controller during the TRAKTOR KONTROL S4 installation procedure.

This section describes the Traktor Kontrol S4 Control Panel user interface.

7.2.1 Opening the Control Panel

You can open the Control Panel in various ways:

► From within TRAKTOR: Go to Preferences > Audio Setup and click the Settings button, located at the right of the Latency slider and display:

![Audio Setup](image)

► From your desktop: Go to Start > Programs > Native Instruments > Traktor Kontrol S4 Driver > Traktor Kontrol S4 Control Panel.
If you cannot find the Control Panel, the driver is most likely not installed at all. In this case, please re-install the driver as described in the separate Setup Guide.

Here is what you get when opening the Control Panel:

The Control Panel

On the left side, you find two tabs: Audio Settings and Diagnostics.

► Click on the tabs at the left to open the corresponding page of the Control Panel.

7.2.2 Audio Settings Page

The Audio Settings page allows you to adjust the settings of the audio interface.
The Audio Settings page consists of two sections:

- **Audio Processing**: settings for the analog-to-digital/digital-to-analog conversion done by your audio interface.

- **Device Monitor**: displays information about the audio interface's processing status and your system's output latency.

### Audio Processing Section

The **Audio Processing** section holds two menus and one display:

- **Sample Rate**: Choose a sample rate that is compatible with your music application and suited to your computing power. A higher sample rate improves the audio quality, but also causes higher CPU load. By default, the sample rate is set to 44100 Hz (CD quality).

The sample rate defines how many samples are played/recorded per one second of sound. A higher sample rate results in higher audio quality; however, 44100 Hz (as used for recording audio CDs) is a common setting and absolutely sufficient for most tasks. If your final destination is CD you should use this setting or a multiple of it (88200 Hz). For a better understanding: 48000 Hz is used by DAT recorders, and for DVD (films) recording. 96000 Hz is typical for DVD, HD DVD, and Blue-ray Disc audio recording. You should be aware that a higher sample rate also causes higher CPU load.
- **Process Buffer**: Lower the buffer size value for a quicker response of your computer to TRAKTOR controller and software actions.

When converting audio information to digital and vice versa, the audio driver needs to store the data in buffer packages (audio buffers) which are then sent to and processed by the CPU. The higher the buffer size, the longer it takes for a signal to finally arrive at the output as audio. You might experience this as late response in between hitting a key on a controller which controls music software on your computer, and hearing sound at the output. This delay is called latency. A rule of thumb is: lower buffer size results in lower latency. However, there are more factors to latency than buffer size alone (e.g., CPU speed and RAM size). You should start off with a higher buffer size setting, and gradually decrease the value until you find the perfect balance between playability and audio quality for your system. If you experience crackling at the audio output, the buffer size is very likely to be too low for your computer’s CPU to cope with, as lower buffer size causes higher CPU load.

- **USB Buffer**: Use this menu in case you cannot achieve satisfactory Latency settings with the Process Buffer menu. Lower the USB buffer size for smaller USB buffer packaging, which should further reduce the audible latency. If you notice any audio interruptions, you should raise the buffer size until you have a clear sound, free of dropouts.

**Device Monitor Section**

The **Device Monitor** section holds two displays:

- **Processing State**: The processing state monitor provides feedback on the current status of the device. There are three possible status messages:
  - **Idle**: controller is connected, but no audio data is being streamed.
  - **Streaming**: driver is working and processing audio data.
  - **Panic**: driver stopped streaming. Too many USB I/O errors occurred in the interface communication.

- **Output Latency**: displays your system’s output latency in milliseconds.

Notice there is also an input latency when working with the TRAKTOR KONTROL S4. The output latency value does not represent the overall latency, from pressing a button on the controller to hearing the resulting effect at the output. The overall latency is about twice as long as the output latency.
7.2.3 Diagnostics Page

The Diagnostics page allows for monitoring the controller’s performance and for detecting errors.

The Control Panel with Diagnostics page opened

The information provided in the Diagnostics page might be more of interest to advanced users; however, in case of problems, you should always have a look at this page.

The Diagnostics page consists of three sections:

- **Drop-Out Detection**: displays USB I/O errors and buffer underruns when detected.
- **Connection Monitor**: displays client-to-driver connections and USB data errors when detected.
- **Information**: displays information on driver and firmware version. There is also a link to the Troubleshooting Guide here.
Drop-Out Detection Section

The Drop-Out Detection section holds two displays and a button:

- **USB I/O Errors**: counts USB input/output errors. A high USB I/O Errors count points to your system being overloaded.
- **Buffer Underruns**: Buffer underruns occur when your computer isn’t able to process an audio buffer in time. Reasons for underruns can be too many ongoing background tasks or high CPU usage within a music program that uses the device as audio driver.
- **Reset**: A click on this button resets the error count.

Connection Monitor Section

The Connection Monitor section holds two displays and a button:

- **Number of Clients**: displays the number of clients connected to the interface. Multiple ASIO applications are counted separately, WDM and WASAPI increase the number by one, no matter how many WDM/WASAPI applications play audio.
- **USB Data Errors**: counts USB data errors. Poor quality or long cables as well as irradiation can be the source of data errors on the USB bus.
- **Reset**: A click on this button resets the error count.

Information Section

The Information section holds two displays and a button:

- **Driver Version**: See the currently installed driver version here.
- **Firmware Version**: See the currently installed firmware version here.
- **Troubleshooting Guide**: Click Show to open the Troubleshooting Guide.

### 7.3 Using the S4 Audio Interface with Other Music Applications

The use of the S4’s on-board audio interface is not limited to the TRAKTOR KONTROL S4 system: you can use it with any other music applications installed on your computer. To do this, you need to configure your music applications accordingly: most of the time, you will find a
setting in the options or preferences of your music applications allowing you to select the TRAKTOR KONTROL S4 as audio interface. For more info, please refer to the documentation of your music applications.

### 7.4 Using the S4 as your Default Audio Interface

If you want to use the TRAKTOR KONTROL S4 for playback of all audio applications on your computer (not only for music software), you have to set it as your default audio interface.

#### 7.4.1 Windows XP

For Windows XP, you can define the TRAKTOR KONTROL S4 as your default audio interface as follows:

2. Select the `Audio` tab.
3. In the `Sound playback` and `Sound recording` sections, click the `Default Device` menu, and then select `Traktor Kontrol S4`.
4. Click `OK` to close the Sounds and Audio Devices dialog.

#### 7.4.2 Windows Vista and 7

For Windows Vista and 7, you can define the TRAKTOR KONTROL S4 as your default audio interface as follows:

1. Open `Start > Control Panel > Hardware and Sound > Sound`.
2. Select the `Playback` tab.
3. In the device list, select `Traktor Kontrol S4` and click `Set Default`.
4. Select the `Recording` tab.
5. In the device list, select `Traktor Kontrol S4` and click `Set Default`.
6. Click `OK` to close the dialog.

#### 7.4.3 Mac OS X

For Mac OS X, you can define the TRAKTOR KONTROL S4 as your default audio interface as follows:
1. From the Apple menu, select System Preferences.
2. In the panel that opens, click Sound.
3. On the Sound Effects tab, select Traktor Kontrol S4 in the Play alerts and sound effects through menu.
4. Click the Output tab, and select Traktor Kontrol S4 from the Choose a device for sound output list.
5. Click the Input tab, and select Traktor Kontrol S4 from the Choose a device for sound input list.
6. Close the window to confirm your changes.
8  Troubleshooting and Help

This chapter covers the most common issues. Most of what can go wrong when setting up and using TRAKTOR KONTROL S4 should be listed here along with some tried-and-tested ways to solve these issues.

8.1  TRAKTOR Won’t Start

1. Check the system requirements for TRAKTOR KONTROL S4. The minimum requirements are the very least you can get by with, and are often not enough for advanced use (i.e. Keylock, FX). Increasing your RAM may save you a lot of trouble.
2. Make sure you have the most recent TRAKTOR version installed.
3. Make sure that you have not clicked an outdated application alias/shortcut.
4. Try to restart your computer. Disconnect any other audio interfaces and computer peripherals like printers, scanners, and the like.
5. Try to rename the file collection.nml in the TRAKTOR 2 Root folder to restart TRAKTOR with a clean Collection, and then re-import the renamed Collection. For more info on the Root folder, please refer to the TRAKTOR 2 Manual.

8.2  Hardware-related Problems

This section lists the points that you shall check when something seems to be wrong with your TRAKTOR KONTROL S4 controller.

8.2.1  Basics

This might sound obvious, but the first things to check are following:

- Make sure that the TRAKTOR KONTROL S4 is connected to the computer via the included USB cable.
- Check that the controller is turned on (ON/OFF switch on the rear panel must be engaged).
8.2.2 USB and Driver Issues

Once your TRAKTOR KONTROL S4 is connected and turned on, wait a few seconds and give a look at the USB indicator located in the Master Display, in the middle of your device:

![USB indicator in the Master Display](image)

If the USB indicator is flashing, there is no connection to the computer or there is a problem with the driver. Please check the following points:

- The TRAKTOR KONTROL S4 is a USB 2.0 device and will not work on a USB 1.0/1.1 port.
- A bad USB cable can be responsible for connectivity problems. Try using a different cable bearing the official USB logo, in some cases using a shorter cable might help.
- Check that the driver is correctly installed. You can do this for example by looking for the TRAKTOR KONTROL S4 Control Panel (see ↑7.2.1, Opening the Control Panel for more info). If you cannot find the Control Panel, the driver is most likely not installed at all. In this case, please re-install the driver from the TRAKTOR KONTROL S4 installation disc as described in the separate Setup Guide.

**Driver Installation Note in Windows**

As any other USB device, the driver installs exactly for one USB port. If you connect the TRAKTOR KONTROL S4 to another port, a standard Windows dialog opens in which you can install the driver to that port.

- If you have previously installed the driver on your computer once, Windows will find the right drivers itself.
- If you did not install the drivers on your computer, Windows will install the wrong drivers. Please disconnect the TRAKTOR KONTROL S4 and follow the installation procedure described in the separate Setup Guide.
8.2.3 Update the Driver

Check NI Service Center regularly for driver updates.

8.2.4 USB-related Power Issues

We strongly recommend you to use an external power supply with your S4 via the included power supply unit. Although operation is also possible when your S4 is powered via the USB connection, you then have following limitations: the headphones output level is lower, and all LEDs light darker.

If for any reason you cannot make use of any external power supply, you should check the following points:

- The port needs to fulfill the minimum power specification for a USB 2.0 port (500 mA). On certain computers, the USB 2.0 ports do not meet the official USB 2.0 power specification. In this case, you may see a message, saying that there is not enough power available to operate your device. The TRAKTOR KONTROL S4 may produce crackles or may not work at all.

- In case of failures, it is useful to check if TRAKTOR KONTROL S4 works if you disconnect any other USB device from the computer.

- If your computer is unable to supply the necessary amount of bus power, try connecting your TRAKTOR KONTROL S4 to a USB 2.0 hub with external power supply. Avoid connecting other devices to the hub, as each bus-powered device takes its share from the total amount of power available.

Once again, the best way to avoid any power-related issue with your S4 is to connect the included external power supply unit!
8.2.5 Using the TRAKTOR KONTROL S4 with a Laptop

Please check if your computer is suited for handling real-time audio processing without drop-outs. The TRAKTOR KONTROL S4 Control Panel provides you with a useful tool to achieve this. See chapter ↑7.2.2, Audio Settings Page for more info.

In general, it is not recommended to use laptops with shared-memory graphic cards. You will need all the memory and processing power available for your audio software.

There are some steps to optimize your laptop’s audio performance:

- It is not recommended to run the laptop on battery, as power management might slow the clock rate of the CPU down, to save battery.
- Disconnect all unused hardware (e.g. printer, scanner). This will increase the amount of processing power available for your music software.
- Laptops often are equipped with built-in devices that disturb audio processing, most commonly a network adapter or a wireless LAN card. You might need to disable these devices while working with the TRAKTOR KONTROL S4.

8.3 Loose Jog Wheel Top Plate

The flat, round, push-sensitive surface of the jog wheels on your TKS4 was designed to be easily replaceable. Due to heavy shocks or extreme vibration during travelling, in some rare cases a jog wheel top plate might become loose or detached from the controller.

It can easily be reattached to the base of the jog wheel. To do this:

1. Align the connector pins on the bottom of the top plate with the corresponding clips on the jog wheel base.
2. Hold the rubber rim of the wheel steady with one hand.
3. Use the other hand to push the plate down into the round central area of the jog wheel and twist the plate around to the left (anti-clockwise) until the pins click back into the clips on the base (you may hear a clicking sound).
Once the plate has clicked back into place, it should be securely fastened to the unit. If it is still loose, try running through the procedure again. Although it may not be necessary for optimum use, we recommend recalibrating your jog wheels after detaching and reattaching the jog wheel top plate. For further details on jog wheel calibration, please refer to the separate Jog Wheel Calibration Guide in the TRAKTOR 2 documentation folder.

### 8.4 TRAKTOR Crashes

In case of a crash during runtime, please contact the Native Instruments technical support team and send them your crash log. You will find the crashlog in the following folders:

- Windows: `\My Documents\Native Instruments\Traktor 2\Crashlogs`
- Mac OS X: `Users/~/Library/Logs/CrashReporter/`

### 8.5 Getting Help

#### 8.5.1 Knowledge Base / Readme / Online Support

Open the Service Center application and click on the Support button in the upper right corner. Here you will find direct links to the Native Instruments Online Knowledge Base and the Online Support Form.

The Online Knowledge Base gathers useful information about your Native Instruments product and can be of great help to solve possible issues you may encounter when working with Native Instruments products.

If no Knowledge Base entry matches your problem, or if the matching entry does not solve the problem, you can use the Online Support Form to contact the Technical Support team with Native Instruments. The Online Support Form will ask you to enter information about your hardware and software setup. This information is essential for our support team to be able to provide you with quality assistance.
When communicating with the Native Instruments support team, keep in mind that the more details you can provide about your hardware, your operating system, the version of the software you are running, and the problem you are experiencing, the better they will be able to help you. In your description, you should mention:

- How to reproduce the problem
- What you have already tried to fix the problem
- A description of your setup, including all hardware
- The brand and specifications of your computer

When installing new software or software updates, a Readme file is included that contains late breaking news and new information that was not yet included in the documentation. Please open and read this Readme file before contacting Technical Support.

8.5.2 Forum

In the Native Instruments User Forum you can discuss product features directly with other users and with experts moderating the forum.

http://www.native-instruments.com/forum

8.6 Updates

Whenever you encounter problems, it is recommended that you first download and install any available software updates. Updates are released regularly to fix known problems and to continuously improve the software. The version number of your software is displayed in the About dialog for any Native Instruments application. This dialog can be opened by clicking on the NI logo in the upper right corner of the user interface. Alternatively, you can find the version numbers of all installed Native Instruments applications when showing the details for an application within the Overview page of the Service Center. Updates are available on the Update page in Service Center or on our website under:

http://www.native-instruments.com/updates
This appendix shows you how to connect your TRAKTOR KONTROL S4 with your other gears in various setups.

For a reference of each socket or control element to be found on the rear and front panel of the TRAKTOR KONTROL S4, please refer to section ↑5.8, The Rear Panel and ↑5.9, The Front Panel, respectively.

It goes without saying that all setups require that TRAKTOR KONTROL S4 was correctly installed on your computer beforehand! For more info on the installation procedure, please refer to the separate Setup Guide.

We will first describe the most basic setup. Then, we will show you some interesting add-ons.

### 9.1 TRAKTOR KONTROL S4 Basic Setup

This setup is the most common. It is also described in the Setup Guide and used in most of the tutorials.

Let’s start with the fundamentals: the S4, your computer, your headphones, and an amplification system.
Connect the Power Supply

1. Connect the included power supply to a power outlet using the appropriate adapter for your region.
2. Connect the power cord plug to the Power Supply connector (labeled POWER) on the rear panel of your S4.

We strongly recommend you to use an external power supply with your S4 via the included power supply unit. Although operation is also possible when your S4 is powered via the USB connection, you then have following limitations: the headphones output level is lower, and all LEDs light darker. Moreover, your device might then be subject to USB power-related issues, as explained in section 8.2.4, USB-related Power Issues.
**Connect the S4 to Your Computer via USB**

Before connecting the controller to your computer, make sure it is in a stable playing position. Turning the controller on its head while it is connected to your computer can cause decalibration of the jog wheels, which is indicated by constantly flashing Load buttons. Placing the device back in the upright position and switching it on and off will reset the jog wheels to the correct state. In the unlikely event that the jog wheels still do not respond as expected after power cycling, recalibrating the jog wheels manually might become necessary. For further info on calibration, please refer to the separate Jog Wheel Calibration Guide in the Documentation subfolder of the TRAKTOR 2 program folder.
Connect one end of the included USB 2.0 cable to the USB socket on the rear panel of your S4, and the other end to an available USB 2.0 port on your computer.

The TRAKTOR KONTROL S4 is a USB 2.0 device and will not work on a USB 1.0/1.1 port.

If possible, do always use the USB cable provided with the S2 box to operate your unit. Longer or lower quality USB cables may not transfer sufficient power to the S2, which may lead to performance issues. For proper operation, it is also advised to always connect the power supply.
**Turn Down All Volume Controls**

Before you plug any audio cable, make sure to turn down all volume controls, both on your S4 and on your amplification system. This will avoid any possible audio artifacts that could damage your speakers and your ears!
Connect the Main Outputs to Your Amplification System

On the rear panel of your S4, connect the Main Output 1/2's 1/4" sockets (balanced) or the RCA sockets (unbalanced) to your amplification system, depending on the type of inputs supported by your amplifier or active speakers.
Connect your Headphones to the PHONES Socket (Front Panel)

► On the front panel of your S4, plug your headphones into the Headphones socket (PHONES).

⚠️ Before putting on headphones, always make sure the headphone volume knob (CUE VOL) is set to minimum! To set the headphone volume to minimum, turn the CUE VOL knob counter-clockwise until it reaches its end stop. Then, while playing music, slowly increase the headphone volume by turning the CUE VOL knob clockwise until it reaches the desired listening level.
Turn On Your S4

- On the rear panel of your S4, engage the ON/OFF switch to turn on the device.

→ Look at the top panel of your controller: after a quick LED animation, the USB indicator in the Master Display might flash for a few seconds, then it should stay lit. This confirms that your S4 is correctly recognized by your computer.

If the USB indicator stays flashing, there is a problem with your USB connection and/or driver. Please refer to section 18.2, Hardware-related Problems for more info on how to solve this issue.

Start TRAKTOR

Start the TRAKTOR software, for example by double-clicking on its alias/shortcut on your desktop. The TRAKTOR window opens up.
Set the Deck Flavors in TRAKTOR

Instead of setting the Deck Flavor manually as described here, you can also use the Setup Wizard: choose *2 Track Decks + 2 Remix Decks* in the menu, click *Finish*, and let the Wizard set everything for you. Bear in mind, though, that the Setup Wizard additionally resets all TRAKTOR settings to their default values. For more info on the Setup Wizard, please refer to section 6.5, *The Setup Wizard*.

In the TRAKTOR software, we set the lower Decks C and D to Remix Decks:

1. Open the Preferences window by clicking on the Preferences button in TRAKTOR’s Header:

2. Go to *Preferences > Decks > Deck Flavor* and select *Remix Deck* in the C and D menus:

3. Click *Close* at the bottom of the Preferences window to confirm your modifications.

Notes

- The MAIN LEVEL knob and meters at the top middle of your S4’s top panel allow you to adjust and monitor the overall output level:
The CUE VOL and CUE MIX knobs on the S4 front panel respectively control the volume and the mix between the cued signal and the master signal in your headphones:

### 9.2 Adding a Microphone

Starting from the basic setup, we add here a microphone and show you how to use it on the Aux channel of TRAKTOR.

Before you proceed, please follow the steps for the basic setup described in section 9.1, TRAKTOR KONTROL S4 Basic Setup.

#### Connect Your Microphone to the MIC Socket

The MIC socket and its dedicated GAIN knob

On the rear panel of your S4, plug your microphone into the Microphone socket (MIC) located in the INPUT CHANNEL D section.

Before you connect your microphone, make sure that the GAIN knob next to the MIC socket is turned fully down!
Set the THRU/USB Switch to USB

Set the THRU/USB switch to USB.

On that same INPUT CHANNEL D, set the THRU/USB switch to USB to ensure that the microphone signal is routed through TRAKTOR.

Set the Input Routing in TRAKTOR and Adjust the Microphone Input Level

If you have configured the basic setup via the Setup Wizard, the audio input routing is already set for your microphone and you can skip this section.

Otherwise, set the input routing as follows:

1. Open the Preferences window by clicking on the Preferences button in TRAKTOR’s Header:

2. Go to Preferences > Input Routing > Input Aux and select 3: In: Ch D left and 4: In: Ch D right in the L (Mono) and R menu, respectively:

3. While keeping an eye on the small level meters to the right of the L (Mono) and R menus, sing something in your microphone at the loudness at which you will sing during your performance, and adjust the Microphone Gain knob (GAIN) located next to the Microphone socket (MIC) on your S4 until the level meters on your screen show a satisfying level (to adjust the microphone input gain, you can follow the guidelines described in section ↑4.3, Adjusting Levels).
4. When the meters show a satisfying level, click Close at the bottom of the Preferences window to confirm your modifications.

For more info on the input routing, see section ↑6.4.2, Adjusting the Input Routing.

Once the microphone input gain is set, don’t touch this GAIN knob anymore. To control the volume of your microphone within your mix, use the MIC VOL knob on the S4’s front panel instead (see below).

Notes

Your microphone signal is now sent to the Aux channel in TRAKTOR. This has following interesting consequences:

- The volume of the microphone is controlled by the MIC VOL knob on the front panel of your S4:

![MIC VOL knob](image)

- You can also control the microphone volume via the AUX knob at the right of the crossfader in TRAKTOR:

![AUX knob in TRAKTOR](image)

- You can select the microphone signal for use in the Loop Recorder by choosing Aux in the Loop Recorder’s Source menu:

![Loop Recorder menu](image)
- By having assigned the microphone signal to the Aux channel, you still have four internal Decks at your disposal (Track Decks or Remix Decks).

## 9.3 Using a Master Mixer

In some situations, you might want to use other audio devices independently from the TRAKTOR KONTROL S4 system, like an additional setup with turntables and mixer. A solution consists in using this other mixer as master mixer. This mixer will receive the mix coming from TRAKTOR KONTROL S4 and thus act as middleman on the way to your amplification system. Starting from the basic setup, you only need to change the connections at the Main Outputs of your S4.

Before you proceed, please follow the steps for the basic setup described in section 9.1, TRAKTOR KONTROL S4 Basic Setup.

### Connect the Main Outputs of the S4 to Available Inputs on Your Master Mixer

- On the rear panel of your S4, unplug the cables connecting the Main Outputs of your S4 to your amplification system, and connect the Main Outputs 1/2 1/4" (balanced) or RCA (unbalanced) sockets to an available stereo input channel on your master mixer, depending on the type of inputs supported by your master mixer.

On the master mixer, make sure that the input channel receiving the TRAKTOR KONTROL S4 signal is set to line level.

### Connect the Outputs of Your Master Mixer to Your Amplification System

- Don’t forget to connect the outputs of your master mixer to your amplification system and make the necessary level adjustments on your master mixer.

## 9.4 TRAKTOR KONTROL S4 with Turntables or CD Decks

With this setup, you can plug turntables or CD decks (or any other line level source) to the two stereo inputs available on your TRAKTOR KONTROL S4 and use them in your mix on two different channels.
Control via timecode vinyls/CDs (Scratch Control) is not available in TRAKTOR KONTROL S4 yet.

► Starting from the basic setup, we will connect the audio sources to both stereo input channels on your S4 and configure the required settings accordingly.

Before you proceed, please follow the steps for the basic setup described in section ↑9.1, TRAKTOR KONTROL S4 Basic Setup.

### Connect Your Turntables or CD Decks to the IN 1/2 and IN 3/4 Sockets

Plug your external CD Deck(s) or turntable(s) into the IN 1/2 and IN 3/4 sockets.

► In the INPUT CHANNEL C and D sections, plug your turntable or CD deck to the IN 1/2 and IN 3/4 RCA sockets, respectively.

### Set the Input Level on Each Channel Accordingly

► In the INPUT CHANNEL C and D sections, set the LINE/PHONO switch to PHONO for a turntable, and LINE for a CD deck or any other line level source (see picture above).
**Turntables Only: Connect the Earth Lead(s)**

![Image of Ground terminal screw]

When using turntables, attach their earth leads to the Ground terminal screw on the rear panel of your S4.

**Set the THRU/USB Switch to USB**

![Image of THRU to USB switch]

On the INPUT CHANNEL D, set the THRU/USB switch to USB to route the audio source to TRAKTOR.

⚠️ You cannot use a microphone together with another audio source plugged in the INPUT CHANNEL D. Since we want to use an audio source connected to the Inputs 3 and 4 of this channel, we need to unplug any connected microphone.
Set the Input Routing and Deck Flavors in TRAKTOR

Instead of setting the input routing options and Deck Flavors manually as described here, you can also use the Setup Wizard: choose **2 Track Decks + 2 Live Inputs** in the menu, click **Finish**, and let the Wizard set everything for you. Bear in mind, though, that the Setup Wizard additionally resets all TRAKTOR settings to their default values. For more info on the Setup Wizard, please refer to section ↑6.5, The Setup Wizard.

In the TRAKTOR software, we need to route the inputs of your S4 to the virtual input channels C and D, and to set the lower Decks C and D to Live Input:

1. Open the Preferences window by clicking on the Preferences button in TRAKTOR’s Header:

2. Go to **Preferences > Input Routing > Input Channel C** and select **1: In: Ch C left** and **2: In: Ch C right** in the L (Mono) and R menus, respectively:

3. Go to **Preferences > Input Routing > Input Channel D** and select **3: In: Ch D left** and **4: In: Ch D right** in the L (Mono) and R menus, respectively:

4. Go to **Preferences > Decks > Deck Flavor** and select **Live Input** in the C and D menus.
5. Click **Close** at the bottom of the Preferences window to confirm your modifications.

→ Deck C and D will now transmit the signals coming from your external audio sources to channel C and D on the Mixer, respectively.

For more info on the input routing, see section ↑6.4.2, Adjusting the Input Routing
9.5 TRAKTOR KONTROL S4 with Slave Mixer

This setup makes use of the Thru mode available on the INPUT CHANNEL D of your TRAKTOR KONTROL S4.

The Thru mode allows you to plug any audio source into the INPUT CHANNEL D and directly forward it to the Main Outputs. This can be useful, for example, if you want to use an additional analog mixing system (turntables and mixer) whose mixer does not have enough inputs to act as a master mixer (see section 9.3, Using a Master Mixer above).

Starting from the basic setup, we will connect the audio source to the INPUT CHANNEL D on your S4 and configure the required settings accordingly.

Before you proceed, please follow the steps for the basic setup described in section 9.1, TRAKTOR KONTROL S4 Basic Setup.

Connect Your Slave Mixer to the IN 3/4 Sockets

Plug your slave mixer into the IN 3/4 sockets and set the level to LINE.

On the rear panel of your S4, plug the main outputs of your slave mixer into the IN 3/4 RCA sockets of the INPUT CHANNEL D, and set the LINE/PHONO switch nearby to LINE.
Set the THRU/USB Switch to THRU

Set the THRU/USB switch to THRU.

On the INPUT CHANNEL D, set the THRU/USB switch to THRU to route the slave mixer directly to the Main Outputs of the S4.

⚠️ You cannot use a microphone together with another audio source plugged in the INPUT CHANNEL D. Since we want to use an audio source connected to the Inputs 3 and 4 of this channel, we need to unplug any connected microphone.

Adjust the Source Input Level

To adjust the input level of the source before it is sent to the Main Outputs, do the following:

1. From your audio source (e.g. slave mixer), send some audio at the maximum volume that you plan to use during your performance.
2. Adjust the Thru Gain knob (GAIN) located next to the THRU/USB switch on your S4 (see picture above).
10 Appendix B – Technical Information

You will find here the technical specifications and the block diagram for the audio interface of your TRAKTOR KONTROL S4.

10.1 Technical Specifications

Jacks and Sockets

- 4 input jacks (IN 1/2 and IN 3/4) for mono RCA plugs
- 1 input jack (MIC) for mono 6.3 mm (1/4 inch) phone plug
- 2 output jacks (MAIN OUT 1/2) for 6.3 mm (1/4 inch) TRS (balanced) phone plugs
- 2 output jacks (MAIN OUT 1/2) for mono (unbalanced) RCA plugs
- 1 headphones jack for stereo 6.3 mm (1/4 inch) phone plug
- 1 external footswitch input jack for 6.3 mm (1/4 inch) TRS phone plug
- 2 MIDI (IN/OUT) 5-pin DIN circular connectors
- 1 ground terminal screw
- 1 Kensington lock slot
- 1 USB 2.0 Type B
- 1 power supply connector

Audio Specifications

<table>
<thead>
<tr>
<th>Audio Inputs (A/D)</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Channels</td>
<td>4</td>
</tr>
<tr>
<td>Sample rate</td>
<td>44.1, 48, 88.2, 96 kHz</td>
</tr>
<tr>
<td>Bit resolution</td>
<td>16, 24</td>
</tr>
<tr>
<td>Converter</td>
<td>Cirrus Logic</td>
</tr>
<tr>
<td>Line Inputs</td>
<td></td>
</tr>
<tr>
<td>--------------------------</td>
<td>--------</td>
</tr>
<tr>
<td>Input impedance</td>
<td>47 kΩ</td>
</tr>
<tr>
<td>Cross talk</td>
<td>-83 dBu</td>
</tr>
<tr>
<td>Full scale level</td>
<td>16 dBu</td>
</tr>
<tr>
<td>SNR (weighted)</td>
<td>98.5 dBu</td>
</tr>
<tr>
<td>THD+N</td>
<td>0.01 %</td>
</tr>
<tr>
<td>Frequency response ±1 dBu</td>
<td>20 Hz – 40 kHz</td>
</tr>
<tr>
<td>Dynamic range codec</td>
<td>105 dBu</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Microphone Input</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Input impedance</td>
<td>5.2 kΩ</td>
</tr>
<tr>
<td>Full scale level @ 1 kHz</td>
<td>-32 dBu</td>
</tr>
<tr>
<td>SNR (weighted) @ 1 kHz</td>
<td>92 dBu</td>
</tr>
<tr>
<td>THD+N @ 1 kHz</td>
<td>0.01 %</td>
</tr>
<tr>
<td>Frequency response ±1 dBu</td>
<td>20 Hz – 40 kHz</td>
</tr>
<tr>
<td>Dynamic range codec</td>
<td>105 dBu</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Phono Inputs</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Input impedance</td>
<td>47 kΩ</td>
</tr>
<tr>
<td>Full scale level @ 1 kHz</td>
<td>-19 dBu</td>
</tr>
<tr>
<td>SNR (weighted) @ 1 kHz</td>
<td>85.5 dBu</td>
</tr>
<tr>
<td>THD+N @ 1 kHz</td>
<td>0.026 %</td>
</tr>
</tbody>
</table>
Audio Outputs (D/A)

<table>
<thead>
<tr>
<th>Channels</th>
<th>4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample rate</td>
<td>44.1, 48, 88.2, 96 kHz</td>
</tr>
<tr>
<td>Bit resolution</td>
<td>16, 24</td>
</tr>
<tr>
<td>Converter</td>
<td>Cirrus Logic</td>
</tr>
</tbody>
</table>

Line Outputs

| Output impedance (1/4" balanced / RCA unbalanced) | 164 Ω / 82 Ω |
| Max output level                                  | 13 dBu       |
| SNR (weighted)                                    | 99.5 dBu     |
| THD+N                                              | 0.01 %       |
| Frequency response ±1 dBu                         | 20 Hz – 40 kHz |
| Dynamic range codec                               | 105 dBu      |

Headphones Outputs

| Load impedance | 16 Ω – 600 Ω |
| Max output level (100 Ω load)                     | 7 dBu        |
| SNR (weighted) under load condition                | 93 dBu       |
| THD+N                                                 | 0.02 %       |
| Frequency response ±1 dBu                          | 20 Hz – 40 kHz |

Power Supply

- In: 100-240V - 60/50Hz - 0.4A
- Out: 9V 1200mA 10.8VA

Dimensions and Weight

- Depth: 32.2cm / 12.7"
- Height: 5.2cm / 2"
- Width: 50cm / 19.7"
- Weight: 3.4kg / 7.5lbs

**Environmental Specifications**

- **Operating temperature**: +5 to +35 °C (41 to 95 °F), max 85% non-condensing humidity
- **Storage temperature**: 0 to 40 °C (32 to 104 °F), max 85% non-condensing humidity

⚠️ Do not install this unit in locations exposed to high humidity or direct sunlight.
10.2 Block Diagram

TRAKTOR KONTROL S4’s audio inputs/outputs block diagram

On this diagram, wires carry stereo signals.
11 Appendix C – Quick References

This appendix provides you with you Quick Reference tables summing up the basic functionality of each control element on your TRAKTOR KONTROL S4. This gives you a quick and concise overview of all basic functions of your controller. For more info on each control element, please refer to the descriptions in chapter 5, Hardware Reference.

11.1 Track Deck Quick Reference

Deck controls for when the Deck in focus is a Track Deck.

See section 5.3, The Decks for more details on these control elements.

<table>
<thead>
<tr>
<th>Control element</th>
<th>Function</th>
</tr>
</thead>
</table>
| DECK C or DECK D button         | Normal: switches the focus of your S4 Deck between upper and lower Deck in TRAKTOR. Lit when lower Deck focused.  
|                                 | SHIFT: switches the Layout in TRAKTOR.                                   |
| LOAD button                     | Normal: loads selected track on the Deck when using Quick Loading.      
|                                 | SHIFT: unloads the track from the Deck (i.e. it clears the Deck).        
|                                 | Lights up when you press the jog wheel’s top plate.                    |
| Jog wheel                       | Outer rim: tempo bending.                                               
|                                 | Top plate: scratch control (direct control on playback position).        
|                                 | SHIFT + top plate: seek through track (fast forward / rewind).           
<p>|                                 | In Loop: hold LOOP IN / LOOP OUT and spin the jog wheel to fine-tune the Loop In Point / Loop Out Point. |
| ON AIR indicator                | Lit when the focused Deck is audible on the TRAKTOR KONTROL S4 main outputs. |
| SAMPLES indicator               | Lit when the lower Deck is a Remix Deck.                                |
| DECK A or DECK B indicator      | Lit when your S4 Deck is focused on the upper Deck (Deck A or Deck B).  |</p>
<table>
<thead>
<tr>
<th>Control element</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>DECK C or DECK D indicator</td>
<td>Lit when your S4 Deck is focused on the lower Deck (Deck C or Deck D).</td>
</tr>
<tr>
<td>KEYLOCK indicator</td>
<td>Lit when Keylock is active.</td>
</tr>
<tr>
<td>MASTER indicator</td>
<td>Lit when the Deck is the tempo master.</td>
</tr>
<tr>
<td>Loop Size Display</td>
<td>Shows the loop size selected via the LOOP SIZE encoder.</td>
</tr>
<tr>
<td>TEMPO fader</td>
<td>Increases/decreases Deck tempo. Hold SHIFT to move the fader without altering the tempo.</td>
</tr>
<tr>
<td>Tempo Offset buttons up/down</td>
<td>Lit button indicates offset between tempo fader in the software and TEMPO fader on the S4. Pressing either button resets the tempo to the TEMPO fader position.</td>
</tr>
<tr>
<td>(OFFSET)</td>
<td>Press both buttons simultaneously to lock the tempo to 0 % (the TEMPO fader is then disabled). Both buttons light up to indicate the tempo locking.</td>
</tr>
<tr>
<td></td>
<td>Press either button to unlock the tempo.</td>
</tr>
<tr>
<td></td>
<td>Both buttons light up dimmed when the TEMPO fader is near 0 %.</td>
</tr>
<tr>
<td>LOOP IN button</td>
<td>Sets a Floating Cue Point at current playback position without stopping the playback. This Floating Cue Point will serve as Loop In Point when you press the LOOP OUT button (see below).</td>
</tr>
<tr>
<td></td>
<td>Lights up together with LOOP OUT when playback is within an active Loop. In Loop: Hold to adjust Loop In Point with jog wheel.</td>
</tr>
<tr>
<td>LOOP OUT button</td>
<td>Sets a Loop Out Point at current playback position and activates a Floating Loop between the previously set Floating Cue Point and this Loop Out Point.</td>
</tr>
<tr>
<td></td>
<td>Looping active: Lights up together with LOOP IN when playback is within the active Loop, lights up alone when playback is outside the active Loop.</td>
</tr>
<tr>
<td></td>
<td>In Loop: Hold to adjust Loop Out Point with jog wheel.</td>
</tr>
<tr>
<td>LOOP MOVE encoder</td>
<td>Push: activates/deactivates looping.</td>
</tr>
<tr>
<td></td>
<td>Loop active: Loop move controls. Turn to move the Loop by the selected loop size (as displayed in the Loop Size Display). SHIFT + turn to move the Loop by 1-beat steps.</td>
</tr>
<tr>
<td></td>
<td>No Loop active: Beatjump controls. Turn to jump by the selected loop size (as displayed in the Loop Size Display). SHIFT + Turn to jump by 1-beat steps.</td>
</tr>
<tr>
<td>Control element</td>
<td>Function</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| LOOP SIZE encoder    | Push: activates/deactivates looping. Activating looping automatically sets a Floating Loop at current playback position with the selected loop size.  

Turn (no active Loop): selects a loop size (in beats) for the next Floating Loop that will be set. The selected loop size is displayed in the Loop Size Display above.  

Turn (Loop active): halves/doubles the size of the current Loop.                                                                                   |
| Sample Play buttons  | Unlit: empty slot. Press to export a Sample from the track loaded on that Deck at current playback position (if playback is within an active Loop, the Loop is copied). The Sample is loaded in Looped mode and with the same playback state as the track (muted if playing). Press SHIFT + button to load the Sample selected in the Playlist.  

Dimmed: Sample loaded but stopped or muted.  

Lit: Sample playing.  

Sample in Looped mode: Press to start/mute/unmute the Sample. Press and hold for one second to stop playback and reset it to start position.  

Sample in One-shot mode: Press to start playback. Press again to stop playback and reset it to start position.  

SHIFT + dimmed/lit button: unloads Sample from Sample Slot (button turns back off).                                                                 |
| Hotcue buttons 1-4    | Unlit: empty slot. Press outside any active Loop to store a Cue Point at current playback position. Press within an active Loop to store this Loop.  

LED color: blue for Cue Point, green for Loop.  

Lit: When the Deck is playing, press to jump to that Cue Point / Loop. When the Deck is stopped, press & hold to trigger the playback from that point. Upon release, playback stops and skips back to that point.  

SHIFT + lit button: deletes Cue Point / Loop stored in Hotcue slot (button turns back off).                                                                                                                |
| PLAY button           | Starts/stops playback. Button lights up when playing.  

SHIFT + PLAY: activates/deactivates Keylock (KEYLOCK indicator lights up in the Deck Display).                                                                                                                      |
### 11.2  Remix Deck Quick Reference

Deck controls for when the Deck in focus is a Remix Deck.

See section ↑5.3, The Decks for more details on these control elements.

<table>
<thead>
<tr>
<th>Control element</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deck Assign button (DECK C or DECK D)</td>
<td>Switches the focus of your S4 Deck between upper and lower Deck in TRAKTOR.</td>
</tr>
<tr>
<td></td>
<td>SHIFT + button: switches the Layout in TRAKTOR.</td>
</tr>
<tr>
<td>LOAD button</td>
<td>Loads the currently selected Sample into the first empty Sample Cell of a Sample Slot when using Quick Loading.</td>
</tr>
<tr>
<td></td>
<td>Lights up when you press the jog wheel’s top plate.</td>
</tr>
<tr>
<td>Jog wheel</td>
<td>Outer rim: tempo bending.*</td>
</tr>
<tr>
<td></td>
<td>Top plate: scratch (direct control on playback position).*</td>
</tr>
<tr>
<td>Control element</td>
<td>Function</td>
</tr>
<tr>
<td>-----------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ON AIR indicator</td>
<td>Lit when the Deck is audible on the TRAKTOR KONTROL S4 main output.</td>
</tr>
<tr>
<td>SAMPLES indicator</td>
<td>Lit (showing that this Deck is a Remix Deck).</td>
</tr>
<tr>
<td>DECK A or DECK B indicator</td>
<td>Unlit.</td>
</tr>
<tr>
<td>DECK C or DECK D indicator</td>
<td>Lit (showing that your S4 Deck is focused on the lower Deck C or D in TRAKTOR).</td>
</tr>
<tr>
<td>KEYLOCK indicator</td>
<td>Not used (no Keylock on Remix Decks).</td>
</tr>
<tr>
<td>MASTER indicator</td>
<td>Not used (Remix Decks stay always synchronized to another tempo master).</td>
</tr>
<tr>
<td>Loop Size Display</td>
<td>Shows the loop size selected via the LOOP SIZE encoder.</td>
</tr>
<tr>
<td>TEMPO fader</td>
<td>Increases/decreases Deck tempo.</td>
</tr>
<tr>
<td></td>
<td>Hold SHIFT to move the fader without altering the tempo.</td>
</tr>
<tr>
<td>Tempo Offset buttons up/down</td>
<td>Lit button indicates offset between tempo fader in the software and TEMPO fader on the S4. Pressing either button resets the tempo to the TEMPO fader position.</td>
</tr>
<tr>
<td></td>
<td>Press both buttons simultaneously to lock the tempo to 0 % (the TEMPO fader is then disabled). Both buttons light up to indicate the tempo locking. Press either button to unlock the tempo.</td>
</tr>
<tr>
<td></td>
<td>Both buttons light up dimmed when the TEMPO fader is near 0 %.</td>
</tr>
<tr>
<td>LOOP IN button</td>
<td>Sets a Floating Cue Point at current playback position without stopping the playback. This Floating Cue Point will serve as Loop In Point when you press the LOOP OUT button (see below).</td>
</tr>
<tr>
<td></td>
<td>Lights up together with LOOP OUT when playback is within an active Loop.</td>
</tr>
<tr>
<td>LOOP OUT button</td>
<td>Sets a Loop Out Point at current playback position and activates a Floating Loop between the previously set Floating Cue Point and this Loop Out Point.</td>
</tr>
<tr>
<td></td>
<td>Looping active: Lights up together with LOOP IN when playback is within the active Loop, lights up alone when playback is outside the active Loop.</td>
</tr>
<tr>
<td>Control element</td>
<td>Function</td>
</tr>
<tr>
<td>-------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>LOOP MOVE encoder</td>
<td><strong>In Remix mode</strong></td>
</tr>
<tr>
<td></td>
<td>Push: activates/deactivates looping.</td>
</tr>
<tr>
<td></td>
<td>Loop active: Loop move controls. Turn to move the Loop by the selected loop size (as displayed in the Loop Size Display). SHIFT + turn to move the Loop by 1-beat steps.</td>
</tr>
<tr>
<td></td>
<td>No Loop active: Beatjump controls. Turn to jump by the selected loop size (as displayed in the Loop Size Display). SHIFT + Turn to jump by 1-beat steps.</td>
</tr>
<tr>
<td></td>
<td><strong>In Legacy mode</strong></td>
</tr>
<tr>
<td></td>
<td>Turn: adjusts the volume of Sample Slots when Sample Slots are in Edit mode.</td>
</tr>
<tr>
<td></td>
<td>See also the &quot;Hotcue Buttons&quot; section in †6.3, S4 Control Options for information on Remix and Legacy mode.</td>
</tr>
<tr>
<td>LOOP SIZE encoder</td>
<td><strong>In Remix mode</strong></td>
</tr>
<tr>
<td></td>
<td>Push: activates/deactivates looping. Activating looping automatically sets a Floating Loop at current playback position with the selected loop size.</td>
</tr>
<tr>
<td></td>
<td>Turn (no active Loop): selects a loop size (in beats) for the next Floating Loop that will be set. The selected loop size is displayed in the Loop Size Display above.</td>
</tr>
<tr>
<td></td>
<td>Turn (Loop active): halves/doubles the size of the current Loop.</td>
</tr>
<tr>
<td></td>
<td><strong>In Legacy mode</strong></td>
</tr>
<tr>
<td></td>
<td>Turn: adjusts the volume of Sample Slots when Sample Slots are in Edit mode.</td>
</tr>
<tr>
<td></td>
<td>See also the &quot;Hotcue Buttons&quot; section in †6.3, S4 Control Options for information on Remix and Legacy mode.</td>
</tr>
<tr>
<td>Control element</td>
<td>Function</td>
</tr>
<tr>
<td>----------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Sample Play buttons  | Unlit: empty Sample Slot. Press to load a Sample from the capture source at current playback position (if playback is within an active Loop, the Loop is copied).  
Press SHIFT + button to load the Sample selected in the Playlist.  
Dimmed: Sample loaded but stopped or muted.  
Lit: Sample playing.  
Sample in Loop mode: Press to start/mute/unmute the Sample. Press and hold for one second to stop playback and reset it to start position.  
Sample in One-shot mode: Press to start playback. Press again to stop playback and reset it to start position.  
SHIFT + dimmed/lit button: unloads Sample from Sample Slot (button turns back off). |
| Hotcue buttons 1-4   | Unlit: empty Sample Slot. Press to load a Sample from the track at current playback position, in Loop mode and stopped.  
LED color: green for Looped mode, blue for One-shot mode.  
Dimmed: Sample loaded and stopped. Press & hold to trigger the Sample. Upon release, playback stops and skips back to start.  
Lit: Sample playing (LED’s brightness follows Sample level). Press to retrigger the Sample.  
**In Legacy mode**  
SHIFT + lit/dimmed button: activate Edit mode for Sample Slot (button starts flashing), where you can use the LOOP MOVE and LOOP SIZE encoders to control volume and filter settings for the Sample. Press SHIFT + button again to deactivate Edit mode.  
**In Remix mode**  
SHIFT + lit/dimmed button: selects the next Sample Cell in the Sample Slot.  
See also the "Hotcue Buttons" section in ↑6.3, S4 Control Options for information on Remix and Legacy mode. |
| PLAY button          | Press to start playback of Sample Slots. Press again to stop playback and reset it to start position.*                                      |
### 11.3 Mixer Quick Reference

<table>
<thead>
<tr>
<th>Control element</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>CUE button</td>
<td>Stopped Samples: Press &amp; hold to trigger Sample Slots. Upon release, playback stops and skips back to start. Playing Samples: Press to retrigger Samples.*</td>
</tr>
<tr>
<td>SYNC button</td>
<td>Re-synchronizes Samples in Looped mode with the current tempo master. *</td>
</tr>
<tr>
<td>SHIFT button</td>
<td>Press and hold: gives access to secondary functions of other control elements.</td>
</tr>
</tbody>
</table>

See section ↑5.4, The Mixer for more details on these control elements.

The BROWSE encoder and BROWSE button are covered in ↑11.5, Loop Recorder Quick Reference below. The Loop Recorder is covered in ↑11.4, FX Unit Quick Reference below.

### 11.3.1 Main Section Quick Reference

<table>
<thead>
<tr>
<th>Control element</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>MAIN LEVEL knob</td>
<td>Adjusts the level of the signal sent to the Main Outputs of the S4.</td>
</tr>
<tr>
<td>MAIN LEVEL meters</td>
<td>Give a visual feedback on the pre-knob level of your mix. Orange LEDs light up when the signal is clipping or when the limiter kicks in on the software side.</td>
</tr>
</tbody>
</table>
## 11.3.2 Channel and Crossfader Quick Reference

<table>
<thead>
<tr>
<th>Control element</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>GAIN encoder</td>
<td>Turn: adjusts input gain level for that channel. Push: resets input gain level to 0 dB.</td>
</tr>
<tr>
<td>FX Assign buttons 1 and 2</td>
<td>Normal: assigns the channel to FX Unit 1 and 2, respectively. (For use with four FX Units, see detailed description.) SHIFT: assigns the channel to the left and right side of the crossfader, respectively. The Crossfader Assignment indicator lights up accordingly.</td>
</tr>
<tr>
<td>High-frequency knob (HI)</td>
<td>Adjusts the high-frequency content of the signal.</td>
</tr>
<tr>
<td>Mid-frequency knob (MID)</td>
<td>Adjusts the mid-frequency content of the signal.</td>
</tr>
<tr>
<td>Low-frequency knob (LOW)</td>
<td>Adjusts the low-frequency content of the signal.</td>
</tr>
<tr>
<td>FILTER knob</td>
<td>Adjusts the on-board bipolar filter.</td>
</tr>
<tr>
<td>Headphone Cue button (CUE)</td>
<td>Sends the pre-fader signal to the cue channel (headphones).</td>
</tr>
<tr>
<td>Deck Assignment indicator (A/B/C/D)</td>
<td>Lights up when corresponding software Deck is currently under focus on the S4.</td>
</tr>
<tr>
<td>Channel fader</td>
<td>Controls the channel’s level.</td>
</tr>
<tr>
<td>Channel meter</td>
<td>Gives a visual feedback on the channel’s pre-fader level. Blue: signal below clipping. Orange: signal clipping.</td>
</tr>
<tr>
<td>Crossfader Assignment indicator</td>
<td>Left arrow lit: channel assigned to the left side of the crossfader. Right arrow lit: channel assigned to the right side of the crossfader.</td>
</tr>
<tr>
<td>Crossfader</td>
<td>Controls the mix between signals assigned to its both sides.</td>
</tr>
</tbody>
</table>
### 11.3.3 Master Display Quick Reference

<table>
<thead>
<tr>
<th>Control element</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alert indicator</td>
<td>Flashes when there is something wrong: Main Volume knob or Headphones Volume knob too low in the software, CPU load too high, laptop power supply disconnected.</td>
</tr>
<tr>
<td>USB indicator</td>
<td>Lit if the driver is up and running. Flashing if there is no connection to the computer or a problem with the driver.</td>
</tr>
<tr>
<td>Preview Play indicator</td>
<td>Lit when a track is loaded into the Preview Player.</td>
</tr>
<tr>
<td>SNAP button</td>
<td>Activates the Snap option (lit when Snap is active).</td>
</tr>
<tr>
<td>SNAP indicator</td>
<td>Lit when Snap is active.</td>
</tr>
<tr>
<td>Clock Master button</td>
<td>Sets the Clock as tempo master (lit when Clock is set as master).</td>
</tr>
<tr>
<td>Clock Master indicator (MASTER)</td>
<td>Lit when the Clock is set as tempo master.</td>
</tr>
<tr>
<td>Quantize button</td>
<td>Activates the Quantize option (lit when Quantize is active).</td>
</tr>
<tr>
<td>Quantize indicator</td>
<td>Lit when Quantize is active.</td>
</tr>
</tbody>
</table>

### 11.4 FX Unit Quick Reference

See section ↑5.5, The FX Units for more details on these control elements.

<table>
<thead>
<tr>
<th>Control element</th>
<th>Single mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>FX On button</td>
<td>Normal: activates/deactivates FX Unit globally (lit when activated). SHIFT: selects next FX from FX list (as set in Preferences &gt; Effects &gt; FX Pre-Selection).</td>
</tr>
<tr>
<td>FX DRY/WET knob</td>
<td>Adjusts the ratio between unprocessed (dry) signal and processed (wet) signal.</td>
</tr>
<tr>
<td>FX Knob 1-3</td>
<td>FX parameter 1-3 (FX-dependent). Parameter for 1st, 2nd, and 3rd FX.</td>
</tr>
</tbody>
</table>
### 11.5 Loop Recorder Quick Reference

See section ▲5.6, The Loop Recorder for more details on these control elements.

<table>
<thead>
<tr>
<th>Control element</th>
<th>Single mode</th>
<th>Group mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>FX Button 1-3</td>
<td>FX Button 1: resets all FX parameters to their default value.</td>
<td>Activates/deactivates FX slot 1-3 (lit when slot activated).</td>
</tr>
<tr>
<td></td>
<td>FX Buttons 2 and 3: FX-dependent (lit when activated).</td>
<td>SHIFT + button: loads in this slot the next FX from FX list (as set in Preferences &gt; Effects &gt; FX Pre-Selection).</td>
</tr>
<tr>
<td></td>
<td>SHIFT + button: loads a predefined FX (as set in Preferences &gt; Traktor Kontrol S4 &gt; S4 Control Options &gt; Direct FX 1-3).</td>
<td></td>
</tr>
<tr>
<td>FX Mode button (MODE)</td>
<td>Normal: switches the FX Unit between Single mode and Group mode (lit when Group mode activated).</td>
<td>SHIFT: saves current settings as default settings (&quot;snapshot&quot;). These settings will then be recalled the next time you load this FX, or by pressing the FX Button 1 (Single mode only).</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Control element</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>DRY/WET knob</td>
<td>Adjusts the mix between master output and Loop Recorder output.</td>
</tr>
<tr>
<td>SIZE button</td>
<td>Selects the size of the loop to be recorded.</td>
</tr>
<tr>
<td>REC button</td>
<td>No loop stored: Starts/stops recording a loop.</td>
</tr>
<tr>
<td></td>
<td>Loop stored: Starts/stops overdub recording.</td>
</tr>
<tr>
<td>UNDO button</td>
<td>No loop playing: Deletes the whole loop (and all its layers).</td>
</tr>
<tr>
<td></td>
<td>Loop playing: Undoes/redoes the last overdub layer.</td>
</tr>
<tr>
<td>PLAY button</td>
<td>Starts/stops playback of the recorded loop.</td>
</tr>
</tbody>
</table>
11.6  Browsing, Loading and Copying Quick Reference

See section ↑5.7, Browsing, Loading and Copying for more details on these control elements.

<table>
<thead>
<tr>
<th>Control element</th>
<th>Function</th>
</tr>
</thead>
</table>
| BROWSE encoder         | Turn: scrolls through the Playlist.  
SHIFT + turn: scrolls through the Favorites.  
Push: loads/unloads selected item in the Preview Player. When an item is loaded into the Preview Player, turning BROWSE seeks through the loaded item.  
(When Browse mode is not active, load the selected track by pressing LOAD on the desired Deck; load the selected Sample by pressing the desired Sample Play button.) |
| BROWSE button          | Press & release: activates/deactivates Browse mode (see below).  
Press & hold: activates Copy mode.                             |
| Browse mode            |                                                                                                                                          |
| BROWSE encoder         | Usual functions (see above).                                                                                                             |
| Jog wheels             | Scrolls through the Playlist.                                                                                                             |
| LOOP MOVE encoders     | Turn: scrolls through the Browser Tree.  
Push: expands/collapses node in the Browser Tree.                                                                                        |
| LOOP SIZE encoders     | Turn: scrolls through the Favorites.                                                                                                      |
| Flashing control elements | Press to load the selected item on to this location.                                                                                   |
| Copy mode              |                                                                                                                                          |
| Flashing control elements | While holding the BROWSE button depressed, press any flashing source and then any flashing target to copy the corresponding track or Sample. |
Index

A

Absolute (prefs) [146]
Absolute mode [94]
Adjusting levels [41]
Alert indicator [119]
Aligning tracks [36]
Analysis [21] [68]
Assigning FX to channels [59] [113]
Audience [42]
Audio input [77] [88]
Audio interface [161]
Audio Processing (Control Panel) [164]
Audio Settings (Control Panel) [164]
AUTO button [69]
Auto Loop (prefs) [146]
Auto mode (tempo master) [69]
AUX knob (software) [188]

B

Basic setup [176]
Beat matching
  manually [38]
  quantized [36]
Beatgrid [68]
  adjusting on the fly [107]
Beatjump (prefs) [144]
Beatjumps [97]
Beats
  manually aligning [40]
BPM [71]
BROWSE button [51] [66] [130] [132] [138]
BROWSE encoder [26] [130]
  pre-listening a track [32]
  Quick Loading [128]
Browse mode [51] [130]
Browser [32]
Browsing from your S4 [127]
  Quick Reference [211]
Buttons [81]
C
Calibration [149]
CD deck [189]
Changing the size of a Loop [46]
Channel [19] [29] [78] [112]
  Crossfader Assignment indicator [117]
  CUE button [34] [39] [115]
  Deck Assignment indicator [116]
  fader [30] [42] [116]
  FILTER knob [30] [115]
  FX Assign buttons [59] [113]
  GAIN encoder [30] [42] [113]
  HI knob [30] [114]
  LOW knob [30] [114]
  meter [30] [42] [116]
  MID knob [30] [114]
  signal flow [112]
Channel fader [30] [116]
Channel meter [30] [42] [116]
Clearing a Hotcue [49]
Clipping [41] [44]
Clock [67] [69]
  panel [69]
  setting as tempo master [70] [71]
  setting the Clock’s tempo (BPM) [71]
Clock Master button and indicator [70] [71] [120]
Collection [20] [68]
Common setups [176]
Compatibility [16]
Concepts [74]
Connection Monitor (Control Panel) [167]
Control Panel [162]
  Audio Settings page [163]
  Diagnostics page [166]
Controller Editor [13] [138]
Controller overview [17]
Copy mode [66] [132]
Copying from your S4 [127]
  Quick Reference [211]
Crossfader [30] [112] [117]
  assignment [114]
Crossfader Assignment indicator [117]
CUE button (Deck)
  on Track Decks [37] [106]
CUE button (Mixer) [34] [39] [115]
Cue channel [34]
CUE MIX knob [32] [34] [39] [137]
Cue Points
  Floating Cue Point [96]
setting and storing [35]
storing [103]
CUE VOL knob [32] [137]
Cueing [35] [45]
Customizing TRAKTOR KONTROL S4 [140]

D

Deactivating looping [48]
Deck [18] [74]
  flavor [77] [86] [150]
  focus [87] [88]
  overview [86]
DECK A indicator [26]
DECK A-D indicators [90]
Deck Assign buttons [56] [88]
Deck Assignment indicator [116]
DECK C button [88]
DECK D button [56] [88]
Deck Display [89]
  DECK A indicator [26]
  DECK A-D indicators [90]
  KEYLOCK indicator [73] [90]
  Loop Size Display [46] [91]
  MASTER indicator [70] [90]
  ON AIR indicator [90]
  SAMPLES indicator [90]
Default FX [58]
Delay (FX) [58]
Device Monitor (Control Panel) [165]
Direct FX 1-3 (prefs) [143]
Direct Loop (prefs) [144]
Displays [85]
Distortion [42][44]
Documentation [11]
Driver issues [171]
Drop-Out Detection (Control Panel) [167]
DRY/WET knob (FX Unit) [59][61]
DRY/WET knob (Loop Recorder) [63][125]
Dynamic range [41]

E
Effects [19][57][79]
Encoders [83]
EQs [30][43][114]
  using when mixing in a track [37]
External audio input [77][88]

F
Faders [84]
  channel [30][116]
  TEMPO [39][93]
Favorites [27][128]
Filter (FX) [58]
FILTER knob [30][43][115]
  for mixing in a track [37]
Flavor (Deck) [77][86][150]
Floating Cue Point [96]
Floating Loop [96]
Focus [87][88]
FOOTSWITCH socket [133]
Front panel [136]
  Headphones socket (PHONES) [137]
  Headphones Volume knob (CUE VOL) [137]
  Microphone Volume knob (MIC VOL) [137]
FX [57]
  default [58]
  loading (Group mode) [60]
  loading (Single mode) [61]
  synchronization [68]
  tempo-synched [60]
FX Assign buttons [59][113][154]
FX Buttons 1-3 [59][61]
**FX Knobs 1-3** [60] [61]  
**FX On button** [58] [61]  
**FX Unit** [19] [43] [57] [79]  
  - assigning to channels [59]  
  - Assigning to channels [113]  
  - controlling [60]  
  - DRY/WET knob [59] [61]  
  - FX Buttons 1-3 [59] [61]  
  - FX Knobs 1-3 [60] [61]  
  - FX On button [58] [61]  
  - Group mode [58] [123]  
  - MODE button [58] [61]  
  - Quick Reference [209]  
  - reference [122]  
  - Single mode [61] [123]  
  - snapshot [61]  
  - using four FX Units [153]  

**H**  
**Hardware Reference** [74]  
**Headphones** [32]  
**Headphones Cue button** [37] [39] [115]  
**Headphones Mix knob (CUE MIX)** [32] [34] [39] [137]  
**Headphones socket (PHONES)** [32] [137] [183]  
**Headphones Volume knob (CUE VOL)** [32] [137]  
**HI knob** [30] [114]  
**Hotcue 5-8 (prefs)** [144]  
**Hotcue buttons** [35] [47]  
  - on Remix Decks [56]  
  - on Track Decks [103]  
**Hotcue Buttons (prefs)** [145]  
**Hotcues** [48]  
  - clearing [49]  
  - deleting [104]  
  - storing [35] [47] [103]  

**G**  
**GAIN encoder** [30] [42] [113]  
**Gater (FX)** [60]  
**Ground terminal** [133] [191]  
**Group mode** [58] [123]  
  - adjusting FX Dry/Wet balance [61]
Loop Buttons (prefs) [145]

**LOOP IN button**
- on Track Decks [46] [96]

**Loop mode** [52]

**LOOP MOVE encoder**
- on Track Decks [47] [48] [97]

**LOOP OUT button**
- on Track Decks [46] [96]

**Loop Out Point** [96]

**Loop Recorder** [62] [80]
- adjusting the loop size [64]
- deleting a recorded loop [65]
- DRY/WET knob [63] [125]
- overdubbing [66] [126]
- PLAY button [64] [127]
- Quick Reference [210]
- REC button [64] [66] [126]
- recording a loop [64]
- reference [124]
- SIZE button [64] [125]
- Source menu (software) [63] [188]
- transfering a recorded loop to a Sample Slot [66]
- UNDO button [65] [66] [126]

**Loop section**

**Loop Size Display** [46] [91]

**LOOP SIZE encoder**
- on Track Decks [45] [48] [98]

**Looped mode** [101]

**Looping** [45]

**Loops**
- activating/deactivating [48] [97]
- adjusting the size [46] [96] [98]
- Floating Loop [96]
- moving [47] [96]
- setting in a track [45] [46] [96]
- storing [47] [103]

**LOW knob** [30] [114]
M

MAIN knob (software) [31] [44] [111]
Main level [43]
MAIN LEVEL knob [31] [44] [110]
MAIN LEVEL meters [31] [44] [110]
MAIN meter (software) [44]
MAIN OUT section [134]
Main Outputs 1/2 [182]
Main section [19] [43] [79] [110]
Manual Looping (prefs) [145]
Manually cueing [39]
MASTER button and indicator [70] [71] [120]
Master Display [36] [118]
  Alert indicator [119]
  MASTER button and indicator [70] [71] [120]
  Preview Play indicator [119]
  QUANT button and indicator [36] [72] [121]
  SNAP button and indicator [36] [72] [120]
  USB indicator [119] [171]
MASTER indicator (Deck Display) [70] [90]
MASTER indicator (Master Display) [70]
Meters [85]
  channel [30] [116]
Metronome icon [69]
MIC VOL knob [137] [188]

Microphone [186]
Microphone Gain knob (GAIN) [135]
Microphone socket (MIC) [135] [186]
Microphone Volume knob (MIC VOL) [137] [188]
MID knob [30] [114]
MIDI IN/OUT sockets [133]
MIDI mode [13] [137]
Mixer [19] [78]
  channel [29] [78] [112]
  Main section [43] [79] [110]
  Master Display [36] [118]
  Quick Reference [207]
  reference [109]
Mixing
  by hand [38]
    using automatic sync [31]
MODE button [58] [61]
Moving a Loop [47] [96]
Music files [20]
Music folders [21]

N

Navigate
  track by selected Loop size [47]
Noise level [41]
O
Offset
   manually correcting [40]
OFFSET (Tempo Offset buttons) [94]
ON AIR indicator [90]
ON/OFF switch [136] [184]
One-shot mode [52] [102]
Online Support Form [174]
Output Latency [165]
Overdubbing [66] [126]
Overview [17]
Overview Poster [13]

P
Phase offset (correcting) [40]
PHONES socket [32] [137] [183]
Pitch (tracks) [73]
PLAY button (Deck)
   on Track Decks [28] [106]
PLAY button (Loop Recorder) [64] [127]
Playing a track [25]
Playlist [27] [77] [128]
   in iTunes [22]
Poster [13]
POWER section [136]
Power supply [177]
Power Supply connector [136] [178]
Preferences [140]
   Audio Setup page (Mac OS X) [161]
   Audio Setup page (Windows) [162]
   Decks page [150]
   Effects page [153]
   Input Routing page [151]
   Traktor Kontrol S4 page [141]
Preferences button [140]
Pre-listening a track in the Browser [32] [130]
Preparing the mix using headphones [33]
Preview Play indicator [119]
Preview Player [32] [130]
Process Buffer (Control Panel) [165]
Processing State (Control Panel) [165]

Q
QUANT button and indicator [36] [72] [121]
Quantize mode [36] [72] [121]
Quick Loading
  samples [100] [128]
  tracks [26] [128]
Quick References [200]

R
Rear panel [133]
  INPUT CHANNEL C section [135]
  INPUT CHANNEL D section [134]
  MAIN OUT section [134]
  POWER section [136]
REC button [64] [66] [126]
Recalibrating your S4 [149]
Recording a loop [64]
Relative (prefs) [146]
Relative mode [146]
Remix Deck [50]
  concept [77]
  Quick Reference [203]
Restoring the default settings [148]
Reverb (FX) [58]
S

Sample Play buttons [52] [66] [99]
Sample Play Buttons (prefs) [144]
Sample Rate
  Mac OS X [161]
  Windows [164]
Sample Slot [77] [99]
Samples [77]
  capturing from a track [54]
  grabbing from a track [100] [131]
  loading [51]
  playback mode [52] [101]
  playing [52]
  Quick Loading [100]
  stopping & skipping back to start [52]
  triggering [52]
  unloading [56] [102]
SAMPLES indicator [90]
Scratching
  on a track [92]
Seeking through a track [92]
Selecting
  track [26]
Service Center [174]
Setting a Loop in a track [45] [96]

Settings button (prefs) [162]
Setup Wizard [148] [154]
SHIFT button [88]
  tapping [108]
Signal flow in channels [112]
Single mode [61] [123]
SIZE button [64] [125]
Skipping back to start of track [37]
SNAP button and indicator [72] [120]
SNAP indicator & button [36]
Snap mode [36] [46] [55] [72] [120]
Snapshot (FX Unit) [61]
Sockets [86]
  FOOTSWITCH [133]
  IN 1/2 [135]
  IN 3/4 [135]
  MAIN OUT 1/2 1/4 [134]
  MAIN OUT 1/2 RCA [134]
  MIC [135] [186]
  MIDI IN/OUT [133]
  PHONES [137] [183]
  USB [136]
Source menu (Loop Recorder, software) [188]
Storing a Cue Point [35] [103]
Storing a Hotcue [35] [47]
Storing a Loop [47] [103]
Switches [85]
Switching between Deck flavors [150]
SYNC button
  on Track Decks [34] [70] [107]
Synchronization [67]
Synchronizing tracks
  by hand [38]
  using automatic sync [34]
System requirements [16]

T
Technical Specs [195]
Tempo
  adjusting manually [39]
  automatically adjusting (Sync) [34]
Tempo bending
  on Track Decks [40] [92]
TEMPO fader [39] [93]
TEMPO Fader
  Absolute mode [94]
  Relative mode [146]
Tempo Faders (prefs) [146]
Tempo master [67]
  setting a Track Deck as [71] [107]
  setting the Clock as [71]
Tempo Offset buttons (OFFSET) [93]
  in Relative mode [146]
Thru Gain knob (GAIN) [134]
THRU/USB switch [135] [187] [191] [194]
Track
  info [28]
  loading [25]
  playing [25]
Track Collection [20] [68]
  browsing [51]
Index

Track Deck [51] [67]
  concept [77]
  Quick Reference [200]
Tracks [77]
TRAKTOR Clock [67] [69]
  setting as tempo master [70] [71]
TRAKTOR KONTROL S4 controller [17]
  main areas [74]
TRAKTOR mode [137]
TRAKTOR 2 Manual [13]
Troubleshooting [170]
  no audio [29]
Turntable [189]
Tutorials [25]
  video [11] [12]

U
UNDO button [65] [66] [126]
Updates [175]
USB indicator [119] [171]
USB issues [171]
USB socket [136] [180]
User Forum [175]
Using a master mixer [189]
Using a slave mixer [193]
Using four FX Units [153]
Using the S4 as default audio interface [168]
Using the S4 audio interface with other music applications [167]
Using the S4 with a laptop [173]
Using turntables and/or CD decks [189]

V
Video tutorials [11] [12]

W
Waveform [28] [48]